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Introduction

This reference describes the objects and methods in the Adobe® Photoshop® JavaScript™ type library. A
companion document, Photoshop Scripting Guide, describes basic scripting concepts and the Photoshop
object model. This document provides reference details of the Photoshop object model, and additional
information on JavaScript-specific features.

Adobe Photoshop uses ExtendScript, Adobe’s extended implementation of JavaScript. See JavaScript
support in Adobe Photoshop for additional information.

This book contains the following sections:

»  This introduction, which describes scripting support in Adobe Photoshop, and lists changes to the
JavaScript interface since the previous release.

- JavaScript Object Reference, which provides a complete reference for all Photoshop DOM objects and
commands.

»  Scripting Constants, which lists all enumerations used in the Photoshop type library.

For a JavaScript file to be recognized by Photoshop as a valid script file, it must use eithera .js ora .jsx
extension.

On the Mac OS, there is no difference in the way scripts with the two extensions function. On Windows, if
the script files is opened from inside Photoshop, there is no difference between using the .5s and . ysx
extension. However, if the script is launched by double-clicking on it, a script with the . s extension is
interpreted with the Microsoft JScript engine, and it cannot launch Adobe Photoshop. For Windows, using
the . jsx extension is preferrable, since it interprets the script with the ExtendScript engine.

All of the Adobe Creative Cloud applications, including Adobe Photoshop, use ExtendScript, Adobe's
extended implementation of JavaScript. ExtendScript files are distinguished by the . §sx extension.
ExtendScript offers all standard JavaScript features, plus additional features and utilities, such as:

» A debugging environment (the ExtendScript Toolkit)

»  Alocalization utility

> Tools that allow you to combine scripts and direct them to particular applications

> Platform-independent file and folder representation

Many of the JavaScript objects and methods use objects defined in ExtendScript, such as the File object,

the Folder object, and the unitvalue object. For that reason, using the . jsx extension for your script
files is preferable.

For details of these and additional features, see the JavaScript Tools Guide. This document is installed with
Creative Cloud applications at these locations:
2 InWindows:

C:\Program Files\Adobe\Adobe Utilities\ExtendScript Toolkit CC\SDK
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> In Mac OS:

Applications/Utilities/Adobe Utilities/ExtendScript Toolkit CC/SDK

The latest versions of this document and of the ExtendScript Tookit, can also be downloaded from Adobe
Developer Center, http://www.adobe.com/devnet/.

The Adobe Photoshop interface includes a Scripts menu (File > Scripts) which provides quick and easy
access to your JavaScripts. Scripts can be listed directly as menu items that run when you select them, or
you can navigate to and run any JavaScript in your file system.

If Adobe Photoshop encounters an error during script execution, it displays the error message.

To install a JavaScript in the Scripts menu, place it in the Scripts folder (Photoshop/Presets/Scripts). The
names of the scripts in the Scripts folder, without the file name extension, will be displayed in the Scripts
menu. Any number of scripts may be installed in the Scripts menu.

Scripts added to the Scripts folder while Adobe Photoshop is running will not appear in the Scripts menu
until the next time you launch the application.

All scripts found in the Scripts folder and sub-folders are displayed at the top level of the File > Scripts
menu. The addition of sub-folders does not add a hierarchical organization to the Scripts menu.

The Browse item at the end of the Scripts menu (File > Scripts > Browse) allows you to execute scripts
which are not installed in the Scripts folder. You can also use Browse to select scripts installed in the Scripts
folder after the application was last launched.

Selecting Browse displays a file browser dialog which allows you to select a script file for execution. Only
.js or .jsxfiles are displayed in the browse dialog. When you select a script file, it is executed the same
way as an installed script.

On startup, Adobe Photoshop executes all . jsx files that it finds in the startup folders.
> On Windows, the startup folder for user-defined scripts is:

C:\Program Files\Common Files\Adobe\Startup Scripts CC\Adobe Photoshop
= 0On Mac OS, the startup folder for user-defined scripts is:

~/Library/Application Support/Adobe/Startup Scripts CC/Adobe Photoshop

If a script is meant to be executed only by Adobe Photoshop, it must include code such as the following:

if ( BridgeTalk.appName == "photoshop" ) {
//continue executing script
}

For additional details, see the JavaScript Tools Guide.
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The JavaScript API follows JavaScript naming conventions in that all classes (object types) begin with
uppercase letters and have mixed case. Typically, in JavaScript, you instantiate classes using the new
operator:

new ClassName () ;

However, in the Photoshop Object Model, it is often not necessary to do this. Major object types are
collected into collection classes; for example, a list of Document objects is contained in a Documents
collection object. You then access the collection object through a corresponding collection property in its
container in the object hierarchy.

For example, the collection of all open documents is contained in the top-level application object. You
can access this through the global variable app, or simply reference its properties directly at the top level:
app.documents [0] // get the first loaded documented

documents [0] // this is the same

A collection property has the same name as the collection object, but begins with lowercase. For example,
a Document contains a collection of Layersets, and a LayerSet contains a collection of ArtLayers.To
access one ArtLayer object in a set:

var myLayer = activeDocument.layerSets[0] .artLayers[0];
The collections, as in this example, can be treated as arrays, which is useful for iteration. They also provide
methods to create their contained objects, and to access them by name:
var newlLayer = activeDocument.artLayers.add(); // Create a new ArtLayer object
newLayer.name = "My Layer"; // name it for later reference

var layerRef = activeDocument.artLayers.getByName ("My Layer") ;

Some objects, such as the Font objects contained in the app . fonts collection, are created by the
application, and never by your scripts.

Your scripts do use the JavaScript new operator to create helper objects, such as those that encapsulate a
set of options for opening or saving a document in a particular format:

var opts = new PDFOpenOptions() ;
opts.page = 10;
app.open (myPDFFile, opts) ;
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The Photoshop objects (the JavaScript type library for Adobe® Photoshop®) are presented alphabetically
and in tabular format in this chapter. Sample code for several object model classes is given to help
illustrate the syntax as well as usage of the object class.

Object properties and methods are described in separate tables for each object. The following sections
describe the conventions used in these descriptions.

The Properties table for an object lists the following:
2 The properties defined in each object.
> The value type for each property.

When the value type is a constant or another object, the value is a hypertext link to the listing for that
constant or object.

> The property’s input status: read-only or read-write.

» A description that explains what the property does.

Property Value type Whatitis

displayDialogs DialogModes Read-write. The dialog mode for the application, which controls
what types of dialogs should be displayed when running
scripts.

For constants, like DialogModes in the sample, click the link to go to the table that shows allowed values.
Constants are represented by objects, and allowed values are properties of those objects. Specify a
constant value in the form ConstantName.VALUE. For example:

app.displayDialogs = DialogModes.ERROR;

The Methods table for an object lists the following:

2 The method name.

> The parameters list.

»  The parameter value types, on lines corresponding to each parameter.
= Return value type

> Adescription of what the method does, and further descriptions of parameters, if needed.
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Method Parameter type Returns What it does
crop Crops the document. The
(bounds %ﬁ?\//aolfu g bounds parameter is an array of
[, angle] number four coordinates for the region
E' K;(iitﬁ]t] ) Unitvalue remaining after cropping, [left,
r el UnitvValue top, right, bottom].

When a parameter type or return value is a constant or another object, the value is a hypertext link to the
listing for that constant or object.

Parameters can be required or optional. Optional parameters are indicated in the table by square brackets
(D). In the example, the first parameters, bounds, is required. The remaining parameters are all optional.

You must pass a value for each required parameter. You can leave out optional parameters if there are no
remaining values to pass; however, if you wish to use the default value for any optional parameter that is
not the last one specified, pass undefined as a placeholder. You must enter the values in the order they are
listed, so that the JavaScript compiler knows which value you are entering.

For example, the following passes only the required parameter (using a previously-defined variable for the
bounding region):

app.activeDocument.crop ( myRegion ) ;

The following skips the angle parameter, specifies the width value, and omits the final height value:

var myWidth = new UnitValue( "500 pixels" );
app.executeAction ( myRegion,undefined, myWidth ) ;
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This object provides a dictionary-style mechanism for storing data as key-value pairs. It can be used for
low-level access into Photoshop. See an example of this usage in ‘Selection sample script’ on page 170.

Many configuration files use serialized action descriptors to represent their data. It is used, for example, to
encapsulate playback options in Application.playbackParameters, and is returned by
Application.getCustomOptions().

Property Value type What it is

count number Read-only. The number of keys contained in the descriptor.

typename string Read-only. The class name of the referenced

actionDescriptor object.

Method Parameter type Returns What it does

clear Clears the descriptor.
0

erase Erases a key from the descriptor.
(key) number

fromStream . Creates a descriptor from a stream
(value) string of bytes; for reading from disk.

getBoolean boolean Gets the value of a key of type
(key) number boolean.

getClass number Gets the value of a key of type
(key) number class.

getData string Gets raw byte data as a string
(key) number value.

getDouble number Gets the value of a key of type
(key) number double.

getEnumerationType number Gets the enumeration type of a
(key) number key.

getEnumerationValue number Gets the enumeration value of a
(key) number key.

getInteger number Gets the value of a key of type
(key) number integer.

getKey number Gets the ID of the Nth key,
(index) number provided by index.
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Method Parameter type Returns What it does (Continued)
ypP

getLargelnteger number Gets the value of a key of type
(key) number large integer.

getList ActionList Gets the value of a key of type list.
(key) number

getObjectType number Gets the class ID of an object in a
(key) number key of type object.

getObjectValue ActionDescriptor Getsthe value of a key of type
(key) number object.

getPath File Gets the value of a key of type
(key) number File.

getReference ActionReference  Gets the value of a key of type
(key) number ActionReference.

getString string Gets the value of a key of type
(key) number string.

getType DescValueType Gets the type of a key.
(key) number

getUnitDoubleType number Gets the unit type of a key of type
(key) number UnitDouble.

getUnitDoubleValue number Gets the value of a key of type
(key) number UnitDouble.

hasKey boolean Checks whether the descriptor
(key) number contains the provided key.

isEqual boolean Determines whether the
(otherDesc) ActionDescriptor descriptor is the same as another

descriptor.

putBoolean Sets the value for a key whose type
(key, number is boolean.
value) boolean

putClass Sets the value for a key whose type
(key, number is class.
value) number

putData Puts raw byte data as a string
(key, number value.
value) string

putDouble Sets the value for a key whose type
(key, number is double.
value) number

putEnumerated Sets the enumeration type and
(key, number value for a key.
enumType, number number

value)
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Method Parameter type Returns What it does (Continued)

putInteger Sets the value for a key whose type
(key, number is integer.
value) number

putLargeInteger Sets the value for a key whose type
(key, number is large integer.
value) number

putList Sets the value for a key whose type
(key, number is an ActionList object.
value) ActionList

putObject Sets the value for a key whose type
(key, nuﬁer is an object, represented by an
classID, numoer i i
) ActionDescriptor Action Descriptor.

putPath Sets the value for a key whose type
(key, number is path.
value) File

putReference Sets the value for a key whose type
(key, number is an object reference.
value) ActionReference

putString Sets the value for a key whose type
(key, number is string.
value) string

putUnitDouble Sets the value for a key whose type
(key, nuﬁer is a unit value formatted as a
unitib, T double
value) number

toStream string Gets the entire descriptor as a

0

stream of bytes, for writing to disk.
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This object provides an array-style mechanism for storing data. It can be used for low-level access into

Photoshop.

This object is ideal when storing data of the same type. All items in the list must be of the same type.

You can use the "put" methods, such as putBoolean(), to append new elements, and can clear the entire
list using clear(), but cannot otherwise modify the list.

Note: The aActionList object is part of the Action Manager functionality. For details on using the Action
Manager, see the Photoshop Scripting Guide.

Property

Value type

What it is

count

typename

Read-only. The number of commands that comprise the

action.

Read-only. The class name of the referenced

ActionList object.

With the exception of the clear () method, you use the methods of this object to either get the value of a
specific type of data in the list or set (put) the value type.

Method Parameter type Returns What it does

clear Clears the list.
0

getBoolean boolean Gets the value of a list element of
(index) number type boolean.

getClass number Gets the value of a list element of
(index) number type class.

getData string Gets raw byte data as a string
(index) number value.

getDouble number Gets the value of a list element of
(index) number type double.

getEnumerationType number Gets the enumeration type of a list
(index) number element.

getEnumerationValue number Gets the enumeration value of a
(index) number list element.

getInteger number Gets the value of a list element of
(index) number

type integer.
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Method Parameter type Returns What it does (Continued)

getLargeInteger number Gets the value of a list element of
(index) number type large integer.

getList ActionList Gets the value of a list element of
(index) number type list.

getObjectType number Gets the class ID of a list element
(index) number of type object.

getObjectValue ActionDescriptor Gets the value of alist element of
(index) number type object.

getPath File Gets the value of a list element of
(index) number type File.

getReference ActionReference  Gets the value of alist element of
(index) number type ActionReference.

getString string Gets the value of a list element of
(index) number type string.

getType DescValueType Gets the type of a list element.
(index) number

getUnitDoubleType number Gets the unit value type of a list
(index) number element of type Double.

getUnitDoubleValue number Gets the unit value of a list
(index) number element of type double.

putBoolean Appends a new value, true or
(value) boolean false.

putClass Appends a new value, a class or
(value) number data type.

putData Appends a new value, a string
(value) string containing raw byte data.

putDouble Appends a new value, a double.
(value) number

putEnumerated Appends a new value, an
(enumType, number enumerated (constant) value.
value) number

putInteger Appends a new value, an integer.
(value) number

putLargeInteger Appends a new value, a large
(value) number integer.

putList Appends a new value, a nested
(value) ActionList action list.
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Method Parameter type Returns What it does (Continued)

putObject Appends a new value, an object.
(classID, number .
value) ActionDescriptor

putPath Appends a new value, a path.
(value) File

putReference Appends a new value, a reference
(value) ActionReference to an object created in the script.

putString Appends a new value, a string.
(value) string

putUnitDouble Appends a new value, a unit/value
(classID, number pair.

number

value)
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This object provides information about what the action is refering to. For example, when referring to the
name of something you might use keyName. The reference would also need to know what name you are
referring to. In this case you could use classDocument for the name of the document or classLayer for the
name of the layer. It can be used for low-level access into Photoshop.Contains data associated with an
ActionDescriptor.

Property Value type What it does
typename string Read-only. The class name of the referenced Action
object.
Method Parameter type Returns What it does
getContainer ActionReference  Gets areference contained in this
0 reference.
Container references provide
additional pieces to the reference.
This looks like another reference,
but it is actually part of the same
reference.
getDesiredClass number Gets a number representing the
0 class of the object.
getEnumeratedType number Gets the enumeration type.
0
getEnumeratedValue number Gets the enumeration value.
0
getForm ReferenceFormType Gets the form of this action
0 reference.
getIdentifier number Gets the identifier value for a
0 reference whose form is identifier.
getIndex number Gets the index value for a
0 reference in a list or array.
getName string Gets the name of a reference.
0
getOffset number Gets the offset of the object’s

O index value.

getProperty number Gets the property ID value.
O
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Method Parameter type What it does (Continued)
putClass Puts a new class form and class
(desiredClass) number type into the reference.
putEnumerated Puts an enumeration type and ID
(desiredClass, nuﬁer into a reference along with the
I er .
emllmTi)/Pef nimber desired class for the reference.
value
putIdentifier Puts a new identifier and value into
(desiredClass, nuxer the reference.
value) numoer
putIndex Puts a new index and value into
(desiredClass, number the reference.
value) number
putName Puts a new name and value into
(desiredClass, number the reference.
value) strlng
putOffset Puts a new offset and value into
(desiredClass, number the reference.
value) number
putProperty Puts a new property and value into
(desiredClass, number the reference.
number

value)
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The Adobe Adobe Photoshop application object, which is the root of the object model and provides
access to all other objects. This object provides application-wide information, such as application defaults
and available fonts. It provides many important methods, such as those for opening files and loading
documents.

To access the properties and methods, you can use the pre-defined global variable app. For example:

var docRef = app.documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;

The properties and methods of the application object are also available at the top level; you can omit
references to the application object altogether. For example:

var docRef = documents.add (800, 600, 72, "docRef", NewDocumentMode.RGB) ;

This usage can be somewhat ambiguous; for clarity, it is recommended that you use an explicit reference

to app.

Property Value type What it is

activeDocument Document Read-write. The frontmost document.
Setting this property is equivalent to clicking an
open document in the Adobe Photoshop
application to bring it to the front of the screen.
Tip: If there is no open document, accessing this

property throws an exception.

backgroundColor SolidColor Read-write. The default background color and color
style for documents.

build string Read-only. Information about the application.

cloudWorkAreaDirectory  alias Read-only. Local directory for all cloud documents.

colorSettings string Read-write. The name of the current color settings,
as selected with Edit > Color Settings.

currentTool string Read-write. The name of the current tool selected.

displayDialogs DialogModes Read-write. The dialog mode for the application,
which controls what types of dialogs should be
displayed when running scripts.

documents Documents Read-only. The collection of open documents.
This is the primary point of access for documents
that are currently open in the application. The array
allows you to access any open document, or to
iterate through all open documents.

fonts TextFonts Read-only. The fonts installed on this system.

foregroundColor SolidColor Read-write. The default foreground color (used to

paint, fill, and stroke selections).
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Property Value type What it is (Continued)

freeMemory number Read-only. The amount of unused memory
available to Adobe Photoshop.

locale string Read-only. The language location of the

macintoshFileTypes

measurementLog
name

notifiers

notifiersEnabled

path

playbackDisplayDialogs

playbackParameters

preferences

preferencesFolder
recentFiles
scriptingBuildDate
scriptingVersion

systemInformation

typename

array of string

MeasurementLog

string

Notifiers

boolean

File

DialogModes

ActionDescriptor

Preferences

File
array of File
string
string

string

string

application.

An Adobe locale code consists of a 2-letter ISO-639
language code and an optional 2-letter ISO 3166
country code separated by an underscore. Case is
significant. For example, en_USs, en UK, ja_JP, de DE,
fr FR.

Read-only. A list of file image types Adobe
Photoshop can open.

The log of measurements taken.
Read-only. The application's name.

Read-only. The collection of notifiers currently
configured (in the Scripts Events Manager menu in
the Adobe Photoshop application).

Read-write. True if all notifiers are enabled.

Read-only. The full path to the location of the
Adobe Photoshop application.

Read-write. The dialog mode for playback mode,
which controls what types of dialog to display
when playing back a recorded action with the
Actions palette.

Read-write. Stores and retrieves parameters used as
part of a recorded action. Can be used, for example,
to control playback speed.

Read-only. The application preference settings
(equivalent to selecting Edit > Preferences in the
Adobe Photoshop application in Windows or
Photoshop > Preferences in Mac OS).

Read-only. The full path to the Preferences folder.
Read-only. Files in the Recent Files list.

Read-only. The build date of the Scripting interface.
Read-only. The version of the Scripting interface.
Read-only. Runtime details of the application and
system.

Read-only. The class name of the referenced app
object.
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Property Value type What it is (Continued)
version string Read-only. The version of Adobe Photoshop
application you are running.
windowsFileTypes array of string Read-only. A list of file image extensions Adobe
Photoshop can open.
Method Parameter type Returns What it does
batch . string Runs the batch automation routine
(inputFiles, air?f‘y of File (similar to the File > Automate >
. string

?Ez;on, string Batch command).

[, options]) BatchOptions The inputFiles parameter specifies
the sources for the files to be
manipulated by the batch command.

beep Causes a "beep" sound.
0
bringToFront Makes Adobe Photoshop the active

0

changeProgressText
(progressString)

charIDToTypeID

(charID)

compareWithNumbers
(first, second)

string

string

string
string

number

number

(front-most) application.

Changes the text that appears in the
progress window.

The progressString parameter is the
string to show in the progress
window.

Converts from a four character code
(character ID) to a runtime ID.

0: They are equal.

Less than 0: Either the value of the
first character that does not match is
lower in the compared string, or all
compared characters match but the
compared string is shorter.

Greater than 0: Either the value of the
first character that does not match is
greater in the compared string, or all
compared characters match but the
compared string is longer.

When a number is encountered it is
converted from a string to a number.
For example, A1, A2, A10 would be
the sorting order, instead of A1, A10,
A2 with the normal sort routine.
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Method Parameter type Returns What it does (Continued)
doAction Plays an action from the Actions
(actionm, string palette. The action parameter is the
from) string name of the action, the from
parameter is the name of the action
set.
doForcedProgress Performs a task with a progress bar.
(progressString, string Forces progress bar to display,
javaScriptString) string ignoring the normal heuristics that
keep it from showing unnecessarily
(for example, during very short tasks).
Other progress APls must be called
periodically to update the progress
bar and allow canceling.
The progressstring parameter is the
string to show in the progress
window, the javaScriptstring
parameter is the string to execute.
doProgress Performs a task with a progress bar.
(progressString, string Other progress APls must be called
javaScriptString) string periodically to update the progress
bar and allow canceling.
The progressstring parameter is the
string to show in the progress
window, the javaScriptString
parameter is the string to execute.
doProgressSegmentTask boolean Sections-off a portion of the unused
(segmentLength, number progress bar for execution of a
done, numbex subtask. Returns false on cancel. This
total number
javasériptString) string method should be used when

iterating a list of tasks with unequal
run times.

The segmentLength parameter is the
length of the current task, the done
parameter is the total length of all
completed tasks, the total
parameter is the total length of all
tasks. The javaScriptString
parameter is the string to execute.
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Method Parameter type Returns What it does (Continued)
doProgressSubTask boolean Sections-off a portion of the unused
(index, nuﬁel’ progress bar for execution of a
limit, _ zlérii; subtask. Returns false on cancel. This
javascriptstring) method should be used when
iterating a list of tasks with equal run
times.
The index parameter is the 0-based
index of the current task, the 1imit
parameter is the total number of
tasks, and the javascriptstring
parameter is the string to execute.
doProgressTask boolean Sections-off a portion of the unused
(taskLength, mtlml?er progress bar for execution of a
javaScriptString) string subtask. Returns false on cancel.
The taskLength parameter is the
amount of the unused progress bar to
section-off between 0.0 and 1.0. The
javaScriptString parameter is the
string to execute.
eraseCustomOptions Erases the user object with specified
(key) string ID value from the Photoshop registry.
executeAction ActionDescriptor  Playsan Action Manager event.
(eventID number .
[, descriptor] ActionDescriptor
[, displayDialogs]) DialogModes
executeActionGet ActionDescriptor Obtainsinformation abouta
(reference) ActionReference predefined or recorded action.
featureEnabled boolean Determines whether the feature
(name) string specified by name is enabled.
The following features are supported
as values for name:
"photoshop/extended"
"photoshop/standard"
"photoshop/trial"
getCustomOptions ActionDescriptor Retreives user objectsin the
(key) string Photoshop registry for the ID with
value key.
isQuicktimeAvailable boolean Returns true if Quicktime is installed.
0
load Loads a support file (as opposed to a
(document) File Photoshop image document) from

the specified location.
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Method Parameter type Returns What it does (Continued)
makeContactSheet string DePRECATED for Adobe Photoshop CS4.
(inputFiles array of File
[, options]) ContactSheetOptions

makePDFPresentation
(inputFiles,
outputFiles
[, options])

makePhotoGallery

(inputFolder,
outputFolder
[, options])

makePhotomerge
(inputFiles)

makePicturePackage

(inputFiles
[, options])

open
(document
[, asl]
[, asSmartObject])

openDialog
0

string
array of File
File
PresentationOptions

string
File
File
GalleryOptions

string
array of File

string
array of File

PicturePackageOptio
ns

Document
File
object or
OpenDocumentType
boolean

array of File

DEPRECATED for Adobe Photoshop CS4.

DePRECATED for Adobe Photoshop CS4.

DePRECATED for Adobe Photoshop. Use
provided script:

runphotomergeFromScript = true;

S.evalFile( app.path +
"Presets/Scripts/Photomerge.jsx")
photomerge . createPanorama (
fileList, displayDialog ) ;

Merges multiple files into one, with
user interaction required.

DEPRECATED for Adobe Photoshop CS4.

Opens the specified document.

Use the optional as parameter to
specify the file format using the
constants in OpenDocumentType; Of,
you can specify a file format together
with its open options using these
objects:

CameraRAWOpenOptions
DICOMOpenOptions
EPSOpenOptions
PDFOpenOptions
PhotoCDOpenOptions
RawFormatOpenOptions

Use the optional parameter
asSmartObject (default: false)to
create a smart object around the
opened document.

See the Application sample scripts for
an example of using the rFile object
in the open method.

Invokes the Photoshop Open dialog
box for the user to select files.

Returns an array of rFile objects for
the files selected in the dialog.
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Method Parameter type Returns What it does (Continued)
purge Purges one or more caches.
(target) PurgeTarget
putCustomOptions Saves a customized settings object in
(key, string , the Photoshop registry.
customObject ActionDescriptor
[, persistent]) boolean key is the unique identifier for your
custom settings.
customObiject is the object to save in
the registry.
persistent indicates whether the
object should persist once the script
has finished.
refresh Pauses the script while the
0 application refreshes. Use to slow
down execution and show the results
to the user as the script runs. Use
carefully; your script runs much more
slowly when using this method.
refreshFonts Force the font list to get updated.
0
runMenultem number Run a menu item given the menu ID.
(menuID)
showColorPicker boolean Returns false if dialog is cancelled,
0 true otherwise.
stringIDToTypeID number Converts from a string ID to a runtime
(stringID) string ID.
togglePalettes Toggle palette visibility.
0
toolSupportsBrushes string boolean Returns true if the specified tool
(tool) supports brushes, false otherwise.
toolSupportsBrushPresets string boolean Returns true if the brush supports
(tool) presets.
typeIDToCharID string Converts from a runtime ID to a
number

(typeID)

character ID.
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Method Parameter type Returns What it does (Continued)
typeIDToStringID string Converts from a runtime ID to a string
(typeID) number ID.

updateProgress boolean Updates the progress bar started by
(done, nuﬁier doProgress method. This method
total) numeer should be used for manual non-task

based progress updating. Returns
false on cancel.

The done parameter is the number of
tasks completed and the total
parameter the total number of tasks.

Application.jsx

This script invokes an alert box to display Properties important to an application such as version number,
the path to the application, the amount of memory available, and the number of documents open.

When a user presses the OK button on the alert box, a second dialog opens, which asks users whether they
would like the foreground and background colors set for the document presently open. If no document is
open, the script opens a new document for the user.

The script (with no document open) produces a progression of three dialogs.

//Create a Welcome message

// Use the name and version properties of the application object to
// Append the application’s name and version to the Welcome message
// use "\r" to insert a carriage return

// use the combination operator += to append info to the message
var message = "Welcome to " + app.name

message += " version " + app.version + "\r\r"

// find out where Adobe Photoshop is installed

// and add the path to the message

// add the optional parameter fsName to the path property
// to display the file system name in the most common format
message += "I'm installed in " + app.path.fsName + "\r\r"

// see how much memory Adobe Photoshop has to play with
message += "You have this much memory available for Adobe Photoshop CC: " +
app.freeMemory + "\r\r"

// use the length property of the documents object to

// see how many documents are open

var documentsOpen = app.documents.length

message += "You currently have " + documentsOpen + " document (s) open.\r\r"

// display the message to the user
alert (message)

// answer will be true for a "Yes" answer and false for a "No" answer
var answer = confirm("Set the foreground and background to my favorite colors?")

// set the colors



Adobe Photoshop

JavaScript Scripting Reference JavaScript Object Reference

53

if

//
if

(answer) {

// I don’t have a favorite color. Why did I ask you may wonder?
app.foregroundColor.rgb.red = Math.random() * 255
app.foregroundColor.rgb.green = Math.random() * 255
app.foregroundColor.rgb.blue = Math.random() * 255
app.backgroundColor.rgb.red = Math.random() * 255
app.backgroundColor.rgb.green = Math.random() * 255
app.backgroundColor.rgb.blue = Math.random() * 255

Open a document
(app.documents.length == 0) ({

// use the application’s path and the offset to the samples folder
var sampleDocToOpen = File (app.path + "/Samples/Fish.psd")

// compose a message with the name of the file

message = "Would you like me to open a sample for you? ("
message += sampleDocToOpen. fsName

message += ")"

// ask the user another question
answer = confirm(message)

// open the document accordingly
if (answer)
open (sampleDocToOpen)

}

PDFPresentation.jsx

This script presents a progression of images as an Adobe PDF slide show.

// use all the files in the Samples folder
var inputFolder = new Folder (app.path + "/Samples/")

// see if we have something interesting
if (inputFolder != null) {

// get all the files found in this folder that are Adobe Photoshop (.psd

format)

var inputFiles = inputFolder.getFiles ("*.psd")

// output to the desktop
var outputFile = File("~/Desktop/JavaScriptPresentation.pdf")

// there are defaults but I like to set the options myself
var options = new PresentationOptions
options.presentation = true

options.view = true

options.autoAdvance = true

options.interval = 5

options.loop = true

options.transition = TransitionType.RANDOM

// create the presentation
makePDFPresentation (inputFiles, outputFile, options)

alert ("Presentation file saved to: " + outputFile.fsName)
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An object within a document that contains the visual elements of the image (equivalent to a layer in the
Adobe Photoshop application).

Access an art layer in a document through the Document.artLayers collection. You can access a layer by

name; for example:

var layerRef = app.activeDocument.artLayers.getByName ("my layer") ;
layerRef.allLocked = true;

Access the art layers in a layer set through the LayerSet.artLayers collection in the parent set.

Property Value type What it is
allLocked boolean Read-write. True to completely lock the contents and
settings of this layer.
blendMode BlendMode Read-write. The blending mode.
bounds array of Read-only. An array of coordinates that describes the
UnitValue .
—_— bounding rectangle of the layer.
boundsNoEffects array of Read-only. An array of coordinates that describes the
UnitValue . . .
——— bounding rectangle of the layer not including effects.
fillOpacity number [0.0..100] Read-write. The interior opacity of the layer, a
percentage value.
filterMaskDensity double Read-write. The density of the filter mask (between
0.0 and 250.0)
filterMaskFeather double Read-write. The feather of the filter mask (between 0.0
and 250.0)
grouped boolean Read-write. True if this layer is grouped with the layer
beneath it.
isBackgroundLayer boolean Read-write. True if this is the background layer of the
document. A document can have only one
background layer. If there is no background layer,
setting this to true causes this to become the
background layer.
kind LayerKind Read-write. Sets the type (such as 'text layer') for an

empty layer.

Valid only when the layer is empty and when
isBackgroundLayer iS false. See
isBackgroundLayer.

You can use the kind property to make a background
layer a normal layer; however, to make a layer a
background layer, you must set isBackgroundLayer
to true.
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Property Value type What it is (Continued)

layerMaskDensity double Read-write. The density of the layer mask (between
0.0 and 100.0)

layerMaskFeather double Read-write. The feather of the layer mask (between
0.0 and 250.0)

linkedLayers array of ArtLayer Read-only.The layers linked to this layer. See

or LayerSet ArtLayer.link.

name string Read-write. The name.

opacity number [0.0..100.0]. Read-write. The master opacity of the layer, a
percentage value.

parent Document Read-only. The object's container.

pixelsLocked boolean Read-write. True if the pixels in the layer's image
cannot be edited using the paintbrush tool.

positionLocked boolean Read-write. True if the pixels in the layer’s image
cannot be moved within the layer.

textItem TextItem Read-only. The text item that is associated with the
layer.
Valid only when kind = LayerKind.TEXT.

transparentPixelsLocked boolean Read-write. True if editing is confined to the opaque
portions of the layer.

typename string Read-only. The class name of the referenced
artLayer object.

vectorMaskDensity double Read-write. The density of the vector mask (between
0.0 and 250.0)

vectorMaskFeather double Read-write. The feather of the vector mask (between
0.0 and 250.0)

visible boolean Read-write. True if the layer is visible.

xmpMetadata xmpMetadata Read-write. Metadata for the layer.
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Method

Parameter type Returns

What it does

adjustBrightnessContrast

(brightness,
contrast)

adjustColorBalance

( [shadows]
[, midtones]
[, highlights]
[l

preservelLuminosity]

adjustCurves
(curveShape)

adjustLevels

(inputRangeStart,
inputRangeEnd,
inputRangeGamma,
outputRangeStart,
outputRangeEnd)

applyAddNoise

(amount,
distribution,
monochromatic)

applyAverage
O

applyBlur
O

applyBlurMore
0

applyClouds
0

applyCustomFilter
(characteristics,
scale,
offset)

number
number

array of number
array of number
array of number
boolean

array of array of number

number [0..253]

number [(start + 2)..255]
number [0.10..9.99]
number [0..253]

number [ (start+ 2)..255]

number [0.1..400]
NoiseDistribution
boolean

array of number
number
number

Adjusts the brightness in the
range [-100..100] and contrast
[-100..100].

Adjusts the color balance of the
layer's component channels. For
shadows, midtones, and
highlights, the array must
include three values in the
range [-100..100], which
represent cyan or red, magenta
or green, and yellow or blue,
when the document mode is
CMYK or RGB.

See Document.mode.

Adjusts the tonal range of the
selected channel using up to
fourteen points.

Each value in the curveShape
array is a point pair, an array of
an x and y integer value.

Adjusts the levels of the
selected channels

Applies the Add Noise filter
amount is a percentage value.

Applies the Average filter.

Applies the Blur filter.

Applies the Blur More filter.

Applies the Clouds filter.

Applies a custom filter.

The characteristics array has
25 members.

See Adobe Photoshop Help for
specific instructions.
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Method Parameter type Returns What it does (Continued)
applyDeInterlace Applies the De-Interlace filter.
(eliminateFields, EllmlnaFeFlelds
createFields) CreateFields
applyDespeckle Applies the Despeckle filter.

0

applyDifferenceClouds
0

applyDiffuseGlow

(graininess,
glowAmount,
clearAmount)

applyDisplace
(horizontalScale,
verticalScale,
displacement,
undefinedareas,
displacementMapFiles)

applyDustAndScratches

(radius,
threshold)

applyGaussianBlur
(radius)

applyGlassEffect
(distortion,
smoothness,
scaling
[, invert]
[, texture]
[, textureFile])

applyHighPass
(radius)

number [0..10]
number [0..20]
number [0..20]

number [-999..999]
number [-999..999]
DisplacementMapType
UndefinedAreas

File

number [1..100]
number [0..255]

number [0.1..250.0]

number [0..20]
number [1..15]
number [50..200]

boolean
TextureType
File

number [0.1..250.0]

Applies the Difference Clouds
filter.

Applies the Diffuse Glow filter.

Applies the Displace filter using
the specified horizontal and
vertical scale, mapping type,
treatment of undistorted areas,
and path to the distortion
image map.

Applies the Dust & Scratches
filter.

Applies the Gaussian Blur filter
within the specified radius (in
pixels)

Applies the Glass filter.

scalingis a percentage value.

Applies the High Pass filter
within the specified radius.
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Method Parameter type Returns What it does (Continued)
applyLensBlur Applies the Lens Blur filter.
DepthMapSource
( [[S(mflgsinistance] number source: The source for the
[: invertDepthMap] boolean depth map (default:
[, shapel % DepthMapSource . NONE)
[, radius] numoer
[, bladeCurvature] number focalDistance : The blur focal
[, rotation] nuﬁer distance for the depth map
[’ bright ] nu exr .
; ti;gshgiz]s number (default: o).
[, amount] ;u@eg tributi invertDepthMask : True if the
[’ distribution] OlseDlstCriputlion de th ma .. t d (d f It'
: boolean p p is inverted (default:
) [, monochromatic] false).
shape: The shape of the iris
(default: Geometry . HEXAGON)
radius: The radius of the iris
(default: 15).
bladeCurvature: The blade
curvature of the iris (default: o).
rotation: The rotation of the
iris (default: o)
brightness: The brightness for
the specular highlights (default:
0).
threshold: The threshold for
the specular highlights (default:
0).
amount: The amount of noise
(default: 0)
distribution: The distribution
value for the noise (default:
NoiseDistribution.UNIFORM).
monochromatic: True if the
noise is monochromatic
(default: false).
applyLensFlare Applies the Lens Flare filter with
(brightness, numbe]zu  tvalue) the specified brightness (0 - 300,
flareCenter, igia;; w as a percentage), the xand y
lensType) SEnSIYRe coordinates (unit value) of the
flare center, and the lens type.
applyMaximum Applies the Maximum filter
(radius) number [1..100] within the specified radius (in
pixels).
applyMedianNoise Applies the Median Noise filter
(radius) number [1..100] within the specified radius (in

pixels).
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Method Parameter type Returns What it does (Continued)
applyMinimum Applies the Minimum filter
(radius) number [1..100] within the specified radius (in
pixels) (1 - 100).
applyMotionBlur Applies the Motion Blur filter.
(angle, number [-360..360]
radius) number [1..999]
applyNTSC Applies the NTSC colors filter.
0
applyOceanRipple Applies the Ocean Ripple filter.
(size, number [1..15]
magnitude) number [0..20]
applyOffset . Moves the layer the specified
(horizontal, %ﬁue amount horizontally and
. ni alue . .
ﬁgi;iii&reas) OffsetUndefinedAreas vertically (mm/ma.x amouqts
depend on layer size), leaving
an undefined area at the layer’s
original location.
applyPinch Applies the Pinch filter.
(amount ) number [-100..100]

applyPolarCoordinates
(conversion)

applyRadialBlur

(amount,
blurMethod,
blurQuality

[, blurCenter]

)

applyRipple
(amount,
size)

applySharpen
0

applySharpenEdges
0

applySharpenMore
0

PolarConversionType

number [1..100]
RadialBlurMethod
RadialBlurQuality
UnitValue

number [-999..999]
RippleSize

amount is a percentage value.

Applies the Polar Coordinates
filter.

Applies the Radial Blur filter in
the specified amount, using
either a spin or zoom effect and
the specified quality. The
parameter blurcCenter is the
position (unit value).

Applies the Ripple filter in the
specified amount, throughout
the image and in the specified
size.

Applies the Sharpen filter.

Applies the Sharpen Edges filter.

Applies the Sharpen More filter.
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Method Parameter type What it does (Continued)
applyShear Applies the Shear filter. The
(curve, array of array of number curve defines a curve with
undefinedaAreas) UndefinedAreas [2.255] points.
Each value in the curvearrayisa
point pair, an array of an x and y
integer value.
applySmartBlur Applies the Smart Blur filter.
(radius, number [0.1..100.0]
threshold number [0.1..100.0]
blurQualitI:y SmartBlurQuality
node) ! SmartBlurMode
applySpherize Applies the Spherize filter.
(amount number [-100..100] .
node) ! SpherizeMode amount IS a percentage value.
applyStyle Applies the specified style to the
(styleName) string layer. You must use a style from
the Styles list in the Layer Styles
Palette.
applyTextureFill Applies the Texture Fill filter.
(textureFile) File
applyTwirl Applies the Twirl filter.
(angle) number [-999..999]
applyUnSharpMask Applies the Unsharp Mask filter.
(amount, number [1..500] (amount is a percentage value.
radius, number [0.1..250.0]
threshold) number [0..255]
applyWave Applies the Wave filter.
(generatorNumber, mamer o] Scale factors are percentage
minimumWavelength, number [1. '99.8] P 9
maximumWavelength, number [2..min+1] values.
minimumAmplitude, number [1. '995?]
maximumAmplitude, number [2..min+l]
horizontalScale, number [1..100]
verticalScale, numper [1..100]
waveType, WaveTY. pe
undefinedAreas, UndefinedAreas
randomSeed) number
applyZzigZag Applies the Zigzag filter.
(amount, number [-100..100]
ridges number [0..20]
style) ! ZigZagType
autoContrast Adjusts the contrast of the
0 selected channels automatically.
autoLevels Adjusts the levels of the

0

selected channels using the
auto levels option.
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Method Parameter type

Returns

What it does (Continued)

clear
()

copy

([merge] ) boolean

cut
0

desaturate
()

duplicate
ArtLayer or LayerSet

([relativeObject]

[, insertionLocation]) ElementPlacement

equalize
0

invert
()

link
(with) ArtLayer or LayerSet

merge

ArtLayer
LayerSet

ArtLayer

Cuts the layer without moving it
to the clipboard.

Copies the layer to the
clipboard. When the optional
argument is set to true, a
merged copy is performed (that
is, all visible layers are copied to
the clipboard).

Cuts the layer to the clipboard.

Converts a color image to a
grayscale image in the current
color mode by assigning equal
values of each component color
to each pixel.

Creates a duplicate of the object
on the screen.

Redistributes the brightness
values of pixels in an image to
more evenly represent the
entire range of brightness levels
within the image.

Inverts the colors in the layer by
converting the brightness value
of each pixel in the channels to
the inverse value on the
256-step color-values scale.

Links the layer with the
specified layer.

Merges the layer down,
removing the layer from the
document; returns a reference
to the art layer that this layer is
merged into.
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Method

Parameter type

Returns

What it does (Continued)

mixChannels

(outputChannels
[, monochrome])

move
(relativeObject,

insertionLocation)

photoFilter

([fillColor]
[, density]

[, preservelLuminosityl])

posterize
(levels)

rasterize
(target)

remove

array of array of number
boolean

ArtLayer or LayerSet
ElementPlacement

SolidColor
number [1..100]
boolean

number [2..225]

RasterizeType

Modifies a targeted (output)
color channel using a mix of the
existing color channels in the
image.

The outputChannels
parameter is an array of channel
specifications. For each
component channel, specify a
list of adjustment values in the
range [-200..200] followed by a
'constant’ value [-200..200].)

When monochrome = true, the
maximum number of channel
value specifications is 1.

Valid only when docRef .mode =
DocumentMode .RGB Of CMYK.

RGB arrays must include four
values. CMYK arrays must
include five values.

Moves the layer relative to the
object specified in parameters.

For art layers, only the constant
values ElementPlacement.
PLACEBEFORE and PLACEAFTER
are valid.

For layer sets, only the constant
values ElementPlacement.
PLACEBEFORE and INSIDE are
valid.

Adjust the layer’s color balance
and temperature as if a color
filter had been applied.

density is a percentage value.

Specifies the number of tonal
levels for each channel and then
maps pixels to the closest
matching level.

Converts the targeted contents
in the layer into a flat, raster
image.

Deletes the object.
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Method Parameter type Returns What it does (Continued)
resize Resizes the layer to the specified
([horizontall number dimensions (as a percentage of
[, vertical] gﬁiiiposition its current size) and places it in
[, anchorl]) the specified position.
rotate Rotates rotates the layer around
(angle number the specified anchor point
[, anchor]) AnchorPosition (default: MIDDLECENTER).
selectiveColor Modifies the amount of a
(selectionMethod AdjustmentReference process color in a specified
[, reds] :iig gg Eﬁﬁg primary color without affecting
E ;i;g:?] array of number the other primary colors.

[, cyans] array of number
[' plues] array of number
! array of number

[, magentas]

[, whites] array of number

[, neutrals] array of number

[, blacks]) array of number
shadowHighlight

( [shadowAmount] number [0..100]

[, shadowWidth] number [0.100]

[, shadowRadius] nu$§er [0..2500]

[, highlightAmount] number [0..100]

[, highlightWidth] number [0..100]

[, highlightRadius] nuﬁer [0..2500]

[, colorCorrection] number [-100..100]

[, midtoneContrast] number [-100..100]

[, blackClipl] number [0.000..50.000]

[’ whiteClip]) number [0.000..50.000]
threshold

(level) number [1..255]
translate

([deltax] Unitvalue

[, deltaYl) Unitvalue
unlink

0

Each color array must have four
values.

Adjusts the range of tones in the
image’s shadows and highlights.

Amounts and widths are
percentage values. Radius
values are in pixels.

Converts grayscale or color
images to high-contrast, B/W
images by converting pixels
lighter than the specified
threshold to white and pixels
darker than the threshold to
black.

Moves the layer the specified
amount (in the given unit)
relative to its current position.

Unlinks the layer.

The following script opens all the files in the samples folder, creating one multi-layered document. Each
layer is pasted into one of four quadrants and given 50% transparency. Finally the layers are sorted by

name.

ArtLayer.jsx
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// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

//Close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Create a new document to merge all the samples into
var mergedDoc = app.documents.add (1000, 1000, 72, "Merged Samples",
NewDocumentMode .RGB, DocumentFill.TRANSPARENT, 1)

// Use the path to the application and append the samples folder
var samplesFolder = Folder (app.path + "/Samples/")

//Get all the files in the folder
var fileList = samplesFolder.getFiles()

// open each file
for (var i = 0; i < fileList.length; i++) {
// The fileList is folders and files so open only files
if (fileList[i] instanceof File) (
open(fileList [i])

// use the document name for the layer name in the merged document
var docName = app.activeDocument .name

// flatten the document so we get everything and then copy
app.activeDocument.flatten ()
app.activeDocument.selection.selectAll ()
app.activeDocument.selection.copy ()

// don’t save anything we did
app.activeDocument.close (SaveOptions.DONOTSAVECHANGES)

// make a random selection on the document to paste into
// by dividing the document up in 4 quadrants and pasting
// into one of them by selecting that area
var topLeftH = Math.floor (Math.random() * 2)
var topLeftV = Math.floor (Math.random() * 2)
var docH = app.activeDocument.width.value / 2
var docV = app.activeDocument.height.value / 2
var selRegion = Array (Array (topLeftH * docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV),
Array (topLeftH * docH + docH, topLeftV * docV + docV),
*
*

Array (topLeftH * docH, topLeftV * docV + docV),

Array (topLeftH * docH, topLeftV * docV))
app.activeDocument.selection.select (selRegion)
app.activeDocument .paste ()

// change the layer name and opacity
app.activeDocument.activelLayer.name = docName
app.activeDocument.activelLayer.fillOpacity = 50
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}

// sort the layers by name

for (var x = 0; x < app.activeDocument.layers.length; x++) {

for (var y = 0; y < app.activeDocument.layers.length - 1 - x; y++) {
// Compare in a non-case sensitive way

var docl
var doc2
if (docl.

}

app.activeDocument.layers [y] .name
app.activeDocument.layers[y + 1] .name

toUpperCase () > doc2.toUpperCase()) ({
app.activeDocument. layers[y] .move (app.activeDocument.layers [y+1],
ElementPlacement . PLACEAFTER)

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits

app.displayDialogs

startDisplayDialogs
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The collection of ArtLayer objects in a document or layer set.

Access through the Document.artLayers or LayerSet.artLayers collection. For example:

var layerRef

docRef .artLayers.add ()

Property Value type Whatitis
length number Read-only. The number of elements in the artLayers
collection.
parent Document Read-only. The object's container.
typename string Read-only. The class name of the referenced
artLayers object.
Method Parameter type Returns What it does
add ArtLayer Creates a new art layer in the
0 document and adds the new object to
this collection.
getByName ArtLayer Get thefirst elementin the artLayers
(name) string collection with the provided name.
removeAll Removes all elements from the

0

artLayers collection.
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Options for running a batch operation using the Application.batch() method.

JavaScript only supports folders as sources for batch commands. Specify the batch source folder as the
inputFiles parameter of the Application.batch() method.

Property Value type Whatitis

destination BatchDestinationType Read-write. The type of destination for the
processed files (default:
BatchDestinationType .NODESTINATION).

destinationFolder Folder Read-write. The folder location for the processed
files.

Valid only when destination =
BatchDestinationType.FOLDER

errorFile File Read-write. The file in which to log errors
encountered.

To display errors on the screen (and stop batch
processing when errors occur) leave blank.

fileNaming array of Read-write. A list of file naming options
FileNamingType (maximum: 6)

Valid only when destination =
BatchDestinationType.FOLDER

macintoshCompatible boolean Read-write. True to make the final file names
Macintosh compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER

overrideOpen boolean Read-write. True to override action open
commands (default: false).

overrideSave boolean Read-write. True to override save as action steps
with the specified destination (default: false).

Valid only when destination =
BatchDestinationType.FOLDER Of
SAVEANDCLOSE.

startingSerial number Read-write. The starting serial number to use in
naming files (default: 1).

Valid only when destination =
BatchDestinationType.FOLDER

suppressOpen boolean Read-write. True to suppress the file open options
dialogs (default: false).
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Property Value type What it is (Continued)
suppressProfile boolean Read-write. True to suppress the color profile

warnings (default: false).

typename string Read-only. The class name of the referenced
batchOptions object.

unixCompatible boolean Read-write. True to make the final file name Unix
compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER.

windowsCompatible boolean Read-write. True to make the final file names
Windows compatible (default: true).

Valid only when destination =
BatchDestinationType.FOLDER.
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Options for converting an image to bitmap mode, using Document.changeMode() with
ChangeMode .Bitmap.

Convert color images to grayscale before converting the image to bitmap mode. See the
ArtLayer.desaturate() method.

Property Value type What it is

angle number [-180..180] Read-write. The angle (in degrees) at which to
orient individual dots. See shape.

Valid only when method -
BitmapConversionType . HALFTONESCREEN.

frequency number [1.0..999.99] Read-write. The number of printer dots (per inch) to
use.

Valid only when method =
BitmapConversionType.HALFTONESCREEN.

method BitmapConversionType Read-write. The conversion method to use (default:
BitmapConversionType .DIFFUSIONDITHER).

patternName string Read-write. The name of the pattern to use.

For information about pre-installed valid patterns,
see Adobe Photoshop Help on the bitmap
conversion command, or view the options availabe
in the Custom Color drop down box after choosing
the bitmap conversion command.

Valid only when method -
BitmapConversionType . CUSTOMPATTERN.

resolution number Read-write. The output resolution in pixels per inch
(default: 72. 0).

shape BitmapHalfToneType  Read-write. The dot shape to use.

Valid only when method =
BitmapConversionType . HALFTONESCREEN.

typename string Read-only. The class name of the referenced
bitmapConversionOptions object.
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Options for saving a document in BMP format using the Document.saveAs() method.

Property Value type What it is
alphaChannels boolean Read-write. True to save the alpha channels.
depth BMPDepthType Read-write. The number of bits per channel.
flipRowOrder boolean Read-write. True to write the image from top
to bottom (default: false).
Available only when osType =
OperatingSystem.WINDOWS.
osType OperatingSystem Read-write. The target OS.
(default: operat ingSystem. WINDOWS).
rleCompression boolean Read-write. True to use RLE compression.
Available only when osType =
OperatingSystem.WINDOWS.
typename string Read-only. The class name of the referenced

BMPSaveOptions object.
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Options for opening a document in Camera RAW format using the Application.open() method.

Property Value type What it is

bitsPerChannel BitsPerChannelType Read-write. The number of bits per channel.
blueHue number [-100..100] Read-write. The blue hue of the shot.
blueSaturation number [-100..100] Read-write. The blue saturation of the shot.
brightness number [0..150] Read-write. The brightness of the shot.

chromaticAberrationBY

chromaticAberrationRC

colorNoiseReduction

colorSpace
contrast
exposure
greenHue
greenSaturation

luminanceSmoothing

redHue
redSaturation

resolution

saturation

settings

shadows
shadowTint
sharpness
size

temperature

number [-100..100]

number [-100..100]

number [0..100]

ColorSpaceType

number [-50..100]

number [-4.0..4.0]

number [-100..100]

number [-100..100]

number [0..100]

number [-100..100]

number [-100..100]

number [1..999]

number [-100..100]

CameraRAWSettingsType

number [0..100]
number [-100..100]
number [0..100]
CameraRAWSize

number [2000..50000]

Read-write. The chromatic aberration B/Y of the
shot.

Read-write. The chromatic aberration R/C of the
shot

Read-write. The color noise reduction of the
shot.

Read-write. The colorspace for the image.
Read-write. The contrast of the shot.
Read-write. The exposure of the shot.
Read-write. The green hue of the shot.
Read-write. The green saturation of the shot.

Read-write. The luminance smoothing of the
shot.

Read-write. The red hue of the shot.
Read-write. The red saturation of the shot.

Read-write. The resolution of the document in
pixels per inch.

Read-write. The saturation of the shot.

Read-write. The global settings for all Camera
RAW options. Default:
CameraRAWSettingsType.CAMERA.

Read-write. The shadows of the shot.
Read-write. The shadow tint of the shot.
Read-write. The sharpness of the shot.
Read-write. The size of the new document.

Read-write. The temperature of the shot.
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Property Value type What it is (Continued)
tint number [-150..150] Read-write. The tint of the shot.
typename string Read-only. The class name of the referenced

cameraRAWOpenOptions object.

vignettingAmount number [-100..100] Read-write. The vignetting amount of the shot.

vignettingMidpoint number [-100..100] Read-write. The vignetting mid point of the
shot.

whiteBalance WhiteBalanceType Read-write. The white balance options for the

image. These are lighting conditions that affect
color balance.
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Information about a color element in the image.

Access through the Document.channels collection. You can access an individual channel object in this list
by index or by name. For example, this accesses a channel object in the active document by name and
assigns an opacity value:

var channelRef = app.activeDocument.channels.getByName ("my channel") ;
channelRef .opacity = 22;

A channel is analogous to a plate in the printing process that applies a single color. The document'’s color
mode determines the number of default channels; for example, an RGB document has three channels, red,

green, and blue. A color can also have an alpha channel, which stores selections as masks, or a spot
channel, which stores spot colors.

Property Value type What itis

color SolidColor Read-write. The color of the channel.
Not valid when kind = ChannelType.COMPONENT.

histogram array of number Read-only. A histogram of the color of the channel. The
array contains 256 members.
Not valid when kind = ChannelType.COMPONENT. For
component channel histogram values, use the histogram
property of the Document object instead.

kind ChannelType Read-write. The type of the channel.

name string Read-write. The name of the channel.

opacity number [0..100] Read-write. The opacity to use for alpha channels or the
solidity to use for spot channels.
Valid only when kind = ChannelType.MASKEDAREA Of
SELECTEDAREA.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced channel
object.

visible boolean Read-write. True if the channel is visible.

Method Parameter type Returns What it does

duplicate Channel Duplicates the channel.

Document

( [targetDocument] )
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Method

Parameter type

Returns

What it does

merge

Merges a spot channel into the
component channels.

Deletes the channel.
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The collection of Channel objects in a document.

Access through the Document.channels collection property. For example:

var channelRef = app.activeDocument.channels.add ()

Property Value type What itis
length number Read-only. The number of elements in the channels
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced channels
object.
Method Parameter type Returns What it does
add Channel Creates a new channel object and
0 adds it to this collection.
getByName Channel Get the first element in the channels
(name) string collection with the provided name.
removeAll Removes all alpha channel objects

0 from the channels collection.

The following script opens a file if one is not already open, and then writes a histogram report
(histogram.log) for the channels in the active document.

Note: This script contains a switch construction that uses a break statement. The break statement
requires an ending semicolon (;), as in the following sample:

break;
Histogram.jsx
// Function to activate all the channels according to the documents mode
// Takes a document reference for input

function TurnOnDocumentHistogramChannels (inDocument) {

// see how many channels we need to activate
var visibleChannelCount = 0

// based on the mode of the document
switch (inDocument.mode) {

case DocumentMode.BITMAP:
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case DocumentMode.GRAYSCALE:

case DocumentMode . INDEXEDCOLOR :
visibleChannelCount = 1
break;

case DocumentMode .DUOTONE :
vigsibleChannelCount = 2
break;

case DocumentMode.RGB:
case DocumentMode.LAB:

visibleChannelCount = 3
break;

case DocumentMode.CMYK:
vigsibleChannelCount = 4

break;

case DocumentMode .MULTICHANNEL:

default:
visibleChannelCount = inDocument.channels.length + 1
break;

// now get the channels to activate into a local array
var aChannelArray = new Array ()

// index for the active channels array
var aChannelIndex = 0

for (var channelIndex = 0; channelIndex < inDocument.channels.length;
channelIndex++) {
if (channelIndex < visibleChannelCount) {
aChannelArray[aChannelIndex++] = inDocument.channels [channelIndex]

// now activate them
inDocument .activeChannels = aChannelArray

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// 1f there are no documents open then try to open a sample file
if (app.documents.length == 0) {

open (File (app.path + "/Samples/Fish.psd"))
}

// get a reference to the working document
var docRef = app.activeDocument
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// create the output file
// first figure out which kind of line feeds we need

if ($.os.search(/windows/i) != -1) {
fileLineFeed = "Windows"

} else {
fileLineFeed = "Macintosh"

}

// create the output file accordingly

fileOut = new File("~/Desktop/Histogram.log")
fileOut.lineFeed = fileLineFeed

fileOut.open ("w", "TEXT", "??2?2°?")

// write out a header
fileOut.write ("Histogram report for " + docRef.name)

// find out how many pixels I have
var totalCount = docRef.width.value * docRef.height.value

// more info to the out file
fileOut.write (" with a total pixel count of " + totalCount + "\n")

// channel indexer
var channelIndex = 0

// remember which channels are currently active
var myActiveChannels = app.activeDocument.activeChannels

// document histogram only works in these modes
if (docRef.mode == DocumentMode.RGB | |
docRef .mode == DocumentMode.INDEXEDCOLOR | |
docRef .mode == DocumentMode.CMYK) {

// activate the main channels so we can get the documents histogram
TurnOnDocumentHistogramChannels (docRef)

// Output the documents histogram
OutputHistogram(docRef.histogram, "Luminosity", fileOut)

}

// local reference to work from
var myChannels = docRef.channels

// loop through each channel and output the histogram
for (var channelIndex = 0; channelIndex < myChannels.length; channellIndex++) {

// the channel has to be visible to get a histogram
myChannels [channelIndex] .visible= true

// turn off all the other channels
for (var secondaryIndex = 0; secondaryIndex < myChannels.length;
secondaryIndex++) {
if (channellIndex != secondarylIndex) ({
myChannels [secondaryIndex] .visible= false

}

// Use the function to dump the histogram
OutputHistogram (myChannels [channelIndex] .histogram,
myChannels [channelIndex] .name, fileOut)
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}

// close down the output file
fileOut.close()
alert ("Histogram file saved to: " + fileOut.fsName)

// reset the active channels
docRef .activeChannels = myActiveChannels

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// Utility function that takes a histogram and name
// and dumps to the output file
function OutputHistogram(inHistogram, inHistogramName, inOutFile) ({

// find ouch which count has the largest number
// I scale everything to this number for the output
var largestCount = 0

// a simple indexer I can reuse
var histogramIndex = 0

// see how many samples we have total
var histogramCount = 0

// search through all and find the largest single item
for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++) {
histogramCount += inHistogram[histogramIndex]
if (inHistogram[histogramIndex] > largestCount)
largestCount = inHistogram|[histogramIndex]

}

// These should match
if (histogramCount != totalCount) ({

alert ("Something bad is happening!")
}

// see how much each "X" is going to count as
var pixelsPerX = largestCount / 100

// output this data to the file
inOutFile.write("One X = " + pixelsPerX + " pixels.\n")

// output the name of this histogram
inOutFile.write (inHistogramName + "\n")

// loop through all the items and output in the following format

// 001

// 002

for (histogramIndex = 0; histogramIndex < inHistogram.length;
histogramIndex++) {

// I need an extra "O" for this line item to keep everything in line
if (histogramIndex < 10)
inOutFile.write ("0")
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// I need an extra "0" for this line item to keep everything in line
if (histogramIndex < 100)
inOutFile.write("0")

// output the index to file
inOutFile.write (histogramIndex)

// some spacing to make it look nice
inOutFile.write(" ")

// figure out how many X’'s I need
var outputX = inHistograml[histogramIndex] / largestCount * 100

// output the X's
for (var a = 0; a < outputX; a++)

inOutFile.write ("X")

inOutFile.write ("\n")

}

inOutFile.write ("\n")
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Defines a CMYK color, used in the SolidColor object.

See also GrayColor, HSBColor, LabColor, NoColor, RGBColor

Property Value type What it is

black number [0.0..100.00] Read-write. The black color value (as percent).

cyan number [0.0..100.00] Read-write.The cyan color value (as percent).

magenta number [0.0..100.00] Read-write. The magenta color value (as percent).

typename string Read-only. The class name of the referenced cMykcolor
object.

yellow number [0.0..100.00] | Read-write. The yellow color value (as percent).
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A color sampler for a document. Access through the Document.colorSamplers collection. For example:

var colorSamplerRef = app.activeDocument.colorSamplers[0];
var currentColor = colorSamplerRef.color;

Note: For additional information about color samplers, see Adobe Photoshop help on the Color

SamplerTool.

Property Value type What it is

color SolidColor Read-only. The color of the color sampler.

position array of Read-only. The position of the color sampler in the

UnitValue document. The array (x,y) represents the horizontal and

vertical location of the count item.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced colorSampler
object.

Method Parameter type Returns What it does

move Moves the color sampler to a new location

(position) arxay of in the document.
nitValue

The position parameter (x,y) represents
the new horizontal and vertical locations
of the moved color sampler.

remove Deletes the colorsampler object.
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The collection of ColorSampler objects in a document. Access through the Document.colorSamplers
collection property. For example:

app.activeDocument .colorSamplers.removeAll ()

Property Value type What it is

length number Read-only. The number of elements in the
Colorsamplers collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced
ColorSamplers object.

Method Parameter type Returns What it does
add ColorSampler | Createsa new color sampler object
(position) array of UnitValue and adds it to this collection.

The position parameter (x,y)
represents the new horizontal and
vertical locations of the moved color
sampler.

removeAll Removes all colorsampler objects
0 from the colorsamplers collection.
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Options for creating a contact sheet with the Application.makeContactSheet() method.

Property Value type What it is

acrossFirst boolean Read-write. True to place the images horizontally
(left to right, then top to bottom) first (default: t rue).

bestFit boolean Read-write. True to rotate images for the best fit
(default: false).

caption boolean Read-write. True to use the filename as a caption for
the image (default: true).

columnCount number [1..100] Read-write. The number of columns to include
(default: 5).

flatten boolean Read-write. True to flatten all layers in the final
document (default: true).

font GalleryFontType Read-write. The font used for the caption (default:
GalleryFontType.ARIAL).

fontSize number Read-write. The font size to use for the caption
(default: 12).

height number [0..29000] Read-write. The height (in pixels) of the resulting
document (default: 720).

horizontal number Read-write. The horizontal spacing (in pixels)
between images (default: 1).

mode NewDocumentMode Read-write. The document color mode (default:
NewDocumentMode . RGB).

resolution number [35..1200] Read-write. The resolution of the document in pixels
per inch (default: 72. 0).

rowCount number [1..100] Read-write. The number of rows to use (default: 6).

typename string Read-only. The class name of the referenced
contactSheetOptions object.

useAutoSpacing boolean Read-write. True to auto space the images (default:
true).

vertical number [0..29000] Read-write. The vertical spacing (in pixels) between
images (default: 1).
Valid only when useAutospacing = false.

width number [100..29000] |Read-write. The width (in pixels) of the resulting

document (default: 576).
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A counted item in a document. Access through the Document.countltems collection. See the
Document.autoCount() method.

Note: This feature is available in the Extended Version only.

For additional information about count items, see Adobe Photoshop help on the Count Tool.

Property Value type What it is

position array of Read-only. The position of the count item in the document.
UnitValue

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced countItem

object.
Method Parameter type Returns What it does
remove

0

Deletes the count Item object.
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The collection of Countltem objects in the document.

Access through the Document.countltems collection property. For example:

app.activeDocument.countItems.removeAll ()

Note: This feature is available in the Extended Version only.

Property Value type What it is
length number Read-only. The number of elements in the countItems
collection.
parent Document Read-only. The containing document.
typename string Read-only.The class name of the referenced count Items
object.
Method Parameter type Returns What it does
add CountItem Creates a new count item object and
(position) array of UnitValue adds it to this collection.
Parameter position (x,y) represents
the horizontal and vertical positions,
respectively, of the count Ttem object.
getByName CountItem Get the first element in the
(name) string CountTtems collection with the
provided name.
removeAll Removes all countItem objects from

0

the countItems collection.
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Options for saving a CMYK document in DCS1 format using the Document.saveAs() method.

Property Value type What it is

dcs DCSType Read-write. (default: bcSType . COLORCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document

encoding SaveEncoding  Read-write. The type of encoding to use for document
(default: saveEncoding . BINARY).

halftoneScreen boolean Read-write. True to include halftone screen (default:
false).

interpolation boolean Read-write. True to use image interpolation (default:
false)

preview Preview Read-write. The type of preview (default:

Preview.MACOSEIGHTBIT).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: £alse).

typename string Read-only. The class name of the referenced
DCS1_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for saving a CMYK document in DCS2 format using the Document.saveAs() method.

Property Value type What it is

dcs DCSType Read-write. The type of composite file to create
(default: DcSType . NOCOMPOSITE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

multiFileDCS boolean Read-write. True to save color channels as multiple
files or a single file (default: false).

preview Preview Read-write. The preview type (default:
Preview.MACOSEIGHTBIT).

spotColors boolean Read-write. True to save spot colors.

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

typename string Read-only. The class name of the referenced
DCS2_SaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data
(unrasterized text).
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Options for opening a document in DICOM format using the Application.open() method.

Note: This feature is available in the Extended Version only.

Property Value type What it is

anonymize boolean Read-write. True to make the patient
information anonymous.

columns number Read-write. Number of columns in n-up
configuration.

reverse boolean Read-write. True to reverse (invert) the image.

rows number Read-write. The number of rows in n-up
configuration.

showOverlays boolean Read-write. True to show overlays.

typename string Read-only. The class name of the referenced
DICOMOpenOptions object.

windowLevel number Read-write. The contrast of the image in
Houndsfield units.

windowWidth number Read-write. The brightness of the image in
Houndsfield units.
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The active containment object for layers and all other objects in the script; the basic canvas for the file.

> Access the object for the currently active document through Application.activeDocument.

> You can access other documents, or iterate through all open documents using the list in the
Application.documents collection. You can access individual documents in the list by index, or use
Documents.getByName() to retrieve them by name.

> Create documents programmatically using the Documents.add() method.

See Document sample script and the Documents collection object for examples.

Note: In Adobe Photoshop, a document can also be referred to as an image or a canvas.

> The term image refers to the entire document and its contents. You can trim or crop an image.

You resize an image using the resizeImage () method.

> The term canvas refers to the space in which the document sits on the screen. You can rotate or
flip the canvas. You resize the canvas using the resizecanvas () method.

Property

Value type

Whatitis

activeChannels

activeHistoryBrushSource

activeHistoryState

activeLayer

artLayers

backgroundLayer

bitsPerChannel
channels
cloudDocument

cloudWorkAreaDirectory

colorProfileName

colorProfileType

colorSamplers

array of Channel

Guide

Guide

ArtLayer or
LayerSet

ArtLayers

ArtLayer

BitsPerChannelType

Channels
boolean

alias

string

ColorProfileType

ColorSamplers

Read-write. The selected channels.

Read-write. The history state to use with the
history brush.

Read-write. The selected HistorysState object.

Read-write. The selected layer.

Read-only. The art layers collection.

Read-only. The background layer of the
document.

Read-write. The number of bits per channel.
Read-only. The channels collection.
Read-only. This document is in the cloud.

Read-only. Local directory for this cloud
document.

Read-write. The name of the color profile.

Valid only when colorProfileType =
ColorProfile.CUSTOM Of WORKING.

Read-write. Whether the document uses the
working color profile, a custom profile, or no
profile.

Read-only. The current color samplers
associated with this document.
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Property Value type What it is (Continued)
componentChannels array of Channel Read-only. The color channels that make up
the document; for instance, the Red, Green,
and Blue channels for an RGB document.
countItems CountItems Read-only. The current count items.
Note: For additional information about count
items, see Adobe Photoshop help on the
Count Tool.
fullName File Read-only. The full path name of the
document.
guides Guides Read-only. The guides collection.
height Unitvalue Read-only. The height of the document (unit
value).
histogram array of number Read-only. A histogram showing the number
of pixels at each color intensity level for the
composite channel. The array c ontains 256
members.
Valid only when mode = DocumentMode.RGB,
CMYK; Of INDEXEDCOLOR.
historyStates HistoryStates Read-only. The history states collection.
info DocumentInfo Read-only. Metadata about the document.
layerComps LayerComps Read-only. The layer compositions collection.
layers Layers Read-only. The layers collection.
layerSets LayerSets Read-only. The layer set collection.
managed boolean Read-only. True if the document a is workgroup
document.
measurementScale MeasurementScale Read-only. The measurement scale for the
document.
Note: The measurement scale feature is
available in the Extended version only.
mode DocumentMode Read-only. The color profile.
name string Read-only. The document's name.
parent Application Read-only. The application object that contains
this document.
path File Read-only. The path to the document.
pathItems PathItems Read-only. The path items collection.
pixelAspectRatio number Read-write. The (custom) pixel aspect ratio to

[0.100..10.000]

use.
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Property Value type What it is (Continued)
printSettings DocumentPrintSettin Read-only. The print settings for the document.
gs

quickMaskMode boolean Read-write. True if the document is in Quick
Mask mode.

resolution number Read-only. The document’s resolution (in pixels
per inch).

saved boolean Read-only. True if the document has been

saved since the last change.

selection Selection Read-only. The selected area of the document.

typename string Read-only. The class name of the Document
object.

width Unitvalue Read-only. The width of the document (unit
value).

xmpMetadata xmpMetadata Read-only. XMP metadata for the document.

Camera RAW settings for the image are stored
here for example.
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Method Parameter type Returns What it does
yp
autoCount Counts the number of objects in a
(channel, Channel document. Available in the Extended
threshold) numbex Version only.
Creates a Countltem object for each
object counted.
For additional information about how to
set up objects to count, see the Count Tool
in the Adobe Photoshop Help
changeMode Changes the color profile of the
(destinationMode —9—@??'1 el\élode . document.
. BitmapConversionOptions
[, options]) or
IndexedConversionOptions
close Closes the document. If any changes have
([saving]) SaveOptions been made, the script presents an alert
with three options: save, do not save,
prompt to save. The optional parameter
specifies a selection in the alert box
(default: saveoptionsType.
PROMPTTOSAVECHANGES).
convertProfile Changes the color profile.
: : : string
(‘iireliZ;rtlatlonPrOflle’ Intent The destinationProfile parameter must
[, blackPointCompensation] Poolean be either a string that names the color
[, dither]) boolean mode or Working RGB, Working CMYK,
Working Gray, Lab Color (meaning one
of the working color spaces or Lab color).
crop Crops the document. The bounds
(bounds ar;;Y of ¢ UnitValue parameter is an array of four coordinates
[, angle] Eiitflilue for the region remaining after cropping,
:3th Unitvalue :
{' ﬁ;‘ii;h]t] ) Unitvalue [left, top, right, bottom].
duplicate Document | Creates a duplicate of the document
([name ] string object.
[, mergelLayersOnly] boolean

)

The optional parameter name provides the
name for the duplicated document.

The optional parameter
mergeLayersOnly indicates whether to
only duplicate merged layers.
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Method Parameter type Returns |What it does (Continued)
exportDocument Exports the paths in the document to an
(exportIn glle - [llustrator file, or exports the document to
Xpor ype . . . . .
E, E?jz;:ﬂ ExportOptionsTllustrator a fl|f§ vylth.Web or device viewing
+ P —or— optimizations.
ExportOptionsSaveForWeb
This is equivalent to choosing File >
Export > Paths To lllustrator, or File >
Save For Web and Devices.
flatten Flattens all layers in the document.
0
flipCanvas Flips the image within the canvas in the
(direction) Direction specified direction.
importAnnotations Imports annotations into the document.
(file) File
mergeVisibleLayers Flattens all visible layers in the document.
0
paste ArtLayer Pastesthe contents of the clipboard into
([intoSelection]) boolean the document. If the optional argument is
set to true and a selection is active, the
contents are pasted into the selection.
print Prints the document.
( [sourceSpace] SourceSpaceType ) .
[, printSpace] string printSpace specifies the color space for
[ intent] Intent the printer. Valid values are nothing (that
boolean

[blackPointCompensation] )

printOneCopy
0

rasterizeAllLayers
0

recordMeasurements

( [source]
[, dataPoints])

resizeCanvas
( [width]
[, height]
[, anchorl])

MeasurementSource
array of string

UnitValue
UnitValue
AnchorPosition

is, the same as the source); or working
RGB, Working CMYK, Working Gray, Lab
Color (meaning one of the working color
spaces or Lab color); or a string specifying
a specific colorspace (default is same as
source).

Print one copy of the document.

Rasterizes all layers.

Record measurements of document.

Changes the size of the canvas to display
more or less of the image but does not
change the image size. See resizelmage.
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Method Parameter type Returns |What it does (Continued)
resizeImage Changes the size of the image.
i dth UnitValue
( EWlhei;ht] UnitValue The amount parameter controls the
[ resolution] number amount of noise value when using
[, resampleMethod] ResampleMethod preserve details (Range: 0 - 100).
[, amount]) number
revealAll Expands the document to show clipped
0 sections.
rotateCanvas Rotates the canvas (including the image)
(angle) number in clockwise direction.
save Saves the document.
0
saveAs Saves the document in a specific format.
(saveIn File o if . .
[ options] Obj ect (See descrlptlon) SpeCI y the save OptlonS appropnate to
[ asCopy] boolean the format by passing one of these
[, extensionType]) Extension objects:
BMPSaveOptions
DCS1 SaveOptions
DCS2 SaveOptions
EPSSaveOptions
GIFSaveOptions
JPEGSaveOptions
PDFSaveOptions
PhotoshopSaveOptions
PICTFileSaveOptions
PICTResourceSaveOptions
PixarSaveOptions
PNGSaveOptions
RawSaveOptions
SGIRGBSaveOptions
TargaSaveOptions
TiffSaveOptions
splitChannels array of  Splits the document channels into
Document .
0 ————— separate images.
suspendHistory Provides a single entry in history states for
(historyString S’;r%ng the entire script provided by
javaScriptString) string javaScriptString. Allows a single undo
for all actions taken in the script.
The historyString parameter provides
the string to use for the history state.
The javaScriptString parameter
provides a string of JavaScript code to
excute while history is suspended.
trap Applies trapping to a CMYK document.
(Width) number

Valid only when docref.mode =
DocumentMode . CMYK.
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Method Parameter type Returns |What it does (Continued)
trim Trims the transparent area around the
([typel TrimType image on the specified sides of the canvas.
[, top] boolean
[ left] boolean Default is true for all Boolean parameters.
[, bottom] boolean
[, right]) boolean

The following script creates a document that contains two images (a sunflower and a duck) obtained from
the Adobe Photoshop Samples folder and employs the following steps:

?

Determines which image is larger.

Resizes the smaller image to match the larger image.

Creates a merged document twice as high as either image in order to hold both images.
Selects part of the document and pastes the sunflower into the selection.

Inverts the selection and pastes the duck into the lower part of the document.

Positions the sunflower over the duck.

Document.jsx

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// Open the sunflower and duck files from the samples folder
var flowerDoc = open(File (app.path + "/Samples/Sunflower.psd"))
var duckDoc = open(File (app.path + "/Samples/Ducky.tif"))

// Find out which document is larger
// Resize the smaller document the to the larger document’s size
// The resize requires the document be the active/front document
if ((flowerDoc.width.value * flowerDoc.height.value) >
(duckDoc.width.value * duckDoc.height.value)) ({
app.activeDocument = duckDoc
duckDoc.resize (flowerDoc.width, flowerDoc.height)
}
else {
app.activeDocument = flowerDoc
flowerDoc.resizeImage (duckDoc.width, duckDoc.height)

}

// Create a new document twice as high as two files
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var mergedDoc = app.documents.add (duckDoc.width, duckDoc.height * 2,
duckDoc.resolution, "FlowerOverDuck")

// Copy the flower to the top; make it the active document so we can manipulate it
app.activeDocument = flowerDoc
flowerDoc.activeLayer.copy ()

//Paste the flower to the merged document, making the merged document active
app.activeDocument = mergedDoc

// Select a square area at the top of the new document
var selRegion = Array (Array (0, 0),
Array (mergedDoc.width.value, 0),
Array (mergedDoc.width.value, mergedDoc.height.value / 2),
Array (0, mergedDoc.height.value / 2),
Array (0, 0))
// Create the selection
mergedDoc.selection.select (selRegion)

//Paste in the flower
mergedDoc .paste (TRUE)

// do the same thing for the duck
app.activeDocument = duckDoc
duckDoc.activeLayer.copy ()

app.activeDocument = mergedDoc
mergedDoc.selection.select (selRegion)

// Inverting the selection so the bottom of the document is now selected
mergedDoc.selection.invert ()

// Paste the duck
mergedDoc .paste (TRUE)

// get rid of our originals without modifying them
duckDoc.close (SaveOptions.DONOTSAVECHANGES)
flowerDoc.close (SaveOptions .DONOTSAVECHANGES)

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs
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The print settings for a document.

Property Value type What it is

backgroundColor SolidColor Read-write. Background color of page.

bleedWidth Unitvalue Read-write. Bleed width

caption boolean Read-write. Print the caption found in Filelnfo.

centerCropMarks boolean Read-write. Print center crop marks.

colorBars boolean Read-write. Print color calibration bars.

copies number Read-write. Number of copies to print.

cornerCropMarks boolean Read-write. Print corner crop marks.

colorHandling PrintColorHandling |Read-only. Color handling.

activePrinter string Read-write. The currently active printer.

flip boolean Read-write. Flip the image horizontally.

hardProof boolean Read-write. Print a hard proof.

interpolate boolean Read-write.

labels boolean Read-write. Prints the document title.

mapBlack boolean Read-write. Map blacks.

negative boolean Read-write. Invert the image colors.

renderIntent Intent Read-write. Color conversion intent when print
space is different from the source space.

posX Unitvalue Read-only. The x position of the image on
page.

posY UnitvValue Read-only. The y position of the image on
page.

printBorder UnitValue Read-write. The width of the print border.

printerName string Read-write. Name of the printer.

printSpace string Read-write. color space for printer. Can be
nothing (meaning same as source); 'Working
RGB', 'Working CMYK, 'Working Gray/, 'Lab
Color' (meaning one of the working spaces or
Lab color); or a string specifying a specific
colorspace (default is same as source)

registrationMarks boolean Read-write. Print registration marks.
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Property Value type What it is (Continued)
scale number Read-only. Scale of image on page.

vectorData boolean Read-write. Include vector data.
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Method Parameter type Returns What it does
setPagePosition Set the position of the image on the page.
(docPosition DocPositionStyle
pOSX, UnitValue
posY, UnitValue
number

scale)
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Metadata about a document object.

Access through the Document.info property. For example, the following sets the author, caption, and
copyrighted properties:

var docRef = open(fileList[i])

// set the file info

docRef .info.author = "Mr. Adobe programmer"

docRef .info.caption = "Adobe Photo shoot"

docRef .info.copyrighted = CopyrightedType.COPYRIGHTEDWORK

These values can be set interactively by choosing File > File Info.

Property Value type What it is

author string Read-write.

authorPosition string Read-write.

caption string Read-write.

captionWriter string Read-write.

category string Read-write.

city string Read-write.

copyrighted CopyrightedType Read-write. The copyrighted status.

copyrightNotice string Read-write.

country string Read-write.

creationDate string Read-write.

credit string Read-write.

exif array of array [tag data] Read-only. Camera data that includes
camera settings used when the image
was taken.

Each array member is a tag pair, an array
of [tag, tag_data]; for example, [

"camera" "Cannon"].

headline string Read-write.

instructions string Read-write.

jobName string Read-write.

keywords array of string Read-write. A list of keywords that can
identify the document or its contents.

ownerUrl string Read-write.
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Property Value type What it is (Continued)
parent Document Read-only. The info object's container.
provinceState string Read-write.
source string Read-write.
supplementalCategories array of string Read-write.
title string Read-write.
transmissionReference string Read-write
typename string Read-only. The class name of the

referenced info object.

urgency Urgency Read-write.

The following script sets document info (metadata) for all of the files in a specified folder and then saves
the modified files as low-quality JPEG images in a new folder without changing the originals.

?

Ask the user to specify the folder that contains the original files and the output folder for the JPEG
images, and then check that the folders exist.

Open each file and use the document Info object properties to tag it with the following metadata:
» author: Adobe programmer

> caption: Adobe Photo shoot

» captionWriter: Adobe programmer

> city: San Jose

> copyrightNotice: Copyright (c) Adobe programmer Photography

2 copyrighted status: Copyrighted Work

> country: USA

» state: CA

Save the new documents in JPEG format with a low quality setting.

Documentinfo.jsx

// Save the current preferences
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs
app.displayDialogs = DialogModes.NO

// ask the user for the input and output folders
var inputFolder = Folder.selectDialog("Select a folder to tag")
var outputFolder = Folder.selectDialog("Select a folder for the output files")

// see if we got something interesting from the dialog
if (inputFolder != null && outputFolder != null) ({

// get all the files found in this folder

var filelList = inputFolder.getFiles()
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// save the outputs in JPEG
var jpegOptions = new JPEGSaveOptions ()
// set the jpeg quality really low so the files are small
jpegOptions.quality =1
// open each one in turn
for (var i = 0; i < fileList.length; i++) {
// The fileList includes both folders and files so open only files
if (fileList[i] instanceof File && fileList[i] .hidden == false) ({
// get a reference to the new document
var docRef = open(fileList[i])

// tag all of the documents with photo shoot information

docRef.info.author = "Adobe programmer"

docRef.info.caption = "Adobe Photo shoot"

docRef .info.captionWriter = "Adobe programmer"

docRef.info.city = "San Jose"

docRef .info.copyrightNotice = "Copyright (c) Adobe programmer
Photography"

docRef .info.copyrighted = CopyrightedType.COPYRIGHTEDWORK
docRef .info.country = "USA"
docRef .info.provinceState = "CA"

// change the date to a Adobe Photoshop date format
// "YYYYMMDD"
var theDate = new Date ()
// the year is from 1900 ?2???
var theYear = (theDate.getYear() + 1900) .toString/()
// convert the month from 0..12 to 00..12
var theMonth = theDate.getMonth() .toString/()
if (theDate.getMonth() < 10) {
theMonth = "0" + theMonth
}
// convert the day from 0..31 to 00.31
var theDay = theDate.getDate () .toString()
if (theDate.getDate() < 10) {
theDay = "0" + theDay
}
// stick them all together
docRef.info.creationDate = theYear + theMonth + theDay

// flatten because we are saving to JPEG

docRef .flatten()

// go to 8 bit because we are saving to JPEG
docRef .bitsPerChannel = BitsPerChannelType.EIGHT

// save and close
docRef .savels (new File (outputFolder + "/Output" + i + ".jpg"), jpegOptions)

// don’t modify the original
docRef .close (SaveOptions .DONOTSAVECHANGES)

}

// Reset the application preferences
app.displayDialogs = startDisplayDialogs
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The collection of open Document objects.

Access this list through the Application.documents collection property, which is available through the app
global variable, or directly at the top level. For example, the following adds a new document to the
collection:

app.documents.add (800, 500, 72, "myDocument", NewDocumentMode.RGB)

documents.add (800, 500, 72, "myDocument", NewDocumentMode.RGB)

Property Value type Whatitis
length number Read-only. The number of elements in the documents
collection.
parent Application Read-only. The containing application.
typename string Read-only.The class name of the referenced documents
object.
Method Parameter type Returns What it does
add Document Creates a new document object and
([width] UnitValue adds it to this collection.
[, height] UnitValue
[, resolution] number pixelAspectRatio: Defaultis 1.0, a
[, name] string square aspect ratio.
[, mode] NewDocumentMode
[, initialFill] DocumentFill bitsPerChannelType: Default is
[, pixelAspectRatio] mllmber [0.1..10.00] BitsPerChannelType.EIGHT.
[, bitsPerChannel] BitsPerChannelType
! string
[, colorProfileName] )
getByName string Document Gets the first element in the
(name) documents collection with the

provided name
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Options for opening a document in EPS format using the Application.open() method.

Property Value type What it is

antiAlias boolean Read-write. True to use antialias.

constrainProportions boolean Read-write. True to constrain the proportions of
the image.

height Unitvalue Read-write. The height of the image (unit
value).

mode OpenDocumentMode |Read-write. The color profile to use as the
document mode.

resolution number Read-write. The resolution of the document in
pixels per inch.

typename string Read-only. The class name of the referenced
EPSOpenOptions object.

width Unitvalue Read-write. The width of the image (unit value).
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Options for saving a document in EPS format using the Document.saveAs() method.

Property Value type What it is

embedColorProfile boolean Read-write. True to embed the color profile in this
document.

encoding SaveEncoding Read-write. The type of encoding to use (default:
SaveEncoding.BINARY).

halftoneScreen boolean Read-write. True to include the halftone screen
(default: false).

interpolation boolean Read-write. True to use image interpolation (default:
false).

preview Preview Read-write. The preview type.

psColorManagement boolean Read-write. True to use Postscript color management
(default: talse).

transferFunction boolean Read-write. True to include the Transfer functions to
compensate for dot gain between the image and film
(default: false).

transparentWhites boolean Read-write. True to display white areas as
transparent.
Valid only when document.mode =
DocumentMode . BITMAP. See also changeMode().

typename string Read-only. The class name of the referenced
EPSSaveOptions object.

vectorData boolean Read-write. True to include vector data.

Valid only if the document includes vector data (text).
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Options for exporting Pathltem objects to an Adobe Illustrator® file using using the

Document.exportDocument() method. These options are the options that you can provide when you
choose File > Export > Paths To lllustrator.

Property Value type What it is
path IllustratorPathType Read-write. The type of path to export
(default:

IllustratorPathType . DOCUMENTBOUNDS).

pathName string Read-write. The name of the path to export.

Valid only when path =
IllustratorPathType.NAMEDPATH.

typename string Read-only. The class name of the referenced
exportOptionsIllustrator object.
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Options for optimizing a document for the web or devices using the Document.exportDocumenty()
method. These are the options that you can provide when you choose File > Save For Web and Devices.

Property Value type What it is

blur number Read-write. Applies blur to the image to reduce
artifacts (default: 0. 0).

colorReduction ColorReductionType  Read-write. The color reduction algorithm (default:
ColorReductionType.SELECTIVE).

colors number Read-write. The number of colors in the palette
(default: 256).

dither Dither Read-write. The type of dither (default:
Dither.DIFFUSION).

ditherAmount number Read-write. The amount of dither (default: 100).
Valid only when
dither = Dither.DIFFUSION.

format SaveDocumentType  Read-write. The file format to use (default:
SaveDocumentType . COMPUSERVEGI F).
Note: For this property, only COMPUSERVEGIF,

JPEG, PNG-8, PNG-24, and BMP are
supported.

includeProfile boolean Read-write. True to include the document’s
embedded color profile (default: false).

interlaced boolean Read-write. True to download in multiple passes;
progressive (default: false).

lossy number Read-write. The amount of lossiness allowed
(default: o).

matteColor RGBColor Read-write. The colors to blend transparent pixels
against.

optimized boolean Read-write. True to create smaller but less
compatible files (default: true).
Valid only when
format = SaveDocumentType.JPEG.

PNGS8 boolean Read-write. Indicates the number of bits; t rue = 8,

false = 24 (default: true).

Valid only when
format = SaveDocumentType.PNG.
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Property Value type What it is (Continued)

quality number [0..100] Read-write. The quality of the produced image as a
percentage; default: 60.

transparency boolean Read-write. Indication of transparent areas of the
image should be included in the saved
image(default: true).

transparencyAmount number Read-write. The amont of transparency dither
(default: 100).
Valid only if transparency = true.

transparencyDither Dither Read-write. The transparency dither algorithm
(default: transparencyDither = Dither.NONE).

typename string Read-only. The class name of the referenced
ExportOptionsSaveForWeb object.

webSnap number Read-write. The tolerance amount within which to

snap close colors to web palette colors (default: o).
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ExtendScript defines the JavaScript classes File and Folder to encapsulate file-system references in a
platform-independent manner; see ‘JavaScript support in Adobe Photoshop’ on page 32. For references
details of these classes, see the JavaScript Tools Guide.
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Options for the bannerOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

contactInfo string Read-write. The web photo gallery
contact info.

date string Read-write. The web photo gallery date
(default: current date).

font GalleryFontType Read-write. The font setting for the
banner text (default:
GalleryFontType.ARIAL).

fontSize number [1..7] Read-write. The font size for the banner
text (default: 3).

photographer string Read-write. The web photo gallery
photographer.

siteName string Read-write. The web photo gallery site
name (default:
Adobe Web Photo Gallery).

typename string Read-only. The class name of the

referenced galleryBannerOptions
object.
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Options for the customColorOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

activeLinkColor RGBColor Read-write. The color to use to indicate
an active link.

backgroundColor RGBColor Read-write. The background color.

bannerColor RGBColor Read-write. The banner color.

linkColor RGBColor Read-write. The color to use to indicate a
link.

textColor RGBColor Read-write. The text color.

typename string Read-only. The class name of the
referenced
galleryCustomColorOptions object.

visitedLinkColor RGBColor Read-write. The color to use to indicate a

visited link.
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Options for the imagesOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

What it is

border

caption

dimension

font

fontSize

imageQuality

includeCopyright

includeCredits

includeFilename

includeTitle

numericLinks

number [0..99]

boolean

number

GalleryFontType

number [1..7]

number [0..12]

boolean

boolean

boolean

boolean

boolean

Read-write. The size (in pixels) of the border
that separates images (default: o).

Read-write. True to generate image captions
(default: talse).

Read-write. The resized image dimensions in
pixels (default: 350).

Valid only when resizelmages = true.

Read-write. The font to use for image
captions (default: calleryFontType .ARIAL).

Read-write. The font size for image captions
(default: 3).

Valid only when caption = true.

Read-write. The quality setting for a JPEG
image (default: 5).

Read-write. True to include copyright
information in captions (default: false).

Valid only when caption = true.

Read-write. True to include the credits in
image captions (default: false).

Valid only when caption = true.

Read-write. True to include the file name in
image captions (default: true).

Valid only when caption = true.

Read-write. True to include the title in image
captions (default: false).

Valid only when caption = true.

Read-write. True to add numeric links
(default: true).
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Property

Value type

What it is (Continued)

resizeConstraint

resizeImages

typename

GalleryConstrainType

boolean

string

Read-write. The image dimensions to
constrain in the gallery image (default:
GalleryConstrainType . CONSTRAINBOTH).

Valid only when resizelmages = true.
Read-write. True to automatically resize

images for placement on the gallery pages
(default: true).

Read-only. The class name of the referenced
galleryImagesOptions ObECt




JavaScript Scripting Reference

Adobe Photoshop

JavaScript Object Reference 115

Options for a Web photo gallery, created with Application.makePhotoGallery().

Tip: You can preserve default values for many of these properties by choosing File > Automate > Web
Photo Gallery, and then choosing Preserve all metadata in the Options area of the Web Photo

Gallery dialog.
Property Value type What it is
addsSizeAttributes boolean Read-write. True to add width and
height attributes for images (default:
true).
bannerOptions GalleryBannerOptions Read-write. The options related to

customColorOptions

emailAddress

imagesOptions

includeSubFolders

layoutsStyle

preserveAllMetadata

securityOptions

thumbnailOptions

typename

useShortExtension

useUTF8Encoding

GalleryCustomColorOptions

string

GalleryImagesOptions

boolean

string

boolean

GallerySecurityOptions

GalleryThumbnailOptions

string

boolean

boolean

banner settings.

Read-write. The options related to
custom color settings.

Read-write. The email address to show
on the web page.

Read-write. The options related to
images settings.

Read-write. True to include all files
found in sub folders of the input
folder (default: true).

Read-write. The style to use for laying
out the web page (default: centered
Frame 1 - Basic).

Read-write. True to save metadata
(default: false).

Read-write. The options related to
security settings.

Read-write. The options related to
thumbnail image settings.

Read-only. The class name of the
referenced galleryoptions object.

Read-write. True to use the short web
page extension .htm. If false, use the
web page extension .html (default:
true).

Read-write. True to use UTF-8
encoding for the web page (default:
false).
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Options for the securityOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property

Value type

What it is

content

font

fontSize

opacity

text

textColor

textPosition

textRotate

typename

GallerySecurityType

GalleryFontType

number [1..72]

number

string

GallerySecurityTextColorType

GallerySecurityTextPositionType

GallerySecurityTextRotateType

string

Read-write. The web photo gallery
security content (default:
GallerySecurityType .NONE).

Read-write. The web photo gallery
security font (default:
GalleryFontType.ARIAL).

Read-write. The web photo gallery
security font size (default: 3).

Read-write. The web page security
opacity as a percent (default: 100).

Read-write. The web photo gallery
security custom text.

Read-write. The web page security text
color.

Read-write. The web photo gallery
security text position (default:
GallerySecurityTextPositionType.
CENTERED).

Read-write. The web photo gallery
security text orientation to use (default:
GallerySecurityTextRotateType.
ZERO).

Read-only. The class name of the
referenced gallerySecurityOptions
object.
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Options for the thumbnailOptions property of the GalleryOptions object.

Tip: You can preserve default values for many of these properties by setting the GalleryOptions property
preserveAllMetadata to true; this is the same as choosing File > Automate > Web Photo Gallery, and

then choosing Preserve all metadata in the Options area of the Web Photo Gallery dialog.

Property Value type What it is

border number [0..99] Read-write. The amount of border pixels you
want around your thumbnail images (default:
0).

caption boolean Read-write. True if there is a caption (default:
false).

columnCount number Read-write. The number of columns on the
page (default: 5).

dimension number Read-write. The web photo gallery thumbnail
dimension in pixels (default: 75).

font GalleryFontType Read-write. The web photo gallery font
(default: GalleryFontType . ARIAL).

fontSize number [1..7] Read-write. The font size for thumbnail
images text (default: 3).

includeCopyright boolean Read-write. True to include copyright
information for thumbnails (default: false).

includeCredits boolean Read-write. True to include credits for
thumbnails (default: faise).

includeFilename boolean Read-write. True to include file names for
thumbnails (default: false).

includeTitle boolean Read-write. True to include titles for
thumbnails (default: faise).

rowCount number Read-write. The number of rows on the page
(default: 3).

size GalleryThumbSizeType | Read-write. The thumbnail image size
(default: GalleryThumbSizeType . MEDIUM).

typename string Read-only. The class name of the referenced

GalleryThumbnailOptions object.
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Options for saving a document in GIF format using the Document.saveAs() method.

Property Value type What it is

colors number Read-write. The number of palette colors.
Valid only when palette -
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE; Of WINDOWSPALETTE .

dither Dither Read-write. The dither type.

ditherAmount number [1..100] | Read-write.The amount of dither (default: 75).
Valid only when dither = Dither.DIFFUSION.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

interlaced boolean Read-write. True if rows should be interlaced
(default: false).

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: MatteType . WHITE).
When transparency = false, the matte coloris
applied to transparent areas.

palette PaletteType Read-write. The type of palette to use (default:

preserveExactColors

transparency

typename

boolean

boolean

string

Palette.LOCALSELECTIVE).

Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

Read-only. The class name of the referenced
GIFSaveOptions object.
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Defines a gray color, used in the SolidColor object.

See also CMYKColor, HSBColor, LabColor, NoColor, RGBColor

Property Value type What it is
gray numpber [0.0..100.0] Read-write. The gray value (default: 0.0).
typename string

Read-only. The class name of the referenced graycolor
object.
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Property Value type What it is

direction Direction Read-write. Indicates whether the guide is
vertical or horizontal.

coordinate

UnitValue Read-write. Location of the guide from origin
of image.
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The collection of open Guide objects.

Access this list through the Document.guides collection property, which is available through the
activeDocument object. For example, the following adds a new guide to the collection:

activeDocument.guides.add (Direction.HORIZONTAL,UnitValue (20,20))

Property Value type What it is
length number Read-only. The number of elements in the guides
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced guides
object.
Method Parameter type Returns What it does
add . . Guide Creates a new guide object and adds
(direction Direction it to this collection.
, coordinate) UnitValue
getByName string Guide Gets the first element in the guides
(name)

collection with the provided name
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A version of the document stored automatically (and added to the HistoryStates collection), which
preserves the document’s state, each time the document is changed.

Access through Document.historyStates collection. You can access a state in the list by name. For example,
this assigns a property value in the state object named "AddLayerMask":

var stateRef = app.activeDocument.historyState.getByName ("AddLayerMask") ;
stateRef.snapshot = true;

Property Value type Whatitis

name string Read-only. The HistoryState object's name.

parent Document Read-only. The containing document.

snapshot boolean Read-only. True if the history state is a snapshot.

typename string Read-only. The class name of the referenced Historystate

object.
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The collection of Guide objects in the document.

Access through Document.historyStates collection property. For example, this accesses one of the states in
the collection by index:

myState = app.activeDocument.historyStates[7];

Property Value type What it is

length number Read-only. The number of elements in the Historystates
collection.

parent Document Read-only. The containing document.

typename string Read-only. The class name of the referenced

HistoryStates object.

Method Parameter type Returns What it does
getByName Guide Get the first element in the
(name) string

HistoryStates collection with the
provided name.
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Defines an HSB color, used in the SolidColor object.

See also CMYKColor, GrayColor, LabColor, NoColor, RGBColor

Property

Value type

What it is

brightness
hue
saturation

typename

number [0.0..100.0]
number [0.0..360.0]
number [0.0..100.0]

string

Read-write. The brightness value.
Read-write. The hue value.
Read-write. The saturation value.

Read-only. The class name of the referenced HsBColor
object.
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Options for converting an RGB image to an indexed color model using Document.changeMode().

Property Value type Whatiit is

colors number Read-write. The number of palette colors.

Valid only when palette =
Palette.LOCALADAPTIVE, LOCALPERCEPTUAL,
LOCALSELECTIVE, MACOSPALETTE, UNIFORM,
WEBPALETTE, or WINDOWSPALETTE.

dither Dither Read-write. The dither type.

ditherAmount number [1..100] Read-write. The amount of dither.

Valid only when dither = Dither.diffusion.

forced ForcedColors Read-write. The type of colors to force into the
color palette.

matte MatteType Read-write. The color to use to fill anti-aliased
edges adjacent to transparent areas of the image
(default: MatteType . WHITE).

When transparency = false, the matte color is
applied to transparent areas.

palette PaletteType Read-write. The palette type (default:
Palette.EXACT).

preserveExactColors boolean Read-write. True to protect colors in the image
that contain entries in the color table from being
dithered.

Valid only when dither = Dither.DIFFUSION.

transparency boolean Read-write. True to preserve transparent areas of
the image during conversion to GIF format.

typename string Read-only. The class name of the referenced
IndexedConversionOptions object.
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Options for saving a document in JPEG format using the Document.saveAs() method.

Property Value type Whatiit is

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

formatOptions FormatOptions Read-write.The download format to use (default:

FormatOptions.STANDARDBASELINEl

matte MatteType Read-write. The color to use to fill anti-aliased edges
adjacent to transparent areas of the image (default:
MatteType.WHITE).

When transparency is turned off for an image, the
matte color is applied to transparent areas.

quality number [0..12] Read-write. The image quality setting to use; affects
file size and compression (default: 3).

scans number [3..5] Read-write. The number of scans to make to
incrementally display the image on the page
(default: 3).

Valid only for when formatOptions =
FormatOptions.PROGRESSIVE.

typename string Read-only. The class name of the referenced
JPEGSaveOptions object.
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Defines an LAB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, NoColor, RGBColor

Property

Value type

What it is

a
b
1

typename

number [-128.0..127.0]
number [-128.0..127.0]
number [0.0..100.0]

string

Read-write. The a-value.
Read-write. The b-value.
Read-write. The L-value.

Read-only. The class name of the referenced
LabColor object.
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A snapshot of a state of the layers in a document, which can be used to view different page layouts or

compositions.

Access through Document.layerComps collection. You can access a layer comp by its name. For example,

this sets the comment property value for a Layercomp object named myLayerComp:

var layercompRef

= app.activeDocument.layerComps.getByName ("myLayerComp") ;

layercompRef .comment = "View from shoreline";
Property Value type What it is
appearance boolean Read-write. True to use layer appearance (layer styles)

childLayerCompState boolean

settings.

Read-write. True to track child Smart Objects layer comp.

comment string Read-write. A description of the layer comp.

name string Read-write. The name of the layer comp.

parent Document Read-write. The containing document.

position boolean Read-write. True to use layer position.

selected boolean Read-only. True if the layer comp is currently selected.

typename string Read-only. The class name of the referenced 1ayercomp

object.

visibility boolean Read-write. True to use layer visibility settings.

Method Parameter type Returns What it does

apply Applies the layer comp to the document.
O

recapture Recaptures the current layer state(s) for
0 this layer comp.

remove Deletes the 1ayercomp object.
O

resetfromComp Resets the layer comp state to the

0

document state.
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The collection of LayerComp objects in the document.

Access through the Document.layerComps collection property. For example:

app.activeDocument.layerComps.add ("myLayerComp", "View from Shoreline",
true, true, true);

Property Value type Whatitis
length number Read-only. The number of elements in the 1ayercomps
collection.
parent Document Read-only. The containing document.
typename string Read-only. The class name of the referenced
layerComps object.
Method Parameter type Returns What it does
add LayerComp Creates a new layer composition
(name, string object and adds it to this collection.
comment, string
appearance, Eooiean
position, boolean
visibility, oo-ean
childLayerCompState) boolean
getByName LayerComp Gets the first element in the
(name) string collection with the provided name.
removeAll Removes all member objects from

0

the layercomps collection.
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The collection of layer objects, including ArtLayer and LayerSet objects, in the document. Access through
Document.layers, or the LayerSet.layers collections properties.

For example, this uses the 1ength property to count the number of 1ayer objects in the active document,
then displays the number on the screen:

var layerNum

app.activeDocument.layers.length

alert (layerNum)

Property Value type What it is
length number Read-only. The number of elements in the 1ayers
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayers object.
Method Parameter type  Returns What it does
getByName . Layer Gets the first element in the 1ayers
(name) string collection with the provided name.
removeAll

0

Removes all layers from the collection.
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A group of layer objects, which can include ArtLayer objects and other (nested) Layerset objects. A single
command can manipulate all layers in the set.

Access top-level layers sets in a document through the Document.layerSets collection. You can access a
layer set by name. For example, the following sets the al1Locked value for "myLayerSet":

var layerSetRef = app.activeDocument.layerSets.getByName ("myLayerSet") ;
layerSetRef.allLocked = true

Access nested layer sets through the LayerSet.layerSets collection in the parent set. For example:

app.activeDocument.layerSets [0] .layerSets[0];

Property Value type What it is

allLocked boolean Read-write. True if the contents in the layers in this set
are not editable.

artLayers ArtLayers Read-only. The art layers in this layer set.

blendMode BlendMode Read-write. The blend mode to use for the layer set.
bounds array of UnitValue Read-only.The bounding rectangle of the layer set.
enabledChannels array of Channel Read-write. The channels enabled for the layer set; must

be a list of component channels. See Channel.kind.

layers Layers Read-only. The layers in this layer set.
layerSets LayerSets Read-only. Nested layer sets contained within this layer
set.
linkedLayers array of ArtLayer  Read-only.The layers linked to this 1ayerset object.
and/or LayerSet
name string Read-write. The name of this layer set.
opacity number [0.0..100.0] Read-write. The master opacity of the set.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced Layerset
object.

visible boolean Read-write. True if the set is visible.
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Method Parameter type Returns What it does
duplicate LayerSet Creates a duplicate of the object.
([relativeObiject] artlayer or
LayerSet
. \ , ElementPlacement
[, insertionLocation])
link Links the layer set with another
(with) ArtLayer or |ayer
LayerSet '
merge ArtLayer Merges the layerset; returns a

0 reference to the art layer created
by this method.

move Moves the object.
(relativeObject ArtLayer or
! LayerSet
El tPl t
insertionLocation) el Heeril
remove Deletes the object.
0
resize Resizes all layers in the layer set to
([horizontall nuﬁer to the specified dimensions (as a
, vertical numoer i i
E e ] AnchorPosition percentage of its cu.rrent size) and
' places the layer set in the
specified position.
rotate Rotates all layers in the layer set
(angle numl;ler o around the specified anchor point
[, anchor]) AnchorPosition (default:
AnchorPosition.MIDDLECENTER)
translate Moves the position relative to its
([deltaX] UnitvValue current position.
[, deltaY]) UnitValue P

unlink Unlinks the layer set.
O
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The collection of LayerSet objects in the document.

Access the top-level layer sets in a document through the Document.layerSets collection property. For
example:

var layerSetRef = app.activeDocument.layerSets.add ()

Access the nested layer sets through the LayerSet.layerSets collection property in the parent set. For
example:

var layerSetRef = app.activeDocument.layerSets.getByName ("myParentSet") ;
var childSet = layerSetRef.layerSets.getByName ("myChildSet") ;

Property Value type What it is
length number Read-only. The number of elements in the Layersets
collection.
parent Document or Read-only. The containing document or layer set.
LayerSet
typename string Read-only. The class name of the referenced 1ayersets
object.
Method Parameter type Returns What it does
add LayerSet Creates a new layer set object and adds it to
0 the collection.
getByName . LayerSet Gets the first element in the collection with
(name) string the provided name.
removeAll Removes all member layer sets, and any
0 layers or layer sets they contain, from the
document.

The following script creates three layer sets, then nests a second layer set in each layer set, and then
creates a text layer in each nested set that that displays the text "Layer in n Set Inside n Set", where n
represents the ordinal number of the set (first, second, or third).

Note: This script uses the ExtendScript ¢ debugging object. For further details, see the JavaScript Tools
Guide.

LayerSets.jsx
S.level = 1

//close all open documents
while (app.documents.length)
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app.activeDocument.close ()

}

// create a working document
var docRef = app.documents.add()

// create an array to hold the layer sets
var myLayerSets = new Array ()

// Create an array to hold the text
var textArray = Array("First", "Second", "Third")

//Create an indexer variable
var i = 0

// Create three layer sets at the top level
for (i = 0; 1 < 3; 1i++) {
myLayerSets[i] = new Array ()
myLayerSets[i] [0] = docRef.layerSets.add()

}

// Rearrange the layer sets with the first one on top, second next, etc.
myLayerSets[1] [0] .moveAfter (myLayerSets [0] [0])
myLayerSets[2] [0] .moveAfter (myLayerSets[1] [0])

// Create a layer set inside each layer set

for (i = 0; 1 < 3; i++) {
myLayerSets[i] [0] .name = textArray[i] + " Set"
myLayerSets[i] [1] = myLayerSets[i] [0] .layerSets.add ()
myLayerSets[i] [1] .name = "Inside " + textArray[i] + " Set™"

}

// Create an array to hold the layers
var myLayers = new Array ()

// Create a text layer with a description inside each layer set
for (i = 0; 1 < 3; i++) {

myLayers[i] = myLayerSets[i] [1].artLayers.add ()
myLayers [i] .kind = LayerKind.TEXT
myLayers[i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "

+ textArray[i] + " Set"

myLayers [i] .textItem.position = Array (app.activeDocument.width * i * 0.33,
app.activeDocument.height * (i + 1) * 0.25)

myLayers[i] .textItem.size = 12
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The measurement log for the application. Access through the Application.measurementLog property.

Note: This feature is available in the Extended Version only.

Method Parameter type Returns  What it does
exportMeasurements Export measurement to a file.
([file] File
[, rangel) MeasurementRange
[, dataPoints]) array of string
deleteMeasurements Delete measurements from
([range]) MeasurementRange the Iog.
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The measurement scale for the document. Access through the Document.measurementScale property.
For example:

app.activeDocument .measurementScale.pixelLength = 25

Note: This feature is available in the Extended Version only.

Property Value type What it is
pixelLength number Read-write. The length in pixels this scale equates to.
logicalLength number Read-write. The logical length this scale equates to.

logicalUnits string Read-write. The logical units for this scale.




Adobe Photoshop
JavaScript Scripting Reference JavaScript Object Reference 137

Represents a missing color object, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, RGBColor

Property Value type What it is

typename string Read-only. The class name of the referenced nocolor

object.
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An event-handler object that tells a script to execute specified code when a specified event occurs.
Notifiers must be enabled using the Application.notifiersEnabled property.

Access through the Application.notifiers collection.

Note: Events that occur within scripts do not generally trigger notifiers, because they occur inside a "play
script" event.

Property Value type What it is

event string Read-only. The event identifier, a four-character code or a
unique string.

For a list of four-character codes, see Appendix A: Event ID
Codes.

eventClass string Read-only. The class identifier, a four-character code or a
unique string.

When an event applies to multiple types of objects, use this
propery to distinguish which object this notifier applies to.
For example, the Make event ("Mk ") can apply to
documents ("Demn"), channels ("chnl") and other objects.

eventFile File Read-only. The path to the file to execute when the event
occurs and activates the notifier.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced object.
Method Parameter type Returns What it does

remove Deletes this object.

0 You can also remove a Notifier object

from the Script Events Manager
drop-down list by deleting the file named
Script Events Manager.xml from the
Photoshop preferences folder. See Adobe
Photoshop help for more information.
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The collection of Notifier objects in the document. Access through the Application.notifiers collection
property. For example:

var notRef = app.notifiers.add("OnClickGoButton", eventFile)

Notifiers must be enabled using the Application.notifiersEnabled property.

Property Value type What it is

length number Read-only. The number of elements in the notifiers
collection.

parent Application Read-only. Thenotifiers object’'s container

typename string Read-only. The class name of the referenced notifiers object.

Method Parameter type Returns What it does

add . Notifier Creates a notifier object and adds it to this
(event, string collection.

eventFile File defines the cl fth :
L aventclass]) | String event defines the class ID of the event: use a

4-characters code or a unique string. See
Appendix A: Event ID Codes.

eventFile defines the script file that
executes when the event occurs.

When an event applies to multiple types of
objects, use the eventclass (a 4-character ID
or unique string) to distinguish which object
this Notifier applies to. For example, the
Make event ("mk ") applies to documents
("Demn), channels ("chnl") and other
objects.

Tip: When specifying an event or event calss
wtih a 4-character ID code, omit the
single quotes in your code.

removeAll Removes all member objects from the
0 notifiers collection.

You can also remove a notifier object from
the Script Events Manager drop-down list by
deleting the file named script Events
Manager.xml from the Photoshop
preferences folder. See Adobe Photoshop
help for more information.
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A path or drawing object, such as the outline of a shape or a straight or curved line, which contains sub

paths that define its geometry.

Access through the collection in the Document.pathltems property. For example, this selects a named

path item:

var currentPathItem = app.activeDocument.pathItems.getByName ("myPath") ;
currentPathItem.select ()

Create these objects by passing a set of SubPathInfo objects to the Pathltems.add() method. This method
creates a SubPathltem object for each SubPathinfo object, and creates and returns a new Pathltem object
for the path represented by all of the subpaths.

Property Value type Whatitis
kind PathKind Read-write. The type.
name string Read-write. The name.
parent Document Read-only. The containing document.
subPathItems SubPathItems  Read-only. The contained sub-path objects.
typename string Read-only. The class name of the referenced
pathItem object.
Method Parameter type Returns  What it does
deselect Deselects this pathItem
0 object.
duplicate Duplicates this
(name) string pathItemobject with
the new name.
fillPath Fills the area enclosed by
([fillColor] SolidColor this path.
[, mode] ColorBlendMode
[, opacity] number [0..100] opacity is a percentage.
! boolean
{’ ?Zziig‘]eTranSparemy] number [0.0..250.0] feather is in pixels.
) boolean .
[, wholePath] If wholePath is true, all
[, antiAlias]) boolean

subpaths are used when
doing the fill (default:

true).
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Method Parameter type Returns  What it does
makeClippingPath Makes this the clipping
([flatness]) number [0.2..100] path for this document.
flatness tells the
PostScript printer how to
approximate curvesin
the path.
makeSelection Makes a Selection object
([feather] Eumlfer [0.0..250.0] whose border is this
. . oolean
E' 2;Z;iiiii}) SelectionType path.
feather is in pixels.
remove Deletes this object.
0
select Makes this the active or
0 selected PathItem
object.
strokePath Strokes the path with
([tool] ToolType the specified tool.
[, simulatePressure]) boolean

The following creates a path in three segments: two diagonal lines that form a V, and a curved line above

the V that makes it look like a 2D ice cream cone.

Paths.jsx

// Save the current preferences

var startRulerUnits = app.preferences.rulerUnits
var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs

app.preferences.rulerUnits = Units.PIXELS
app.preferences.typelUnits = TypeUnits.PIXELS

app.displayDialogs = DialogModes.NO

// first close all the open documents
while (app.documents.length)
app.activeDocument.close ()

}

// create a document to work with

var docRef = app.documents.add (5000, 7000,

"Simple Line")

//line 1--it’s a straight line so the coordinates for anchor, left, and right
//for each point have the same coordinates
var lineArray = new Array ()

lineArray[0] = new PathPointInfo

lineArray[0] .kind = PointKind.CORNERPOINT

lineArray [0] .anchor = Array (100, 100)
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lineArray [0]
lineArray[0]

lineArray[1]
lineArray [1]
lineArray [1]
lineArray [1]
lineArray [1]

var lineSubPathArray =

lineSubPathAr
lineSubPathAr
lineSubPathAr
lineSubPathAr

// line 2

var lineArray2 =
lineArray2[0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]
lineArray2 [0]

lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]
lineArray2[1]

lineSubPathArray[1] =
lineSubPathArray [1]
lineSubPathArray[1] .
lineSubPathArray[1]

.leftDirection = lineArray[0] .anchor
.rightDirection =

lineArray[0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT
.anchor = Array (150, 200)
.leftDirection = lineArray[1l] .anchor
.rightDirection =

lineArray[1l] .anchor

new Array ()

ray[0] = new SubPathInfo ()

ray [0] .operation = ShapeOperation.SHAPEXOR
ray[0] .closed = false

ray[0] .entireSubPath = lineArray

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (150, 200)
.leftDirection = lineArray2[0] .anchor
.rightDirection = lineArray2[0] .anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)
.leftDirection = lineArray2[1l] .anchor
.rightDirection = lineArray2[1l].anchor

new SubPathInfo ()

.operation = ShapeOperation.SHAPEXOR
closed = false

.entireSubPath = lineArray?2

//ice cream curve

//it’s a curved

line, so there are 3 points, not 2

//coordinates for the middle point (lineArray3[1l]) are different.

//The left direc

tion is positioned "above" the anchor on the screen.

//The right direction is positioned "below" the anchor

//You can change
//how the curve
var lineArray3 =
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]
lineArray3[0]

lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]
lineArray3[1]

lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]
lineArray3[2]

the coordinates for these points to see
works. ..

new Array ()

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (200, 100)

.leftDirection = lineArray3[0] .anchor
.rightDirection = lineArray3[0].anchor

= new PathPointInfo

.kind = PointKind.CORNERPOINT
.anchor = Array (150, 50)
.leftDirection = Array (100, 50)
.rightDirection = Array (200, 50)

= new PathPointInfo

.kind = PointKind.CORNERPOINT

.anchor = Array (100, 100)
.leftDirection = lineArray3[2] .anchor
.rightDirection = lineArray3[2].anchor
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lineSubPathArray[2] = new SubPathInfo()
lineSubPathArray[2] .operation = ShapeOperation.SHAPEXOR
lineSubPathArray[2] .closed = false

lineSubPathArray[2] .entireSubPath = lineArray3

//create the path item
var myPathItem = docRef.pathItems.add("A Line", lineSubPathArray)

// stroke it so we can see something
myPathItem. strokePath (ToolType.BRUSH)

// Reset the application preferences
preferences.rulerUnits = startRulerUnits
preferences.typeUnits = startTypeUnits
displayDialogs = startDisplayDialogs
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The collection of Pathltem objects in a document.

Access through the Document.pathltems collection property. For example, this creates a new path item
using a previously-defined set of subpaths:

app.activeDocument.pathItems.add ("myPath", lineSubPathInfoArray) ;

Property Value type What it is

length number Read-only. The number of pathItem objects in the
pathItems collection.

parent Document Read-only. The pathItems object's container.
typename string Read-only. The class name of the referenced pathItems
object.
Method Parameter type Returns What it does
add . PathItem Createsa new path item object and adds it
(name, string to this collection.

array of SubPathInfo

tirePath) s
erirere A new SubPathltem object is created for

each subPathInfo object provided in
entirePath, and those subPathItem
objects are added to the subPathltems
collection of the returned Pathltem.

getByName _ PathItem Get the first elementin the pathItems

(name) string collection with the provided name.
removeAll Removes all pathItem objects from the

0 pathItems collection.
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Represents the anchor and control-handle endpoints for a path segment. Each point (the anchor point,
left-direction point, and right-direction point) is an array containing X and Y position coordinates.

» Use the pathroint object to retrieve information about the points that describe existing path
segments. The properties are read-only. Access PathPoint objects through the SubPathltem.pathPoints

property.

> Use PathPointInfo with Pathltems.add() to create path points. The properties are writeable.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.

Property Value type Whati it is

anchor array of number Read-only.The X andY coordinates of the anchor point of the
curve.

kind PointKind Read-only. The role (corner or smooth) this point plays in the
containing path segment.

leftDirection array of number Read-only. The location of the left-direction endpoint (‘in’
position).

parent SubPathItem Read-only. The containing subpath object.

rightDirection array of number Read-only.The location of the right-direction endpoint (‘'out’
position).

typename string Read-only. The class name of the referenced pathPoint

object.
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Used to create a PathPoint, which represents the anchor and control-handle endpoints for a path segment.
Each point (the anchor point, left-direction point, and right-direction point) is an array containing X and Y
position coordinates.

= Use the JavaScript new operator to create these objects, and store them in the
SubPathinfo.entireSubPath property before using that object to create a path item with
Pathltems.add().

See the PathPointInfo sample script below.

> Theresulting SubPathltem objects contain the resulting PathPoint objects. Use the PathPoint object to
retrieve information about the points that describe existing path segments. The properties are
read-only.

For paths that are straight segments (not curved), the coordinates of all three points are the same. For
curved segements, the the coordinates are different. The difference between the anchor point and the left
or right direction points determines the arc of the curve. You use the left direction point to bend the curve
"outward" or make it convex; you use the right direction point to bend the curve "inward" or make it

concave.

Property Value type What it is

anchor array of number Read-write.The XandY coordinates of the anchor point of
the curve.

kind PointKind Read-write. The role (corner or smooth) this point plays in the
containing path segment.

leftDirection array of number Read-write.The location of the left-direction endpoint ('in’
position).

rightDirection array of number Read-write.The location of the right-direction endpoint (‘out’
position).

typename string Read-only. The class name of the referenced pathPointInfo
object.

function drawLine (doc, start, stop) {

var startPoint = new PathPointInfo() ;
startPoint.anchor = start;
startPoint.leftDirection = start;
startPoint.rightDirection = start;
startPoint.kind = PointKind.CORNERPOINT;

var stopPoint = new PathPointInfo() ;
stopPoint.anchor = stop;
stopPoint.leftDirection = stop;
stopPoint.rightDirection = stop;
stopPoint.kind = PointKind.CORNERPOINT;
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var spi = new SubPathInfo() ;

spi.closed = false;

spi.operation = ShapeOperation.SHAPEXOR;
spi.entireSubPath = [startPoint, stopPoint];

var line = doc.pathItems.add("Line", [spil);
line.strokePath (ToolType.PENCIL) ;
line.remove () ;

Vi

drawLine (app.activeDocument, [100,100], [200,2001]);
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A collection of PathPoint objects that define a subpath, kept in the SubPathltem.pathPoints property.

Property Value type What it is

length number Read-only. The number of elements in the collection.
parent SubPathItem Read-only. The containing subpath object.
typename string

Read-only. The class name of the referenced Pathproints
object.
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Options for opening a document in generic Adobe PDF format using the Application.open() method.

Property Value type What it is

antiAlias boolean Read-write. True to use antialias.

bitsPerChannel BitsPerChannelType Read-write. The number of bits per channel.

constrainProportions boolean DEePRECATED for Adobe Photoshop.

cropPage CropToType Read-write. The method of cropping to use.

height UnitValue DePRECATED for Adobe Photoshop.

mode OpenDocumentMode | Read-write. The color model to use.

name string Read-write. The name of the object.

object number Read-write. The number of 3d objects to open.

page number Read-write. The page or image to which to open
the document, depending on the value of
usePageNumber.

resolution number Read-write. The resolution of the document (in

pixels per inch).

suppressWarnings boolean Read-write. True to suppress warnings when
opening the document.

typename string Read-only. The class name of the referenced
PDFOpenOptions object.

use3DObjectNumber boolean Read-write. If true, the 3d property refers to using
3d object; if false, then usePageNumber is used.

usePageNumber boolean Read-write. When true, the page property refers
to a page number; when false, it refers to an
image number.

width UnitValue DePRECATED for Adobe Photoshop.
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Options for saving a document in Adobe PDF format using the Document.saveAs() method.

Property Value type Whatiit is

alphaChannels boolean Read-write. True to save the alpha channels
with the file.

annotations boolean Read-write. True to save comments with the
file.

colorConversion boolean Read-write. True to convert the color profile
to a destination profile.

convertToEightBit boolean Read-write. True to convert a 16-bit image
to 8-bit for better compatibility with other
applications.

description string Read-write. Description of the save options
to use.

destinationProfile string Read-write. Description of the final RGB or
CMYK output device, such as a monitor or a
press standard.

downgradeColorProfile boolean DepPRECATED for Adobe Photoshop.

downSample

downSampleSize

downSampleSizeLimit

embedColorProfile

embedFonts

embedThumbnail

encoding

interpolation

PDFResample

number

number

boolean

boolean

boolean

PDFEncoding

boolean

Read-write. The down sample method to
use.

Read-write. The size to downsample images
if they exceed the limit in pixels per inch.

Read-write. Limits downsampling or
subsampling to images that exceed this
value in pixels per inch.

Read-write. True to embed the color profile
in the document.

DEePRECATED for Adobe Photoshop.

Read-write. True to include a small preview
image in Adobe PDF files.

Read-write. The type of compression to use
(default: PDFEncoding. PDFZIP).

DePRECATED for Adobe Photoshop.
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Property Value type What it is (Continued)

jpegQuality number [0..12] Read-write. The quality of the produced
image, which is inversely proportionate to
the compression amount.
Valid only when encoding =
PDFEncoding.JPEG.

layers boolean Read-write. True to save the document’s
layers.

optimizeForWeb boolean Read-write. True to improve performance of
PDF files on Web servers.

outputCondition string Read-write. An optional comment field for
inserting descriptions of the output
condition. The text is stored in the PDF/X
file.

outputConditionID string Read-write. Indentifier for the output
condition.

PDFCompatibility PDFCompatibility Read-write. The PDF version to make the
document compatible with.

PDFStandard PDFStandard Read-write. The PDF standard to make the
document compatible with.

preserveEditing boolean Read-write. True to reopen the PDF in
Adobe Photoshop with native Photoshop
data intact.

presetFile string Read-write. The preset file to use for
settings.
Note: This option overrides other settings.

profileInclusionPolicy boolean Read-write. True to show which profiles to
include.

registryName string Read-write. URL where the output condition
is registered.

spotColors boolean Read-write. True to save spot colors.

tileSize nunber Read-write. Compression option.
Valid only when encoding =
PDFEncoding.JPEG2000.

transparency boolean DePRECATED for Adobe Photoshop.

typename string Read-only. The class name of the referenced
PDFSaveOptions object.

useOutlines boolean DePRECATED for Adobe Photoshop.
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Property Value type What it is (Continued)
vectorData boolean DEePRECATED for Adobe Photoshop.
view boolean

Read-write. True to open the saved PDF in
Adobe Acrobat.
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DEPRECATED in Adobe Photoshop. Kodak PhotoCD is now found in the Goodies folder on the Adobe
Photoshop Install DVD.

Options for opening a document in Kodak Photo CD (PCD) format (including high-resolution files from Pro
Photo CD discs) using the Application.open() method.

Property Value type What it is

colorProfileName string Read-write. The profile to use when reading the
image.

colorSpace PhotoCDColorSpace  Read-write. The colorspace for the image.

orientation Orientation Read-write. The image orientation.

pixelSize PhotoCDSize Read-write. The image dimensions.

resolution number Read-write. The image resolution (in pixels per
inch).

typename string Read-only. The class name of the referenced

photoCDOpenOptions object.
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Options for saving a document in PSD format using the Document.saveAs() method.

Property Value type Whatitis

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

layers boolean Read-write. True to preserve the layers.

spotColors boolean Read-write. True to save the spot colors.

typename string Read-only. The class name of the referenced

photoshopSaveOptions object.
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Options for saving a document in PICT format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use
(default: PICcTCOmpression . NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

resolution PICTBitsPerPixels  Read-write. The number of bits per pixel.

typename string Read-only. The class name of the referenced

PICTFileSaveOptions object.
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Options for saving a document as a PICT Resource file using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

compression PICTCompression Read-write. The type of compression to use (default:
PICTCompression.NONE).

embedColorProfile boolean Read-write. True to embed the color profile in the
document.

name string Read-write. The name of the PICT resource.

resolution PICTBitsPerPixels Read-write. The number of bits per pixel.

resourceID number Read-write. The ID of the PICT resource (default:
128).

typename string Read-only. The class name of the referenced

PICTResourceSaveOptions object.
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Options for a picture package created with Application.makePicturePackage().

Property Value type What it is

content PicturePackageTextType Read-write. The content information (default:
PicturePackageTextType . NONE).

flatten boolean Read-write. True if all layers in the final
document are flattened (default: true).

font GalleryFontType Read-write. The font used for security text
(default: GalleryFontType . ARIAL).

fontSize number Read-write. The font size used for security
text (default: 12).

layout string Read-write. The layout to use to generate the
picture package (default: » (2) 5x7").

mode NewDocumentMode Read-write. Read-write. The color profile to
use as the document mode (default:
NewDocumentMode . RGB).

opacity number Read-write. The web page security opacity as
a percent (default: 100).

resolution number Read-write. The resolution of the document
in pixels per inch (default: 72. 0).

text string Read-write. The picture package custom text.
Valid only when content =
PicturePackageType.USER.

textColor RGBColor Read-write. The color to use for security text.

textPosition |GallerySecurityTextPositionType Read-write. The security text position
(default:
GallerySecurityTextPositionType.
CENTERED).

textRotate GallerySecurityTextRotateType Read-write. The orientation to use for
security text (default:
GallerySecurityTextRotateType.ZERO).

typename string Read-only. The class name of the referenced

PicturePackageOptions object.
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Options for saving a document in Pixar format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha
channels.

typename string Read-only. The class name of the

referenced PixarSaveOptions
object.
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Options for saving a document in PNG format using the Document.saveAs() method.

Property Value type What it is

compression number [0..9] Read-write. The compression value (default: o).
interlaced boolean Read-write. True to interlace rows (default: false).
typename string Read-only. The class name of the referenced

PNGSaveOptions object.
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Represents application preferences for Photoshop. Access this object through the Application.preferences
property. For example:

app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS

Setting values in this object is equivalent to selecting Edit > Preferences (in Windows) or Photoshop >
Preferences (in Mac OS) in the Adobe Photoshop application. For explanations of individual settings, see
Adobe Photoshop Help.

Property Value type What it is
additionalPluginFolder File Read-write. The path to an additional
plug-in folder.

Valid only when
useAdditionalPluginFolder = true.

appendExtension SaveBehavior Read-write. The preferred policy for
writing file extensions in Windows.

askBeforeSavingLayeredTIFF boolean Read-write. True to ask the user to verify
layer preservation options when saving a
file in TIFF format.

autoUpdateOpenDocuments boolean Read-write. True to automatically update
open documents.

beepWhenDone boolean Read-write. True to beep when a process
finishes.
colorChannelsInColor boolean Read-write. True to display component

channels in the Channels palette in color.

colorPicker ColorPicker Read-write. The preferred color selection
tool.
columnGutter number [0.1..600.0] Read-write. The width of the column

gutters (in points).

columnWidth number [0.1..600.0] Read-write. Column width (in points)

createFirstSnapshot boolean Read-write. True to automatically make
the first snapshot when a new document
is created.

dynamicColorSliders boolean Read-write. True if dynamic color sliders

appear in the Color palette.

editLogItems EditLogIltemsType Read-write. The preferred level of detail
in the history log. Valid only when

useHistoryLog = true.
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Property Value type What it is (Continued)

exportClipboard boolean Read-write. True to retain Adobe
Photoshop contents on the clipboard
after you exit the application.

fontPreviewSize FontPreviewType Read-write. The preferred type size to use
for font previews in the type tool font
menus.

fullSizePreview boolean Read-write. True to show image preview
as a full size image, false to show
thumbnail (in Mac OS only).

gamutWarningOpacity number [0..100] Read-write. Opacity value as a
percentage.

gridSize Gridsize Read-write. The preferred size to use for
squares in the grid.

gridstyle GridLineStyle Read-write. The preferred formatting
style for non-printing grid lines.

gridsSubDivisions number [1..100] Read-write. Number of grid subdivisions.

guideStyle GuideLineStyle Read-write. The preferred formatting
style for non-printing guide lines.

iconPreview boolean Read-write. True to use icon previews (in
Mac OS only).

imageCacheLevels number [1..8] Read-write. The number of images to
hold in the cache.

imagePreviews SaveBehavior Read-write. The preferred policy for
writing image previews in Windows.

interpolation ResampleMethod Read-write. The method to use to assign
color values to any new pixels created
when an image is resampled or resized.

keyboardZoomResizesWindows boolean Read-write. True to automatically resize
the window when zooming in or out
using keyboard shortcuts.

macOSThumbnail boolean Read-write. True to create a thumbnail
when saving the image (in Mac OS only).

maximizeCompatibility QueryStateType Read-write. The preferred policy for

maxRAMuse

nonLinearHistory

number [5..100]

boolean

checking whether to maximize
compatibility when opening PSD files.

Read-write. The maximum percentage of
available RAM used by Adobe Photoshop
(5-100).

Read-write. True to allow non-linear
history.
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Property Value type What it is (Continued)

numberofHistoryStates number Read-write. The number of history states
to preserve.

otherCursors OtherPaintingCursors Read-write. The preferred type of pointer
to use with certain tools.

paintingCursors PaintingCursors Read-write. The preferred type of pointer
to use with certain tools.

parent Application Read-write. The containing application.

pixelDoubling boolean Read-write. True to halve the resolution
(double the size of pixels) to make
previews display more quickly.

pointSize PointType Read-write. The point/pica size.

recentFileListLength number [0..30] Read-write. The number of items in the
recent file list.

rulerUnits Units Read-write. The unit the scripting system
will use when receiving and returning
values.

saveLogItems SaveLogItemsType Read-write. Thepreferred location of
history log data when saving the history
items.

saveLogItemsFile File Read-write. The path to the history log
file, when the preferred location is a file.

savePaletteLocations boolean Read-write. True to make new palette
locations the default location.

showAsianTextOptions boolean Read-write. True to display Asian text
options in the Paragraph palette.

showEnglishFontNames boolean Read-write. True to list Asian font names
in English.

showSliceNumber boolean Read-write. True to display slice numbers
in the document window when using the
Slice tool.

showToolTips boolean Read-write. True to show pop up
definitions on mouse over.

smartQuotes boolean Read-write. True to use curly, false to use
straight quote marks.

textFontSize FontSize Read-write. Size of the small font used in
panels and dialogs.

typename string Read-only. The class name of the

referenced preferences object.
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Property Value type What it is (Continued)
typeUnits TypeUnits Read-write. The preferred unit for text

character measurements.

useAdditionalPluginFolder boolean Read-write. True to use an additional
folder for compatible plug-ins stored
with a different application.

useHistoryLog boolean Read-write. True to create a log file for
history states.

uselowerCaseExtension boolean Read-write. True to use lowercase for file
extensions.
usesShiftKeyForToolSwitch boolean Read-write. True to enable cycling

through a set of hidden tools.

useVideoAlpha boolean Read-write. True to enable Adobe
Photoshop to send transparency
information to your computer’s video
board. (Requires hardware support.)

windowsThumbnail boolean Read-write. True to create a thumbnail
when saving the image in Windows.
(Requires hardware support.)
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Options for Adobe PDF presentations created using Application.makePDFPresentation().

Property Value type What it is

autoAdvance boolean Read-write. True to auto advance images when when
viewing the presentation (default: t rue).
Valid only when presentation = true.

includeFilename boolean Read-write. True to include the file name for the image
(default: talse).

interval number [1..60] Read-write. The time in seconds before the view is auto
advanced (default: 5).
Valid only when autoAdvance = true.

loop boolean Read-write. True to begin the presentation again after
the last page (default: false).
Valid only when autoAdvance = true.

magnification MagnificationType Read-write.The magnification type to use when viewing
the image.

PDFFileOptions PDFSaveOptions Read-write. Options to use when creating the PDF file.

presentation boolean Read-write. True if the output will be a presentation
(default: false); when false, the output is a Multi-Page
document.

transition TransitionType Read-write. The method for transition from one image to
the next (default: TransitionType . NONE).
Valid only when autoAdvance = true..

typename string Read-only. The class name of the referenced

PresentationOptions object.
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Options for opening a document in RAW format using the Application.open() method.

Property Value type Whatitis

bitsPerChannel number Read-write. The number of bits for each channel.
The only valid values are BitsPerChannelType.EIGHT
Or BitsPerChannelType .SIXTEEN.

byteOrder ByteOrder Read-write. The order in which multibyte values are
read.
Valid only when bitsPerChannel =
BitsPerChannelType.SIXTEEN.

channelNumber number [1..56] Read-write. The number of channels in the image. The
value of cannot exceed the number of channels in the
image.
When bitsPerChannel =
BitsPerChannelType.SIXTEEN, the only valid values
are1,3,or4.

headerSize number Read-write. The number of bytes of information that

[0..1919999] . . . . . .

will appear in the file before actual image information
begins; that is, the number of zeroes inserted at the
beginning of the file as placeholders.

height number Read-write. The height of the image (in pixels).

interleaveChannels boolean Read-write. True to store color values sequentially.

retainHeader boolean Read-write. True to retain the header when saving.
Valid only when headerSize is 1 or greater.

typename string Read-only. The class name of the referenced
RawFormatOpenOptions object.

width number Read-write. The image width in pixels.




Adobe Photoshop

JavaScript Scripting Reference JavaScript Object Reference 166

Options for saving a document in RAW format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True if alpha channels should be saved.
spotColors boolean Read-write. True if the spot colors should be saved.
typename string

Read-only. The class name of the referenced RawSaveOptions
object.
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Defines an RGB color, used in the SolidColor object.

See also CMYKColor, GrayColor, HSBColor, LabColor, NoColor.

Property

Value type

What it is

blue
green
hexValue
red

typename

number [0..255]
number [0..255]
string

number [0..255]

string

Read-write. The blue color value (default: 255).
Read-write. The green color value (default: 255)
Read-write. The hexadecimal representation of the color.
Read-write. The red color value (default: 255)

Read-only. The class name of the referenced rRGBColor object.




JavaScript Scripting Reference

Adobe Photoshop

JavaScript Object Reference 168

The selected area of a document or layer. Access through the Document.selection property. For example:

app.activeDocument.selection.fill (app.foregroundColor)

Many of the properties and methods use the UnitValue type, which combines measurement values with
the measurement unit. For information about this type, see the JavaScript Tools Guide.

Property Value type What it is
bounds array of Unitvalue  Read-only.The bounding rectangle of the entire selection.
parent Document Read-only. The object's container.
solid boolean Read-only. True if the bounding rectangle is a solid.
typename string Read-only. The class name of the referenced selection
object.
Method Parameter type Returns What it does
clear Clears the selection and
0 does not copy it to the
clipboard.
contract . Contracts (reduces) the
(by) UnitValue selection by the specified
amount.
copy Copies the selection to the
([merge]) boolean clipboard. When the
optional argument is used
and set to true, a merged
copy is performed (all visible
layers in the selection are
copied).
cut Clears the current selection
0 and copies it to the
clipboard.
deselect Deselects the current
0 selection.
expand . Expands the selection by the
(by) UnitValue specified amount.
feather Feathers the edges of the
(by) Unitvalue selection by the specified

amount.
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Method Parameter type What it does (Continued)
£ill Fills the selection.
(Filltype SolidColor .
[ mode] ColorBlendMode opacity is a percentage
[: opacity] number [1..100] value.
[, preserveTransparency]) boolean
grow Grows the selection to
(tolerance, Eu“?er include all adjacent pixels
antiAlias) cotean falling within the specified
tolerance range.
invert Inverts the selection
0 (deselects the selection and
selects the rest of the layer
or document).
Tip: To flip the selection
shape, see rotate.
load Loads the selection from the
(from Channel specified channel.
[, combination] SelectionType P
[, inverting]) boolean
makeWorkPath number Makes this selection item
([tolerance]) the work path for this
document.
resize Resizes the selected area to
([horizontall nuﬁer the specified dimensions
) tical number .
E Zﬁ&iii ] AnchorPosition and anchor position.
resizeBoundary Changes the size of the
([horizontall nuﬁer selection to the specified
. 1 nu er . .
E, ;frelzil;?) ] AnchorPosition d|mgQS|ons around the
’ specified anchor.
rotate Rotates the selection by the
(angle number specified amount around
[ d h AnchorPosition P . .
. anchor]) the specified anchor point.
rotateBoundary Rotates the boundary of the
(angle number selection around the
[, anchor]) AnchorPosition specified anchor.
select Selects the specified region.
; array of number .
(]Eegi;;e] SelectionType The region parameter is an
[ feather] number array of four coordinates,
[, antiAlias]) boolean [left, top, right, bottom].
selectAll Selects the entire layer.

0
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Method Parameter type Returns What it does (Continued)
selectBorder Selects the selection border
(width) UnitValue only (in the specified width);
subsequent actions do not
affect the selected area
within the borders.
similar Grows the selection to
(tolerance, number include pixels throughout
antiAlias) boolean the image falling within the
tolerance range.
smooth Cleans up stray pixels left
(radius) number inside or outside a
color-based selection
(within the radius specified
in pixels).
store Saves the selection as a
(into Channel channel.
[, combination]) SelectionType
stroke Strokes the selection border.
(strokeColor, SolidColor opacity is a percentage
width number . value.
[, location] StrokeLocation
[, mode] ColorBlendMode
[, opacity] number [1..100]
[, preserveTransparency]) boolean
translate Moves the entire selection
([deltax] UnitValue relative to its current
[, deltaY]) UnitValue poﬁﬁon.
translateBoundary Moves the selection relative
([deltax] UnitValue to its current position.
[, deltay]) UnitvValue

The following script creates a checkerboard using the following steps:

> Create an 800 x 800 pixel document.

> Divide the entire document into 100 x 100 pixel squares.

> Select every other square in the first row, then shift the selection criteria to select the alternate squares
in the following row. Repeat until every other square in the document is selected.

> Fill the selected squares with the foreground color from the palette.

> Invert the selection and fill the newly selected squares with the background color from the palette.

» Deselect the squares to remove the selection outlines (the "marching ants").

Selection.jsx

// Save the current preferences
var startRulerUnits = app.preferences.rulerUnits
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var startTypeUnits = app.preferences.typeUnits
var startDisplayDialogs = app.displayDialogs

// Set Adobe Photoshop to use pixels and display no dialogs
app.preferences.rulerUnits = Units.PIXELS
app.preferences.typeUnits = TypeUnits.PIXELS
app.displayDialogs = DialogModes.NO

//Close all the open documents
while (app.documents.length)

app.activeDocument.close ()
}

//Create variables for the 800 pixel board divided in even 100 x 100 squares
var docSize = 800

var cells = 8
var cellSize = docSize / cells

// create a new document
var checkersDoc = app.documents.add(docSize, docSize, 72, "Checkers")

// Create a variable to use for selecting the checker board

// That allows me to shift the selection one square to the right
//on every other row, and then shift back for the rows in between.
var shiftIt = true

// loop through vertically to create the first row
for (var v = 0; v < docSize; v += cellSize) {

// Switch the shift for a new row
shiftIt = !shiftIt

// loop through horizontally
for (var h = 0; h < docSize; h += (cellSize * 2)) {

// push over the cellSize to start with only
if (shiftIt && h == 0) {
h += cellSize

// Select a square
selRegion = Array (Array (h, v),
Array (h + cellSize, v),
Array(h + cellSize, v + cellSize),
Array(h, v + cellSize),
Array (h, v))

// In the first ineration of the loop, start the selection
//In subsequent iterations, use the EXTEND constant value
//of the select () method to add to the selection (in the loop’s else clause)

if (h == 0 && v == 0) {
checkersDoc.selection.select (selRegion)
} else {

checkersDoc.selection.select (selRegion, SelectionType.EXTEND)

// turn this off for faster execution
// turn this on for debugging
WaitForRedraw ()
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}

// Fill the current selection with the foreground color
checkersDoc.selection.fill (app. foregroundColor)

//Invert the selection
checkersDoc.selection.invert ()

// Fill the new selection with the background color
checkersDoc.selection.fill (app.backgroundColor)

// Clear the selection to get rid of the non-printing borders
checkersDoc.selection.deselect ()

// Reset the application preferences
app.preferences.rulerUnits = startRulerUnits
app.preferences.typeUnits = startTypeUnits
app.displayDialogs = startDisplayDialogs

// A helper function for debugging
// It also helps the user see what is going on
// if you turn it off for this example you
// get a flashing cursor for a number time
function WaitForRedraw ()
{
var eventWait = charIDToTypeID ("Wait")
var enumRedrawComplete = charIDToTypeID ("RdACm")
var typeState = charIDToTypeID("Stte")
var keyState = charIDToTypeID("Stte")

var desc = new ActionDescriptor ()
desc.putEnumerated (keyState, typeState, enumRedrawComplete)

executeAction (eventWait, desc, DialogModes.NO)
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Options for saving a document in SGIRGB format using the Document.saveAs() method.

Note: The SGIRGB format is not installed automatically with Adobe Photoshop.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha
channels.

spotColors boolean Read-write. True to save the spot
colors.

typename string Read-only. The class name of the

referenced SGIRGBSaveOptions
object.
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A color definition used in the document. Maps a color to equivalents in all available color models.

> Used in Application.backgroundColor and foregroundColor properties, in Channel.color, in

ColorSampler.color, and in Textltem.color

» Passed to Pathltem fillPath(), Selection fill(), and Selection.stroke().

Property Value type What it is

cmyk CMYKColor Read-write. The CMYK color mode.

gray GrayColor Read-write. The Grayscale color mode.

hsb HSBColor Read-write. The HSB color mode.

lab LabColor Read-write. The LAB color mode.

model ColorModel Read-write. The color model.

nearestWebColor  RGBColor Read-only. The nearest web color to the current color.

rgb RGBColor Read-write. The RGB color mode.

typename string Read-only. The class name of the referenced solidcolor

object.

Method Parameter type Returns What it does

isEqual boolean True if the solidcolor object is visually
(color) SolidColor equal to the specified color.
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An array of PathPoint objects that describes a straight or curved segment of a path, used to create a
SubPathltem.

Pass an array of these objects to the Pathltems.add() method. This method creates a SubPathltem object
for each subrPathInfo object, and creates and returns a new Pathltem object for the path represented by
all of the subpaths.

> Use subPathInfo to create subpaths; the properties are writeable.

> Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.

Property Value type Whatitis

closed boolean Read-write. True if the path describes an enclosed area.

entireSubPath array of PathPoint Read-write.

operation ShapeOperation Read-write. The subpath’s operation on other
subpaths. Specifies how to combine the shapes if the
destination path already has a selection.

typename string Read-only. The class name of the referenced

SubPathInfo object.
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Represents a subpath; a collection of subpaths make up a Pathltem.

Create these objects by passing SubPathinfo objects to the Pathltems.add() method. This method creates
a subPathItem object for each SubPathinfo object, and creates and returns a new Pathltem object for the
path represented by all of the subpaths. Access these objects in the Pathltem.subPathltems collection.

> Use the SubPathltem object to retrieve information about existing subpaths. The properties are
read-only.

= Use SubPathlInfo to create subpaths; the properties are writeable.

Property Value type Whatitis
closed boolean Read-only. True if the path is closed.
operation ShapeOperation Read-only. How this object behaves when it intersects

another SubPathltem object. Specifies how to combine the
shapes if the destination path already has a selection.

parent PathItem Read-only. The object's container.
pathPoints PathPoints Read-only. The pathpoints collection.
typename string Read-only. The class name of the referenced subPathItem

object.
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A collection of SubPathltem objects that make up a Pathltem. Access this object in the
Pathltem.subPathltems collection property.

= Use SubPathlInfo to create subpaths; the properties are writeable.

> Use the SubPathltem object to retrieve information about existing subpaths. The properties are

read-only.
Property Value type Whatiitis
length number Read-only. The number of elements in the collection.
parent PathItem Read-only. The containing path item.
typename string Read-only. The class name of the referenced subrPathItems

object.
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Options for saving a document in TGA (Targa) format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

resolution TargaBitsPerPixels Read-write. The number of bits per pixel (default:
TargaBitsPerPixels.TWENTYFOUR).

rleCompression boolean Read-write. True to use RLE compression (default: t rue).

typename string Read-only. The class name of the referenced

TargaSaveOptions object.
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Describes a font that is available to the application. Access this object in the Application.fonts collection.
For example:

var myFont = app.fonts.getByName ("ArialMT") ;

Property Value type What it is

family string Read-only. The font family.

name string Read-only. The name of the font.

parent Application Read-only. The containing application.
postScriptName string Read-only. The PostScript name of the font.

style string Read-only. The font style.

typename string Read-only. The class name of the referenced TextFont

object.
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The collection of fonts available on your computer. Fonts are represented by TextFont objects. Access this
object in the Application.fonts collection property. For example, this displays the number of available

fonts:

alert (app.fonts.length) ;

Property Value type What it is

length number Read-only. The number of elements in the collection.

parent Application Read-only. The containing application.

typename string Read-only. The class name of the referenced TextFonts object.

Method Parameter type Returns What it does

getByName . TextFont Gets the first element in the TextFonts
(name) string

collection with the provided name.
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The text in an ArtLayer object whose kind property is Layerkind . TEXT. Access this object in the
ArtLayer.textltem property. For example:

myLayers [i] .textItem.contents = "Layer in " + textArray[i] + " Set Inside "
yLay

Many of the properties use the UnitValue type, which combines a measurement value with a
measurement unit. For information about this type, see the JavaScript Tools Guide.

Property Value type What it is
alternateligatures boolean Read-write. True to use alternate ligatures.
Note: Alternate ligatures are the same as
Discretionary Ligatures. See Adobe Photoshop
Help for more information.
antiAliasMethod AntiAlias Read-write. The method of anti aliasing to use.
autoKerning AutoKernType Read-write. The auto kerning option to use.
autoLeadingAmount number Read-write. The percentage to use for auto (default)
[0.01..5000.00] . . .
leading (in points).
Valid only when useAutolLeading = true.
baselineshift UnitValue Read-write. The unit value to use in the baseline
offset of text.
capitalization TextCase Read-write. The text case.
color SolidColor Read-write. The text color.
contents string Read-write. The actual text in the layer.
desiredGlyphScaling number [50..200] Read-write.The desired amount by which to scale the

horizontal size of the text letters. A percentage value;
at 100, the width of characters is not scaled.

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
maximumGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

desiredLetterScaling

desiredWordScaling

direction

fauxBold

fauxItalic

firstLineIndent

font

hangingPunctuation

height

horizontalScale

number

[100..500]

number

[0..1000]

Direction

boolean

boolean

UnitValue
-1296..1296]

points

string

boolean

UnitValueX

number

[0..1000]

Read-write. The amount of space between letters (at
0, no space is added between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumLetterScaling and
maximumLetterScaling values are also required.

Read-write. The amount (percentage) of space
between words (at 100, no additional space is added
between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
maximumWordScaling values are also required.

Read-write. The text orientation.

Read-write. True to use faux bold (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Bold in the Character palette.

Read-write. True to use faux italic (default: false).

Setting this to true is equivalent to selecting text and
clicking Faux Italic in the Character palette.

Read-write. The amount (unit value) to indent the
first line of paragraphs.

Read-write. The text face of the character. Use the
PostScript Name of the font. See TextFont and use
the postScriptName property.

Read-write. True to use Roman hanging punctuation.

Read-write. The height of the bounding box (unit
value) for paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.

Read-write. Character scaling (horizontal) in
proportion to verticalScale (a percentage value).
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Property Value type What it is (Continued)

hyphenateAfterFirst number [1..15]  Read-write. The number of letters after which
hyphenation in word wrap is allowed.

hyphenateBeforeLlast number [1..15] Read-write. The number of letters before which
hyphenation in word wrap is allowed.

hyphenateCapitalWords boolean Read-write. True to allow hyphenation in word wrap

hyphenateWordsLongerThan

hyphenation

hyphenationZone

hyphenLimit

justification
kind

language
leading

leftIndent

ligatures

maximumGlyphScaling

number [2..25]

boolean

UnitValue
0..720] pica

number

Justification

TextType
Language
UnitValue

UnitValue
-1296..1296]

points
boolean

number [50..200]

of capitalized words.

Read-write. The minimum number of letters a word
must have in order for hyphenation in word wrap to
be allowed.

Read-write. True to use hyphenation in word wrap.

Read-write. The distance at the end of a line that will
cause a word to break in unjustified type.

Read-write. The maximum number of consecutive
lines that can end with a hyphenated word.

Read-write. The paragraph justification.
Read-write. The text-wrap type.
Read-write. The language to use.
Read-write. The leading amount.

Read-write. The amoun of space to indent text from
the left.

Read-write. True to use ligatures.

Read-write. The maximum amount to scale the
horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumGlyphScaling and
desiredGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

maximumLetterScaling

maximumWordScaling

minimumGlyphScaling

number

[100..500]

number

number

[0..1000]

[50..200]

Read-write. The maximum amount of space to allow
between letters (at 0, no space is added between
letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumLetterScaling and
desiredLetterScaling values are also required.

Read-write. The maximum amount of space to allow
between words (a percentage value; at 100, no
additional space is added between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the minimumWordScaling and
desiredWordScaling values are also required.

Read-write. The minimum amount to scale the
horizontal size of the text letters (a percentage value;
at 100, the width of characters is not scaled).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumGlyphScaling and
desiredGlyphScaling values are also required.
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Property

Value type

What it is (Continued)

minimumLetterScaling

minimumWordScaling

noBreak

oldstyle
parent

position

rightIndent

size

spaceAfter

number
[100..500]

number [0..1000]

boolean

boolean

ArtLayer

array of
UnitValue

UnitValue
-1296..1296]

points

UnitValue

UnitValue
-1296..1296]

points

Read-write. The minimum amount of space to allow
between letters (a percentage value; at 0, no space is
removed between letters).

Equivalent to Letter Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumLetterScaling and
desiredLetterScaling values are also required.

Read-write. The minimum amount of space to allow
between words (a percentage value; at 100, no
additional space is removed between words).

Equivalent to Word Spacing in the Justification
dialog (Select Justification on the Paragraphs
palette menu).

Valid only when justification =
Justification.CENTERJUSTIFIED,
FULLYJUSTIFIED, LEFTJUSTIFIED, Of
Justification.RIGHTJUSTIFIED.

When used, the maximumWordScaling and
desiredWordScaling values are also required.

Read-write. True to disallow line breaks in this text.

Tip: When true for many consecutive characters, can
prevent word wrap and thus may prevent some
text from appearing on the screen.

Read-write. True to use old style type.
Read-write. The containing layer.

Read-write. The position of origin for the text. The
array members specify the X and Y coordinates.

Equivalent to clicking the text tool at a point in the
document to create the point of origin for text.

Read-write. The amount of space to indent text from
the right.

Read-write. The font size in tnitvalue . NOTE: Type
was points for CS3 and older..

Read-write. The amount of space to use after each
paragraph.
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Property Value type What it is (Continued)
spaceBefore UnitValue Read-write. The amount of space to use before each
T-1296..1296] h
points paragrapn.
strikeThru StrikeThruType Read-write.The text strike-through option to use.
textComposer TextComposer Read-write. The composition method to use to

evaluate line breaks and optimize the specified
hyphenation and justification options.

Valid only when kind = TextType.PARAGRAPHTEXT.

tracking number Read-write. The amount of uniform spacing between
[-1000..10000] .
multiple characters.

Tracking units are 1/1000 of an em space. The width
of an em space is relative to the current type size.In a
1-point font, 1 em equals 1 point;in a 10-point font, 1
em equals 10 points. So, for example, 100 unitsin a
10-point font are equivalent to 1 point.

typename string Read-only. The class name of the referenced
textItem object.

underline UnderlineType |Read-write. The text underlining options.

useAutoLeading boolean Read-write. True to use a font's built-in leading
information.

verticalScale number [0-1000] |Read-write.Vertical character scaling in proportion to

horizontalScale (a percentage value).

warpBend number Read-write. The warp bend percentage.
[-100..100]

warpDirection Direction Read-write. The warp direction.

warpHorizontalDistortion r[lurfggr 100] Read-write. The horizontal distortion of the warp (a

percentage value).

warpStyle WarpStyle Read-write. The style of warp to use.
warpVerticalDistortion number Read-write. The vertical distortion of the warp (a
[-100..100] percentage value).
width Unitvalue Read-write. The width of the bounding box for
paragraph text.

Valid only when kind = TextType.PARAGRAPHTEXT.
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Method Parameter type Returns What it does
convertToShape Converts the text item and its containing layer to
0 afill layer with the text changed to a clipping
path.
createPath Creates a clipping path from the outlines of the

0 actual text items (such as letters or words).
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Options for saving a document in TIFF format using the Document.saveAs() method.

Property Value type What it is

alphaChannels boolean Read-write. True to save the alpha channels.

annotations boolean Read-write. True to save the annotations.

byteOrder ByteOrder Read-write. The order in which the document’s
multibyte values are read (default:
ByteOrder.MACOS in Mac OS, ByteOrder . IBM
in Windows).

embedColorProfile boolean Read-write. True to embed the color profile in
the document.

imageCompression TIFFEncoding Read-write. The compression type (default:
TIFFEncoding.NONE).

interleaveChannels boolean Read-write. True if the channels in the image
will be interleaved.

jpegQuality number [0..12] Read-write. The quality of the produced
image, which is inversely proportionate to the
amount of JPEG compression.
Valid only when imageCompression =
TIFFEncoding.JPEG.

layerCompression LayerCompression Read-write. The method of compression to use
when saving layers (as opposed to saving
composite data).
Valid only when layers = true.

layers boolean Read-write. True to save the layers.

saveImagePyramid boolean Read-write. True to preserve multi-resolution
information (default: false).

spotColors boolean Read-write. True to save the spot colors.

transparency boolean Read-write. True to save the transparency as
an additional alpha channel when the file is
opened in another application.

typename string Read-only. The class name of the referenced

TiffSaveOptions object.




Adobe Photoshop
JavaScript Scripting Reference JavaScript Object Reference 189

ExtendScript defines the JavaScript class unitvalue to represent measurement values together with their
measurement units; see ‘JavaScript support in Adobe Photoshop’ on page 32. For references details of
these classes, see the JavaScript Tools Guide.
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Camera RAW image XMP metadata.

For camera RAW image files, the XMP metadata is stored in a sidecar file, which is a file in the same folder as
the RAW file with the same base name and an XMP extension.

Property Value type What it is
parent Document Read-only. The containing document.
rawData string Read-write. A string containing the XMP metadata in

XML (RDF) format. See the XMP Specification for
details of this format.

typename string Read-only. The class name of the referenced
xmpMetadata object.
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Reference Guide

JavaScript Resource

This section describes the JavaScript resource that enables your JavaScripts to behave like a plug-in. This

includes:

> the ability to specify a menu the script appears in as a command,

> aterminology resource so the script can function with the Action Manager, which allows your script to
record and be automated by scripting parameters,

» acategory to enable ordering and grouping of commands within menus, and

- an enable string that indicates whether the command is enabled or disabled given a set of conditions.

> The strings must be valid XML syntax. The "&" character will not work for example. Use the samp ; samp;
for example to get logical ‘s&"in the enableinfo block.

The JavaScript Resource has an HTML-style syntax, with each <tag> matched by a closing </tags>. This
resource needs to appear within comments ( /* ... */)and should be defined at the top of your script
file (within the first 10,240 characters of the file.)

Tag

Description

<javascriptresource>

<name>

<menu>

<about>

The resource definition tag.

The command name that appears in the Photoshop menu.

If this tag is not provided in the resource, the name of the command in the
menu defaults to the name of the script.

The menu the command appears in. If this tag is not provided, the
command appears in the File > Scripts menu.

Note: Currently the only supported values for <menu> are automate,
filter and help. automate puts the scriptin the File >
Automate menu for example.

A string that appears in an About box, which the user can select from the
Help > About Plug-in menu.

191
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Tag Description
<enableinfo> A boolean expression that indicates whether the command is enabled in

the menu. See Enable-info grammar.

Note: If you provide this tag, the menu item is enabled if and only if there
is at least one document open, and the boolean expression
evaluates to true. If you always want the menu item enabled, do not
use this tag.

<eventids A unique string that identifies the event. Using a UUID will ensure that your
script wont share this identifier with another script.

<category> The category the command appears within in the menu. Used to group
and order commands in the menu. Commands are placed in the menu
alphabetically based on the string in <categorys. If two commands use
the same category, they are grouped together.

<terminology> The terminology dictionary for the script to function with the Action
Manager. See the Terminology dictionary.

This example shows a very basic <javascriptresources. With this resource, the script can be executed
by selecting the command Add a Document, which appears in the Automate menu. This command is
enabled in the menu, provided at least one document is already open. If the user requests information
about the script from the About Plug-in menu, the string contained in the <about > tag is displayed in a
dialog box.
/*

<javascriptresources>

<name>Add a Document</names>

<type>automate</type>

<about>A short string providing information about the script.</abouts>

<enableinfo>true</enableinfo>

</javascriptresources>

*/

app.documents.add() ;

The <enableinfo> tag provides a boolean expression that, when evaluated, indicates whether the
command is enabled in the menu. You can use this expression to enable or disable the menu item based
on various characteristics of the document. The Enable Info grammar is as follows:

<booleanExpressions> := <conjunction> { "||" <conjunctions> }

<conjunctions := <relation> {"&&" <relations> }

<relations> := <equality> {<relationOperators<equality>}

<equalitys> := <simpleExpression> {<equalityOperator><simpleExpressions}
<simpleExpression> := <term> {<addOperator><terms}

<terms := <factor> {<mulOperators<factors}
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<factor> :=

<integers> :=
<intrinsics> :=

<limitFunction> :=

<dimFunction> :=
<ident> :=

<mulOperators> :

<addOperator> :=

<equalityOperators> :

<relationOperator> :=

<inFunction> :=

<integer> | <intrinsic> | <ident> |

" (" <booleanExpression ")" | "(" simpleExpression ")" |
"+ <factor> | "-" <factor> | "!" <factor>

digit {digit}

<limitFunction> | <dimFunction> | <inFunctions>

( "min" | "max") " (" <simpleExpression> ","
<simpleExpression> { "," <simpleExpressions> } ")"

"dim" " (" <simpleExpression> "," <simpleExpression> ")"
(alpha | "_") {alpha | digit | "_" }

man |/

g | e

nezn | wpon

L e N S

"in" " (" <simpleExpression> {"," <simpleExpression> } ")"

Operator precedence is shown in the following table. Operators are listed with the highest order of
precedence at the top of the table

Operator Description

I Or

&& And

+ - Addition or subtraction
*/ Multiply or divide

(..) in() max() min()
unary + - !

Less than, less than or equal, greater than or equal, greater than
Equals, or does not equal.

Functions
Unary operators: increment, decrement, not

The grammar provides variables and constants that you can use in the <enableinfo> expression. The

following table provides a list of the constants that are available.

Constant Name

Description

true

false
BitmapMode
GrayScaleMode
IndexedMode

RGBMode

Boolean true

Boolean false

Bitmap mode.

Grayscale mode, 8 bit depth.
Indexed color mode.

RGB color mode.
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Constant Name Description

CMYKMode CMYK color mode.

HSIMode HSL color mode.

HSBMode HSB color mode
MultiChannelMode Multichannel mode.

DuotoneMode Duotone mode.

LabMode Lab color mode.

GrayléMode Grayscale mode, 16 bits per channel
RGB48Mode RGB color mode, 16 bits per channel.
Lab48Mode LAB mode, 16 bits per channel.
CMYK64Mode CMYK mode, 16 bits per channel.
DeepMultichannelMode | Deep multichannel mode.
DuotoneléMode Duotone mode, 16 bit depth.
RGB96Mode RGB color mode, 32 bits per channel.
Gray32Mode Grayscale mode, 32 bit depth.

The following table show the set of variables you can use in the <enableinfo> expression. The value of

these variables is set based on the properties of the active document.

Variable Name

Description

PSHOP_ImageMode

PSHOP_ ImageDepth

PSHOP_HasLayerMask

PSHOP HasSelectionMask

Image mode of the active document.
Depth of the active document.
Boolean indicating presence of layer mask.

Boolean indicating presence of selection mask.

PSHOP HasTransparencyMask Boolean indicating presence of transparency mask.

PSHOP_NumTargetChannels

PSHOP_NumTrueChannels

Number of target channels.

Numer of image channels.

PSHOP IsAdjustorSheet Boolean
PSHOP_IsTargetComposite Boolean indicating whether channels are flattened.
PSHOP IsTargetSection Boolean.
PSHOP IsTargetVisible Boolean.

PSHOP_ ImageWidth
PSHOP_ImageHeight

PSHOP_TargetProtectFlags.

Width of the image.

Height of the image.
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If any arithmetic or relation operation contains an operand whose value is undefined, or a variable that is
undefined, the result of that evaluation is false.

Boolean values are treated as in C/C++, where non-zero values are true, and zero is false, with the
exception that an undefined value is also false.

The in function (see <inFunctions>) returns true is the first parameter is equal to at least one of the
subsequent parameters. A typical use might be to see if the image mode of the active document is one of
a set of image modes. For example:

in (PSHOP_ ImageMode, RGBMode, CMYKMode, LabMode)

For your script to be able to record scripting parameters and be automated by them, it requires the
addition of two basic mechanisms:

» A terminology dictionary that maps your script’s user interface to human readable text, providing text
and type information for each parameter the script uses.

> Code to read parameter information when it comes from the Action Manager, rather than from the
user-interface, and code to write parameter information to the Action Manger. This code uses the
Action Manager classes ActionDescriptor, ActionList, and ActionReference.

See conditional Mode Change.jsx foran example of a script that can record and be automated by
scripting parameters. This file can be found in the Presets/Scripts folder.

The JavaScript resource provides a <terminology> tag that allows you to provide the terminology
dictionary for your script. The first step in creating a terminology dictionary is to review your script’s user
interface, and create human-readable strings for each element in your user interface.

For example, in the Conditional Mode Change command, the user interface requests a source mode and a
target mode. Both source mode and target mode have several options. All of these elements of the user
interface need to have entries in the terminology dictionary.

The terminology dictionary is created in a PDF dictionary format, with the following entries, and must have
the following format in the <javascriptresources:

<terminology><! [CDATA [<<<
/Version integer
/Events <<event dictionarys>>
/Classes <<class dictionary>>
/Enumerations <<enumeration dictionarys>>
>>> ]]></terminologys>

Note: The information in the terminology tag needs to be wrapped in a cpaTa block so the xml parser will
ignore "/" and other tags that appear in the terminology.

The defintions for events, classes and enumerations dictionaries are provided below.
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The /Events dictionary contains an entry for each event:

/eventName [ // Name used in string-based API
(String event name) // required
/direct parameter type // optional; if omitted, no parameter
<< // optional parameter dictionary
/parameterName [ // Name used in string-based API
(String name) // required
/parameter type // required

]
// other parameters
>>

The /classes dictionary contains and entry for each class:

/className [ // Name used in string-based API
(zString class name) // required
<< // property dictionary
/propertyName [ // Name used in string-based API
(String name) // required
/property type // required

1
// other properties
>>

The /Enumerations dictionary contains an entry for each enumerated type:

/enumTypeName // Name used in string-based API
<<

/enumValue (String name) // required

>>

For /parameter type and /property type definitons, you can use the Class and Enumeration type
declarations you make in your own terminology dictionary, you can use declarations provided by
Photoshop or you can use basic value types.

Basic Value Types

The basic value types are shown in the following table:

Name Code Description

typelnteger 'long' int32

typeFloat "doub' IEEE 64 bit double

typeBoolean 'bool! TRUE Of FALSE

typeText "TEXT' Block of any number of readable characters.

typeAlias ralis’ Macintosh file system path.
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Name Code Description
typePaths "Pth ! Windows file system path.
typePlatformFilePath 'alis'or'Pth typealias for Mac OS, typepPath for Windows.
Predefined Class Types

Photoshop provides a number of predefined classes that are available for use in the terminology
dictionary. A useful subset of those classes is shown in the table below. Use these classes when they are
appropriate, but you can define new classes in the terminology resource, if necessary.

Name Code Description

classColor 'Clr ! Class for color classes.

classRGBColor '"RGBC' keyRed, keyGreen, keyBlue
classCMYKColor 'CMYC! keyCyan, keyMagenta, keyYellow, keyBlack.
classUnspecifiedColo 'UnsC' Unspecified.

r

classGrayscale 'Grsc' keyGray

classBookColor 'BkC1 ! Book color

classLabColor 'LbCl' keyLuminance, keyA, keyB.

Generally, the names for terminology entries must be unique within a particular category and scope. It is
best to not make names unique unnecessarily; generic terms are prefereable, and if a name already exists
for something, go ahead and use it. Case matters in considering uniqueness of terminology entries.

The uniqueness rules for terminology entries are:

> All event names must be different from all other event names.

> All class names must be different from all other names.

> All enumeration type names must be different from all other enumeration type names.

> All keys must be different from all other keys used in the same class or event.

> All enumeration values must be different from all other enumeration values in the same enumeration
type.
» Aclass, event, enumeration type, key, and enumeration value can all have the same name.

This example demonstrates the terminology definition for a new event; the example uses ZStrings. The
event is called newaAnnot, and it takes three parameters:

» annotType, an enumeration (annotType)
» at,aclass (point), and

» size, aclass (annotSizeClass).
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The annotsizeclass has two properties: width, and height, both of type £1oatType. The enumeration
annotType has three values: annot Unknown, annot Text, and annot Sound

<terminology><! [CDATA [<<<
/Version 1
/Events
/newAnnot [ (New Annotation) <<
/annotType [ (Type) /annotTypel
/at [(At) /Point]
/size [(Size) /annotSizeClass] >>]
/Classes
/annotSizeClass [(Size) <<
/width [(Width) /floatType]
/height [(Height) /floatType]
>>]
/Enumerations
/annotType <<
/annotUnknown (Unknown)
/annotText (Text)
/annotSound (Sound)
>>> ]]></terminology>



Scripting Constants

This section lists and describes the enumerations defined for use with Adobe Photoshop JavaScript

properties and methods.

Constant type Values What it means
AdjustmentReference ABSOLUTE Method to use for interpreting
RELATIVE selective color adjustment
specifications:
ABSOLUTE = % of the whole.
RELATIVE = % of the existing color
amount.
Pass to ArtLayer.selectiveColor().
AnchorPosition BOTTOMCENTER The point around which to transform
BOTTOMLEFT an object. This is the point that does
BOTTOMRIGHT ‘ h biect is rotated or
MIDDLECENTER not move when an object is rotated o
MIDDLELEFT resized using methods in ArtLayer,
MIDDLERIGHT LayerSet, and Selection, or when the
TOPCENTER entire canvas is resized with
TOPLEFT D t resizeC 0
TOPRIGHT ocument.resizeCanvas().
AntiAlias CRISP Method to use to smooth edges by
NONE softening the color transition between
SHARP edge pixels and background pixels
SMOOTH 9ep ground pixels.
STRONG Used in a Textltem.antiAliasMethod.
AutoKernType MANUAL The type of kerning to use for
ggg?éﬁi characters. Used in
Textltem.autoKerning.
BatchDestinationType FOLDER The destination, if any, for
NODESTINATION batch-processed files, specified in the
SAVEANDCLOSE

BatchOptions used with the
Application.batch() method:

FOLDER: Save modified versions of the
files to a new location (leaving the
originals unchanged).

NODESTINATIONTYPE: Leave all files
open.

SAVEANDCLOSE: Save changes and
close the files.
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Constant type

Values

What it means

BitmapConversionType

BitmapHalfToneType

BitsPerChannelType

BlendMode

BMPDepthType

CUSTOMPATTERN
DIFFUSIONDITHER
HALFTHRESHOLD
HALFTONESCREEN
PATTERNDITHER

CROSS
DIAMOND
ELLIPSE
LINE
ROUND
SQUARE

EIGHT
ONE
SIXTEEN
THIRTYTWO

COLORBLEND
COLORBURN
COLORDODGE
DARKEN
DIFFERENCE
DISSOLVE
DIVIDE
EXCLUSION
HARDLIGHT
HARDMIX
HUE
LIGHTEN
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PASSTHROUGH
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
SUBTRACT
VIVIDLIGHT

BMP_A1R5G5B5
BMP_A4R4G4B4
BMP_ASR8G8B8
BMP_R5G6B5
BMP_R8G8B8
BMP_X1R5G5B5
BMP_X4R4G4B4
BMP_X8R8G8B8
EIGHT

FOUR

ONE

SIXTEEN
THIRTYTWO
TWENTYFOUR

Specifies the quality of an image you
are converting to bitmap mode. Used
in BitmapConversionOptions.

Specifies the shape of the dots (ink
deposits) in the halftone screen. Used
in BitmapConversionOptions.

The number of bits per color channel.
Value of Document.bitsPerChannel;
pass to Documents.add(). Also used in
PDFOpenOptions and
CameraRAWOpenOptions.

Controls how pixels in an image are
blended when a filter is applied. The
value of ArtLayer.blendMode and
LayerSet.blendMode.

The number of bits per channel (also
called pixel depth or color depth). The
number selected indicates the
exponent of 2. For example, a pixel
with a bit-depth of E1GHT has 28 or
256, possible color values.

Used in BMPSaveOptions.
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Constant type Values What it means
ByteOrder IBM The platform-specific order in which
MACOS multibyte values are read.
CameraRAWSettingsType CAMERA The default CameraRaw settings to
S:EJEE?TIIEDIMAGE use: the camera settings, custom
settings, or the settings of the selected
image. Set in
CameraRAWOpenOptions.
CameraRAWSize EXTRALARGE The camera RAW size type options..
LARGE
MAXTIMUM EXTRALARGE=5120 x 4096
MEDIUM LARGE=4096 x 2731
gmiﬁm MAXIMUM=6144 X 4096
MEDIUM=3072 x 2048
MINIMUM=1536 x 1024
SMALL=2048 x 1365
Set in CameraRAWOpenOptions.
ChangeMode BITMAP The new color profile or mode for a
CMYK document, specified in
GRAYSCALE D t ch Mode()
. ocument.changeMode().
LAB
MULTTCHANNEL Note: Color images must be changed
RGB to GRAYSCALE mode before you
can change them to BITMAP
mode.
ChannelType COMPONENT The type of a color channel:
MASKEDAREA
SELECTEDAREA COMPONENT: related to document color
SPOTCOLOR mode.

MASKEDAREA: Alpha channel where
color indicates masked area.

SELECTEDAREA: Alpha channel where
color indicates selected are.

SPOTCOLOR: Alpha channel to store a
spot color.
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Constant type

Values

What it means

ColorBlendMode

ColorModel

ColorPicker

ColorProfileType

ColorReductionType

ColorSpaceType

CopyrightedType

BEHIND
CLEAR

COLOR
COLORBURN
COLORDODGE
DARKEN
DARKERCOLOR
DIFFERENCE
DISSOLVE
EXCLUSION
HARDLIGHT
HARDMIXBLEND
HUE

LIGHTEN
LIGHTERCOLOR
LINEARBURN
LINEARDODGE
LINEARLIGHT
LUMINOSITY
MULTIPLY
NORMAL
OVERLAY
PINLIGHT
SATURATION
SCREEN
SOFTLIGHT
VIVIDLIGHT

CMYK
GRAYSCALE
HSB

LAB

NONE

RGB

ADOBE
APPLE
PLUGIN
WINDOWS

CUSTOM
NONE
WORKING

ADAPTIVE
BLACKWHITE
CUSTOM
GRAYSCALE
MACINTOSH
PERCEPTUAL
RESTRICTIVE
SELECTIVE
WINDOWS

ADOBERGB
COLORMATCHRGB
PROPHOTORGB
SRGB

COPYRIGHTEDWORK
PUBLICDOMAIN
UNMARKED

The way color should be blended in a
fill or stroke operation. Pass to
Pathltem.fillPath(), Selection.fill(),
Selection.stroke()

The color model to use for a
SolidColor.

The preferred color-selection tool, set
in Preferences.

The type of color profile used to
manage this document, set in
Document.colorProfileType.

The color reduction algorithm option
for ExportOptionsSaveForWeb.

The type of color space to use in
CameraRAWOpenOptions.

The copyright status of a document.
Used in
DocumentPrintSettings.copyrighted.
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Constant type Values What it means
CreateFields DUPLICATION The method to use for creating fields.
INTERPOLATION Pass to ArtLayer.applyDelnterlace().
CropToType ARTBOX The style to use when cropping a page
Eggfg?ﬁ}égox in a PDF document. Set in
CROPROX PDFOpenOptions.cropPage.
MEDIAROX
TRIMBOX
DCSType COLORCOMPOSITE The type of composite DCS file to
Egég;ggg?ggmo“m create with DCS1_SaveOptions or
DCS2_SaveOptions:
COLORCOMPOSITE: Creates a color
composite file in addition to DCS files.
GRAYSCALECOMPOSITE: Creates a
grayscale composite file in addition to
DCS files.
NOCOMPOSITE: Does not create a
composite file.
DepthMapSource IMAGEHIGHLIGHT The source to use for the depth map.
LAYERMASK Pass to ArtLayer.applyLensBlur().
NONE yer.apply 0
TRANSPARENCYCHANNEL
DescValueType ALIASTYPE The value type of an action key,
22222?1;?;% returned by
DOUBLETYDE ActionQescriptor.getType() and
ENUMERATEDTYPE ActionList.getType().
INTEGERTYPE
LARGEINTEGERTYPE
LISTTYPE
OBJECTTYPE
RAWTYPE
REFERENCETYPE
STRINGTYPE
UNITDOUBLE
DialogModes ALL Controls the type of dialogs
EgROR Photoshop displays when running
scripts.
Direction HORIZONTAL »  The direction in which to flip the
VERTICAL

document canvas, passed to
Document.flipCanvas().

»  The orientation of text in
Textltem.direction.

»  The direction of text warping in
Textltem.warpDirection.
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Constant type Values What it means
DisplacementMapType STRETCHTOFIT Describes how the displacement map
TILE fits the image if the image is not the
same size as the map. Pass to
ArtLayer.applyDisplace().
Dither DIFFUSION The type of dithering to use in
Eg;:E GIFSaveOptions,
PATTERN IndexequnversmnOptlons and
ExportOptionsSaveForWeb.
DocPositionStyle PRINTCENTERED The type of positioning to use in
USERDEFINED DocPosition
DocumentFill BACKGROUNDCOLOR The fill type of a new document,
TRANSPARENT passed to Documents.add().
WHITE B —
DocumentMode BITMAP The color mode of a open document,
%gﬁom Document.mode. See also
GRAYSCALE Document.changeMode().
INDEXEDCOLOR
LAB
MULTICHANNEL
RGB
EditLogItemsType CONCISE The preferred level of detail in th
DETAILED history log, set in Preferences:
SESSTONONLY B
CONCISE: Save a concise history log.
DETAILED: Save a detailed history log.
SESSIONONLY: Save history log only for
the session.
ElementPlacement INSIDE The object’s position in the Layers
PLACEATBEGINNING palette.
PLACEATEND
PLACEBEFORE .
PLACEAFTER Note: No't all values are valid for ﬁll
object types. See the specific
object description to make sure
you are using a valid value.
EliminateFields EVENFIELDS The type of fields to eliminate. Pass to
ODDFIELDS ArtLayer.applyDelnterlace().
ExportType ILLUSTRATORPATHS The type of export for
SAVEFORWEB Document.exportDocumenty().
This is equivalent to choosing File >
Export > Paths To lllustrator, or File
> Save For Web and Devices.
Extension LOWERCASE The policy and format for appending
NONE an extension to the filename when
UPPERCASE

saving with Document.saveAs().
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Constant type Values What it means
FileNamingType DDMM File naming options for the
gg% MELOWER BatchOptions used with the
DOCUMENTNAMEMIXED Application.pbatch() method.
DOCUMENTNAMEUPPER
EXTENSIONLOWER
EXTENSIONUPPER
MMDD
MMDDYY
SERIALLETTERLOWER
SERIALLETTERUPPER
SERIALNUMBER1
SERIALNUMBER2
SERTALNUMBER3
SERIALNUMBER4
YYDDMM
YYMMDD
YYYYMMDD
FontPreviewType HUGE The preferred type size to use for font
EXTEQLARGE previews in the type tool font menus,
MEDIUM setin Preferences.
NONE
SMALL
FontSize LARGE The preferred type size to use for
MEDIUM panels and dialogs, set in Preferences.
SMALL
ForcedColors BLACKWHITE The type of colors to be included the
g%m - color table regardless of their usage.
WEB Used in GIFSaveOptions and
IndexedConversionOptions.
BLACKWHITE: Pure black and pure
white.
NONE: None
PRIMARIES: Red, green, blue, cyan,
magenta, yellow, black, and white.
wWEB: the 216 web-safe colors.
FormatOptions OPTIMIZEDBASELINE The option with which to save a JPEG
PROGRESSIVE file, in JPEGSaveOptions.
STANDARDBASELINE
OPTIMIZEDBASELINE: Optimized color
and a slightly reduced file size.
PROGRESSIVE: Displays a series of
increasingly detailed scans as the
image downloads.
STANDARDBASELINE: Format
recognized by most web browsers.
GalleryConstrainType CONSTRAINBOTH The type of proportions to constrain
CONSTRAINHELGHT for images. Used in
CONSTRAINWIDTH

GallerylmagesOptions.
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Constant type Values What it means
GalleryFontType ARTAL The fonts to use for the Web photo
COURTERNEW gallery captions and other text. Used
HELVETICA h .
TTMESNEWROMAN in GalleryBannerOptions,
GallerylmagesOptions, and
GalleryThumbnailOptions.
Also used in PicturePackageOptions.
GallerySecurityTextColorType BLACK The color to use for text displayed over
CUSTOM gallery images as an antitheft
WHITE .
deterrent. Used in
GallerySecurityOptions.
GallerySecurityTextPositionType CENTERED The position of the text displayed over
LOWERLEFT gallery images as an antitheft
LOWERRIGHT det t Used in
UPPERLEFT eterrent. Used In
UPPERRIGHT GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityTextRotateType  CLOCKWISE45 The orientation of the text displayed
CLOCKWISES0 over gallery images as an antitheft
COUNTERCLOCKWISE45 det t Used in
COUNTERCLOCKWISES0Q eterrent. Used In
ZERO GallerySecurityOptions.
Also used in PicturePackageOptions.
GallerySecurityType CAPTION The content to use for text displayed
COPYRIGHT over gallery images as an antitheft
CREDIT det t Used i
CUSTOMTEXT eterrent. Used in -
FILENAME GallerySecurityOptions.
NONE
TITLE Note: All types draw from the image's
file information except
CUSTOMTEXT.
GalleryThumbSizeType CUSTCM The size of thumbnail images in the
LARGE web photo gallery. Used in
MEDTOM GalleryThumbnailOptions
SMALL alleryThu ilOptions.
Geometry HEPTAGON Geometric options for shapes, such as
HEXAGON the iris shape in the Lens Blur Filter.
OCTAGON
PENTAGON Pass to ArtLayer.applyLensBlur().
SQUARE
TRIANGLE
GridLineStyle DASHED The preferred line style for the
DOTTED nonprinting grid displayed over
SOLID . .
images, set in Preferences.
GridSize LARGE The preferred size of grid line spacing,
MEDIUM set in Preferences.
NONE _—

SMALL
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Constant type Values What it means
GuideLineStyle DASHED The preferred line style for
SOLID nonprinting guides displayed over
images, set in Preferences.
IllustratorPathType ALLPATHS The paths to export to an lllustrator
DOCUMENTBOUNDS file using
NAMEDPATH
Document.exportDocumenty().
Intent ABSOLUTECOLORIMETRIC  The rendering intent to use when
PERCEPTUAL converting from one color space to
RELATTIVECOLORIMETRIC th h
SATURATION another wi _
Document.convertProfile() or
Document.print()
Justification CENTER The placement of paragraph text
CENTERJUSTIFIED within the bounding box. Used in
FULLYJUSTIFIED Textltern.iustificati
LEFT extltem.justification.
LEFTJUSTIFIED
RIGHT
RIGHTJUSTIFIED
Language BRAZILLIANPORTUGUESE  The language to use for text. Used in
CANADIANFRENCH Textltem.language.
DANISH
DUTCH
ENGLISHUK
ENGLISHUSA
FINNISH
FRENCH
GERMAN
ITALIAN
NORWEGIAN
NYNORSKNORWEGIAN
OLDGERMAN
PORTUGUESE
SPANISH
SWEDISH
SWISSGERMAN
LayerCompression RLE Compression methods for data for
ZIP

pixels in layers, when saving to TIFF
format. Used in TiffSaveOptions.
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Constant type Values What it means
LayerKind BLACKANDWHITE The type of a layer object, in
BRIGHTNESSCONTRAST ArtLaver.kind
CHANNELMIXER ArLayerxind
COLORBALANCE
s Note: You can create a text layer only
EXPOSURE from an empty art layer.
GRADIENTFILL
GRADIENTMAP
HUESATURATION
INVERSION
LEVELS
NORMAL
PATTERNFILL
PHOTOFILTER
POSTERIZE
SELECTIVECOLOR
SMARTOBJECT
SOLIDFILL
TEXT
THRESHOLD
LAYER3D
VIBRANCE
VIDEO
LensType MOVIEPRIME The type of lens to use. Pass to
PRIME105 A
rtLayer.applyLensFlare().
PRIME35 yerapply 0
ZOOMLENS
MagnificationType ACTUALSIZE The type of magnification to use when
FITPAGE viewing an image. Used in
PresentationOptions.
MatteType BACKGROUND The color to use to fill anti-aliased
BLACK edges adjacent to transparent areas of
FOREGROUND the i When t .
NETSCAPE e image. When transparency is
NONE turned off for an image, the matte
SEMIGRAY color is applied to transparent areas.
WHITE ' .
Used in GIFSaveOptions,
IndexedConversionOptions, and
JPEGSaveOptions.
MeasurementRange ALLMEASUREMENTS The measurement to act upon. Pass to
ACTIVEMEASUREMENTS MeasurementLog methods.
MeasurementSource MEASURESELECTION The source for recording
MEASURECOUNTTOOL measurements. Pass to
MEASURERULERTOOL
Document.recordMeasurements().
NewDocumentMode BITMAP The color profile to use for a new
QYK document.
GRAYSCALE
LAB Pass to Documents.add().
RGB

Also used in ContactSheetOptions and
PicturePackageOptions.
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Constant type Values What it means
NoiseDistribution GAUSSIAN Distribution method to use when
UNTFORM applying an Add Noise filter. Pass to
ArtLayer.applyAddNoise().
OffsetUndefinedAreas REPEATEDGEPIXELS Method to use to fill the empty space
SETTOBACKGROUND left by offsetting a an image or
WRAPAROUND .
selection. Pass to
ArtLayer.applyOffset().
OpenDocumentMode CMYK The color profile to use when opening
ii:YSCALE an EPS or PDF document. Pass to
RGB app.open () in EPSOpenOptions or
PDFOpenOptions.
OpenDocumentType ALIASPIX The format in which to open the
BMP document, using app . open ().
CAMERARAW ! 9 app-open
COMPUSERVEGIF .
DICOM Note: pHoTOCD is deprecated. Kodak
ELECTRICIMAGE PhotoCD is now found in the
EPS Goodies folder on the Adobe
EPSPICTPREVIEW Photoshop Install DVD.
EPSTIFFPREVIEW
FILMSTRIP .
IPEG Note: The p1com option is for the
PCX Extended version only.
PDF
PHOTOCD
PHOTOSHOP
PHOTOSHOPDCS 1
PHOTOSHOPDCS_2
PHOTOSHOPEPS
PHOTOSHOPPDF
PICTFILEFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP
OperatingSystem 082 The target operating system in
WINDOWS BMPSaveOptions.
Orientation LANDSCAPE Page orientation for
PORTRAIT

PhotoCDOpenOptions, deprecated in
Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop Install DVD.




Adobe Photoshop
JavaScript Scripting Reference

Scripting Constants 210

Constant type Values What it means
OtherPaintingCursors PRECISEOTHER The preferred pointer for the following
STANDARDOTHER tools: Eraser, Pencil, Paintbrush,
Healing Brush, Rubber Stamp, Pattern
Stamp, Smudge, Blur, Sharpen, Dodge,
Burn, Sponge.
Set in Preferences.
PaintingCursors BRUSHSIZE The preferred pointer for the following
ziECISE tools: Marquee, Lasso, Polygonal
Lasso, Magic Wand, Crop, Slice, Patch
Eyedropper, Pen, Gradient, Line, Paint
Bucket, Magnetic Lasso, Magnetic Pen,
Freeform Pen, Measure, Color Sampler.
Set in Preferences.
PaletteType EXACT The palette type to use in
Eg%ﬁggg& GIFSaveOptions and
LOCALSELECTTVE IndexedConversionOptions.
MACOSPALETTE
MASTERADAPTIVE
MASTERPERCEPTUAL
MASTERSELECTIVE
PREVIOUSPALETTE
UNIFORM
WEBPALETTE
WINDOWSPALETTE
PathKind CLIPPINGPATH The type of a Pathltem.
NORMALPATH
TEXTMASK
VECTORMASK
WORKPATH
PDFCompatibility PDF13 The PDF version to make the
gggié document compatible with. Used in
PDF16E PDFSaveOptions.
PDF17
PDFEncoding JPEG The type of compression to use when
giggigggiéﬁgmss saving a document in PDF format.
TPEG2000LOW Used in PDFSaveOptions.
JPEG2000MED
JPEG2000MEDHIGH
JPEG2000MEDLOW
JPEGHIGH
JPEGLOW
JPEGMED
JPEGMEDHIGH
JPEGMEDLOW
NONE
PDFZIP

PDFZIP4BIT
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Constant type Values What it means

PDFResample NONE The down sample method to use.
PDFAVERAGE Used in PDFSaveOptions.
PDFBICUBIC
PDFSUBSAMPLE

PDFStandard NONE The PDF standard to make the
iggﬁigggé document compatible with. Used in
PDFX32002 PDFSaveOptions.
PDFX32003
PDFX42008

PhotoCDColorSpace LAB16 The color space for
Eéii PhotoCDOpenOptions, deprecated in
Ny Photoshop CS3.

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop Install DVD.

PhotoCDSize EXTRALARGE The pixel dimensions of the image in
ﬁ?ﬁm PhotoCDOpenOptions, deprecated in
MEDTUM Photoshop CS3.
MINIMOM EXTRALARGE = 1024x1536
SMALL LARGE = 512x768

MAXIMUM = 2048x3072

MEDIUM = 256x384

MINIMUM = 64x96

SMALL = 128x192

Note: Kodak PhotoCD is now found in
the Goodies folder on the
Adobe Photoshop Install DVD.

PICTBitsPerPixels EIGHT The number of bits per pixel to use
g?g;EEN when compression a PICT file. Used in
THIRTYTHO PICTFileSaveOptions a.nd
TWO PICTResourceSaveOptions.

Note: Use 16 or 32 for RGB images;
use 2, 4, or 8 for bitmap and
grayscale images.

PICTCompression JPEGHIGHPICT The type of compression to use when
giggﬁgiﬁPICT saving an image as a PICT file. Used in
JPEGMEDLUMPTCT PICTFileSaveOptions a.nd
NONE PICTResourceSaveOptions.
PicturePackageTextType CAPTION The function or meaning of text in a
gnggﬁGHT Picture Package. Used in
FILENAME PicturePackageOptions.
NONE
ORIGIN
USER
PointKind CORNERPOINT The role a PathPoint plays in a
SMOOTHPOINT

Pathltem.
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Constant type Values What it means
PointType POSTSCRIPT The preferred measurement to use for
TRADITIONAL type points, set in
Preferences.pointSize:
POSTSCRIPT = 72 points/inch.
TRADITIONAL = 72.27 points/inch.
PolarConversionType POLARTORECTANGULAR The method of polar distortion to use.
RECTANGULARTOPOLAR Pass to
ArtLayer.applyPolarCoordinates().
Preview EIGHTBITTIFF The type of image touse as a
ﬁgggg;gﬁmﬂ low-resolution preview in the
MACOSMONOCHROME destination application.
EgEECHROMETIFF Used in DCS1_SaveOptions,
DCS2_SaveOptions, and
EPSSaveOptions.
PrintColorHandling PRINTERMANAGED The type of color handling to use for
PHOTOSHOPMANAGED ColorHandling
SEPARATIONS
PurgeTarget ALLCACHES Cache to be targeted in an
CLIPBOARDCACHE Application.purge() operation.
HISTORYCACHES PP burge() op
UNDOCACHES
QueryStateType ALWAYS The preferred policy for checking
QESER whether to maximize compatibility
when opening PSD files, set in
Preferences.maximizeCompatibility.
RadialBlurMethod SPIN The blur method to use. Pass to
ZOOM ArtLayer.applyRadialBlur().
RadialBlurQuality BEST The smoothness or graininess of the
ggggT blurred image. Pass to
ArtLayer.applyRadialBlur().
RasterizeType ENTIRELAYER The layer element to rasterize, using
FILLCONTENT ArtLayer.rasterize().
LAYERCLIPPINGPATH
LINKEDLAYERS
SHAPE
TEXTCONTENTS
ReferenceFormType CLASSTYPE The type of an ActionReference
ENUMERATED ;
object, returned by getForm().
IDENTIFIER ) y getForm()
INDEX
NAME
OFFSET

PROPERTY
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Constant type Values What it means

ResampleMethod AUTOMATIC The method to use forimage
Eiggigzwromnc interpolation. Passed to
BICUBICSHARDER Document.re5|zelmage(){ and used. as
BICUBICSMOOTHER the value of Preferences.interpolation.
BILINEAR
NEARESTNEIGHBOR
NONE
PRESERVEDETAILS

RippleSize LARGE The size of undulations to use. Pass to
MEDIUM ArtLayer.applyRipple
SMALL yer.applyRipple()

SaveBehavior ALWAYSSAVE The application’s preferred behavior
ASKWHENSAVING when saving a document. See
NEVERSAVE .

Preferences.appendExtension and
imagePreviews

SaveDocumentType ALIASPIX The format in which to save a
21‘0’J§PUSERVEGIF document when exporting with
FLECTRTICTMAGE Document..exportDocument(). Pass in
JPEG ExportOptionsSaveForWeb.format, to
PCX to specify the type of file to write. Only
PHOTOSHOP the following are supported for
PHOTOSHOPDCS_ 1 "
PHOTOSHOPDCS 2 export: COMPUSERVEGIF, JPEG, PNG-8,
PHOTOSHOPEPS PNG-24, and BMP.
PHOTOSHOPPDF
PICTFileFORMAT
PICTRESOURCEFORMAT
PIXAR
PNG
PORTABLEBITMAP
RAW
SCITEXCT
SGIRGB
SOFTIMAGE
TARGA
TIFF
WAVEFRONTRLA
WIRELESSBITMAP

SaveEncoding ASCII The type of encoding to use when
??géﬁ[{cm saving a file to DCS or EPS with
JPEGLOW Document.saveAs().
JPEGMAXIMUM
JPEGMEDIUM

SaveLogItemsType LOGFILE The preferred location of history log
LOGFILEANDMETADATA data, set in Preferences.saveLogltems.
METADATA

SaveOptions DONOTSAVECHANGES The policy for closing a document
PROMPTTOSAVECHANGES

SAVECHANGES

with Document.close().
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Constant type Values What it means
SelectionType DIMINISH The selection behavior when a
EXTEND selection already exists:
INTERSECT
REPLACE DIMINISH: Remove the selection from
the already selected area.
EXTEND: Add the selection to an
already selected area.
INTERSECT: Make the selection only
the area where the new selection
intersects the already selected area.
REPLACE: Replace the selected area.
Used in Pathltem.makeSelection(),
Selection.load(), Selection.select(), and
Selection.store().
ShapeOperation SHAPEADD How to combine the shapes if the
SHAPEINTERSECT destination path already has a
SHAPESUBTRACT lecti
SHAPEXOR selection.
Set for SubPathinfo.operation, stored
in the resulting SubPathltem.
SmartBlurMode EDGEONLY The method to use for smart blurring:
NORMAL
OVERLAYEDGE EDGEONLY, OVERLAYEDGES: Apply blur
only to edges of color transitions.
NORMAL: Apply blur to entire image.
Pass to ArtLayer.applySmartBlur().
SmartBlurQuality HIGH The blur quality to use. Pass to
Low ArtLayer.applySmartBlur().
MEDIUM yer.apply ()
SourceSpaceType DOCUMENT The color space for source when
PROCF printing with Document.print().
SpherizeMode HORIZONTAL The curve (or stretch shape) to use for
sg% the distortion. Pass to
ArtLayer.applySpherize().
StrikeThruType STRIKEBOX The style of strikethrough to use in
STRIKEHEIGHT text. Used in Textltem.strikeThru.
STRIKEOFF
StrokeLocation CENTER The placement of path or selection
égié?fm boundary strokes. Pass to
Selection.stroke().
TargaBitsPerPixels SIXTEEN The resolution to use when saving an
THIRTYTWO image in Targa format. Used in
TWENTYFOUR

TargaSaveOptions.
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Constant type Values What it means
TextCase ALLCAPS The capitalization style to use in text.
NORMAL Used in Textltem.capitalization.
SMALLCAPS
TextComposer ADOBEEVERYLINE The composition method to use to
ADOBESINGLELINE optimize the specified hyphenation
and justification options. Used in
Textltem.textComposer.
TextType PARAGRAPHTEXT The type of text, used in Textltem.kind.
POINTTEXT
PARAGRAPHTEXT: Text that wraps
within a bounding box.
POINTTEXT: Text that does not wrap.
TextureType BLOCKS The type of texture or glass surface
CANVAS image to load for a texturizer or glass
FILE filter. Pass t
FROSTED ilter. Pass to
TINYLENS ArtLayer.applyGlassEffect().
TIFFEncoding JPEG The type of compression to use for
NONE TIFF files. Used in TiffSaveOptions.
TIFFLZW
TIFFZIP
ToolType ARTHISTORYBRUSH The tool to use with
BACKGROUNDERASER Pathltem.strokePath().
BLUR
BRUSH
BURN
CLONESTAMP
COLORREPLACEMENTTOOL
DODGE
ERASER
HEALINGBRUSH
HISTORYBRUSH
PATTERNSTAMP
PENCIL
SHARPEN
SMUDGE
SPONGE
TransitionType BLINDSHORIZONTAL The method to use for transition from
BLINDSVERTICAL one image to the next in a PDF
BOXIN tation. Used i
BOXOUT presentation. Used in
DISSOLVE PresentationOptions.
GLITTERDOWN
GLITTERRIGHT
GLITTERRIGHTDOWN
NONE
RANDOM
SPLITHORIZONTALIN
SPLITHORIZONTALOUT
SPLITVERTICALIN
SPLITVERTICALOUT
WIPEDOWN
WIPELEFT
WIPERIGHT

WIPEUP
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Constant type Values What it means
TrimType BOTTOMRIGHT Type of pixels to trim around an
TOPLEFT image, passed to Document.trim().:
TRANSPARENT EE—
BOTTOMRIGHT = bottom right pixel
color.
TOPLEFT = top left pixel color.
TypeUnits MM The preferred unit for text character
PIXELS measurements, set in Preferences.
POINTS —
UndefinedAreas REPEATEDGEPIXELS The method to use to treat
WRAPAROUND undistorted areas or areas left blank in
an image to which the afilter in the
Distort category has been applied.
Pass to ArtLayer.applyDisplace(),
applyShear(), applyWave().
UnderlineType UNDERLINELEFT The placement of text underlining.
UNDERL INEOFF Used in Textltem.underline.
UNDERLINERIGHT
Note: UNDERLINELEFT and
UNDELINERIGHT are valid only when
direction = Direction.VERTICAL.
Units CcM The preferred measurement unit for
INCHES type and ruler increments, set in
l\éﬂ;RCENT Preferences.rulerUnits.
PICAS
PIXELS
POINTS
Urgency FOUR The editorial urgency status of a
HIGH document, set in
EggE DocumentPrintSettings.urgency.
NORMAL
SEVEN
SIX
THREE
TWO
WarpStyle ARC The warp style to use for text. Used in
ARCH Textltem.warpStyle.
ARCLOWER
ARCUPPER
BULGE
FISH
FISHEYE
FLAG
INFLATE
NONE
RISE
SHELLLOWER
SHELLUPPER
SQUEEZE
TWIST

WAVE
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Constant type Values What it means
WaveType SINE The type of wave to use. Pass to
SQUARE ArtLayer.applyWave().
TRIANGULAR YELAPPYY 0
WhiteBalanceType ASSHOT Lighting conditions that affect color
éILJgSDY balance. Set in
CUSTOM CameraRAWOpenOptions.
DAYLIGHT
FLASH
FLUORESCENT
SHADE
TUNGSTEN
ZigZagType AROUNDCENTER The method of zigzagging to use. Pass
OUTFROMCENTER

PONDRIPPLES

to ArtLayer.applyZigZag().




Appendix A: Event ID Codes

The following table lists events and their four-character ID codes or string identifiers for use with the
notifier object.

Note: Do not include single quotes (') with four-character IDs in your code. The single quotes are
used in this table to illustrate the placement of required spaces in codes that do not contain four

letters. However, string identifiers, which are longer than four characters, require double quotes in

the code.

Tip: If you can't find the event you want to use for notification in this table, you can use ScriptListener to
determine the event ID code. See the ScriptListener documentation in the Action Manager chapter of

the Photoshop Scripting Guide.

Event 4-char ID or String
3DTransform 'TdT !
Average 'Avrg'
ApplyStyle 'ASty!
Assert 'Asrt’
AccentedEdges 'AccE'
Add 'Add !
AddNoise 'AdNs'
AddTo 'Add4T!
Align 'Algn’
All 'All
AngledStrokes 'Angs'’
ApplyImage 'AppI!
BasRelief 'BsR1'
Batch 'Btch'
BatchFromDroplet 'BtcF!
Blur 'Blr !
BlurMore 'B1lrM'
Border 'Brdr'
Brightness 'BrgC'
CanvasSize 'CnvSs'
ChalkCharcoal 'ChlcC!
ChannelMixer 'ChnM'

218
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Event 4-char ID or String
Charcoal 'Chrc'
Chrome 'Chrm'
Clear 'Cler'
Close 'Cls !
Clouds 'Clds'
ColorBalance 'ClrB'
ColorHalftone 'ClrH'
ColorRange 'ClrR'
ColoredPencil 'Clrp!’
ContactSheet "0B71D221-F8CE-11d2-B21B-0008C75B322C"
ConteCrayon 'CntC!
Contract 'Cntc'!
ConvertMode 'CnvM'
Copy 'copy'!
CopyEffects 'CpFX!
CopyMerged 'CpyM'
CopyTolayer 'CpTL!'
Craquelure 'Crql’
CreateDroplet 'CrtD!
Crop 'Crop'
Crosshatch 'Crsh'
Crystallize 'Crst’
Curves 'Crvs'
Custom 'Cstm'
Cut 'cut !
CutToLayer 'CETL'
Cutout 'Ct !
DarkStrokes 'DrkS'
DeInterlace 'Dntr!
DefinePattern 'DEfnP!
Defringe 'Dfrg’
Delete 'Dlt !
Desaturate 'Dstt!
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Event 4-char ID or String
Deselect 'Dslc’
Despeckle 'Dspc'!
DifferenceClouds 'DrfcC!
Diffuse 'Dfs !
DiffuseGlow 'DfsG'
DisablelLayerFX 'dlfx!
Displace 'Dspl’
Distribute 'Dstr’
Draw 'Draw'
DryBrush 'DryB'
Duplicate 'Dplc’
DustAndScratches 'DstS'
Emboss 'Embs'
Equalize 'Eqlz’
Exchange 'Exch'
Expand 'Expn'
Export 'Expr'
Jumpto 'Jpto’

ExportTransparentImage

"02879e00-cb66-11d1-bc43-0060b0all3dc4™"

Extrude 'Extr’
Facet 'Fet !
Fade 'Fade'
Feather 'Fthr'
Fibers 'Fbrs'
Fill 'F1 !
FilmGrain 'FlmG'
Filter 'Fltr'
FindEdges 'FndE'
FitImage "3caal3434-cb67-11d1-bc43-0060b0al3dc4"
FlattenImage 'F1lteI!
Flip 'Flip'
Fragment 'Frgm'
Fresco 'Frsc'
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Event 4-char ID or String
GaussianBlur 'GsnB'
Get 'getd!
Glass 'Gls !
GlowingEdges 'GlwE'
Gradient 'Grdn'
GradientMap 'GrMp'
Grain 'Grn !
GraphicPen 'GrabP’
Group 'GrpL!
Grow 'Grow'
HalftoneScreen 'H1fS!
Hide 'Hd !
HighPass 'HghP'
HSBHSL 'HsbP'
HueSaturation 'HStr!
ImageSize 'ImgS'
Import 'Impr'
InkOutlines 'InkO'
Intersect 'Intr!'
IntersectWith 'IntwW!'
Inverse 'Invs'
Invert 'Invr'
LensFlare 'LnsF!
Levels 'Lvls!
LightingEffects 'LghE'
Link 'Lnk '
Make 'Mk !
Maximum 'Mxm '
Median 'Mdn !
MergeLayers 'Mrg2'
MergeLayersOld 'MrgL'
MergeSpotChannel 'MSpt!'
MergeVisible 'MrgV'
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Event 4-char ID or String
Mezzotint 'Mztn'
Minimum 'Mnm !
ModeChange "8cba8cd6-cb66-11d1-bc43-0060b0all3dc4"
Mosaic 'Msc !
Mosaic_PLUGIN 'MscT'
MotionBlur 'MtnB'
Move 'move'
NTSCColors 'NTSC'
NeonGlow 'NGlw'
Next 'Nxt !
NotePaper 'NtPr!'
Notify 'Ntfy!
Null typeNull
OceanRipple 'OcnR'’
Offset 'Ofst!
Open 'Opn !
Paint 'Pnt !
PaintDaubs 'PntD'
PaletteKnife 'P1tK'
Paste 'past'’!
PasteEffects 'PaFX'
Pastelnto 'PstI!
PasteOutside 'PstO’
Patchwork 'Ptch!
Photocopy 'Phtc!
PicturePackage "4C1lABF40-DD82-11d2-B20F-0008C75B322C"
Pinch 'Pnch'’
Place 'Plc !
Plaster 'Plst’
PlasticWrap 'PlsW'
Play 'Ply !
Pointillize 'Pntl’
Polar 'Plr !
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Event 4-char ID or String
PosterEdges 'PStE'
Posterize 'Pstr’
Previous 'Prvs'
Print 'Prnt’
ProfileToProfile 'PriT!
Purge 'Prge'’
Quit 'quit'
RadialBlur 'RA1B'
Rasterize 'Rstr’
RasterizeTypeSheet 'RstT!
RemoveBlackMatte 'RmvB'
RemovelayerMask 'RmvL'
RemoveWhiteMatte 'RmvW'
Rename 'Rnm '
ReplaceColor 'RplC!
Reset 'Rset'’
ResizeImage "1333cf0c-cb67-11d1-bcd43-0060b0al3dca"
Reticulation 'Rtcl!
Revert 'Rvrt!
Ripple 'Rple’
Rotate 'Rtte’
RoughPastels 'RghP'
Save 'save'
Select 'slct!
SelectiveColor 'SlcC!
Set 'setd’
SharpenEdges 'ShrE'
Sharpen 'Shrp'
SharpenMore 'ShrM'
Shear 'Shr !
Show 'Shw !
Similar 'Smlr'
SmartBlur 'SmrB'
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Event 4-char ID or String
Smooth 'Smth'
SmudgeStick 'SmdS'
Solarize 'Slrz!’
Spatter 'Spt !
Spherize 'Sphr'
SplitChannels 'SplcC!
Sponge 'Spng'
SprayedStrokes 'SprS!
StainedGlass 'StnG'
Stamp 'Stmp!
Stop 'Stop'
Stroke 'Strk!
Subtract 'Sbtr'
SubtractFrom ' SbtF'
Sumie 'Smie’
TakeMergedSnapshot 'TkMr'
TakeSnapshot 'TkSn'
TextureFill 'TxtF!
Texturizer 'Txtz!'
Threshold 'Thrs'
Tiles 'Tls !
TornEdges 'TrnE'
TraceContour 'TrcC!
Transform 'Trnf!
Trap 'Trap'
Twirl 'Twrl'
Underpainting 'Undr'
Undo 'undo'
Ungroup 'Ungr!
Unlink 'Unlk’
UnsharpMask 'UnsM'
Variations 'Vrtn'
Wait 'Wait'
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Event 4-char ID or String
WaterPaper 'WtrP'
Watercolor 'Wtre!
Wave 'Wave'
Wind 'Wnd '
ZigZag 'Z2gzg’
BackLight 'BacL'
FillFlash 'FilE!

ColorCast 'ColE"
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Action Manager 195
actions
command lists 40
descriptions 43
descriptors 37
playing 47
active document 45
activePrinter 98
Add Noise filter
adjustments
brightness 57
color 199
color balance 57,63
contrast 57,61
curves 57
highlights 64
levels 57,61
shadows 64
temperature 63
Adobe lllustrator, exporting paths to 107
alpha channels
defined 74
from transparency (TIFF documents) 188
opacity 74
saving
in BMP documents 71
in PDF documents 150
in PICT documents 155
in PICT resources 156
in Pixar documents 158
in PSD documents 154
in RAW documents 166
in SGIRGB documents 173
in Targa documents 178
in TIFF documents 188
anchor points
adding 145
annotations, importing 94
anti aliasing
text 181
application
activating 47
checking if feature enabled 49
defaults 160
location 46
preferences 160
artLayers, See layers
Asian text 162
authors 101
auto kerning 181, 199
auto leading 186
auto spacing, contact sheets 84

available memory 46
Average filter 57

background color
application 45
galleries 112
background layers 55
backgroundColor 98
baseline shift 181
batch command 47
batches
destination folder 68, 199
specifying options 68
beeping 160
bitmap documents
converting to 200
depth type 200
halftone type 200
opening 209
saving 71
bitmap images
See bitmap documents
black and white images 64
bleedWidth 98
blending modes
layer sets 131
layers 55
Blur filter 57
blur filters
Average 57
Blur More 57
Gaussian Blur 58
Lens Blur 59
Motion Blur 60
Radial Blur 60
Smart Blur 61
Blur More filter 57
BMP documents
See bitmap documents
brightness 57
adjusting 57

equalizing 62
build 45
C
caches
images 161
purging 51
camera raw documents
opening 72

settings 201
size options 201
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canvas
flipping 94
resizing 94
canvas, defined 90
caption 98
captions
contact sheets 84
documents 101
gallery images 113
gallery thumbnails 117
images 101
centerCropMarks 98
changeProgressText 47
channels
activating 90
adding 76
adjusting 57
alpha See alpha channels
creating 76
deleting 74
displaying in color 160
duplicating 74
making visible 74
merging 74
mixing 63
splitting 95
spot See spot channels
types of 74
clipping paths
from paths 141
from text 187
Clouds filter 57
CMYKColor 81
color balance, adjusting 63
color picker 160
color profiles
changing 93
determining type of 91
naming 90
color profiles, see individual document formats
color samplers
adding 83
creating 83
moving 82
removing 82
colorBars 98
colorHandling 98
colors
active links 112
adjusting 199
balancing 57
channels 74
CMYK 81
custom settings 115
in galleries 112
inverting 62
modifying 64
none 137
preserving (GIF only) 118
reduction 108

settings 45
solid color objects 174
testing if equal 174
visited links 112
comments, layer comps 128
compatibility, maximizing 161
component channels
color balance 57
defined 74
listing 90
See composite channels
composite channels 74
See component channels
Compuserve GIF documents
opening 209
saving 118
contact sheets
captions 84
columns 84
dimensions 84
making 50
rows 84
contrast
adjusting 57
adjusting automatically 61
camera raw settings 72
midtones 64
copies 98
copyrights 101
cornerCropMarks 98
count items
adding 86
creating 86
removing 85
cropping 93
current tool name 45
cursors 162
curves, adjusting 57
Custom filters 57

D

DCS 1 documents, saving 87
De-Interlace filter 58
desaturate 62
Despeckle filter 58
dialogs
displaying 45
Difference Clouds filter 58
Diffuse Glow filter 58
Displace filter 58
distort filters
Diffuse Glow 58
Displace 58
Glass Effect 58
Ocean Ripple 60
Pinch 60
Polar Coordinates 60
Ripple 60
Shear 61
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Spherize 61
Twirl 61
Wave 61
Zigzag 61
doAction 48
document formats, see individual document formats
DocumentPrintSettings 98
documents 90
activating 45
adding 104
closing 92
code sample 96
color profiles 90
color samplers 90
counting items 91
counting objects 93
cropping 36, 93
dimensions 90
duplicating 36,93
exporting 94
info 101
loading 49
managed 91
measurement scale 91
metadata 91, 101
open with Photoshop dialog 50
opening 50
optimizing for web 108
printing 94
resizing 94
resolution 92
saving 94, 95
suspending history 95
trapping (CMYK) 95
trimming 96
doForcedProgress 48
doProgress 48
doProgressSegmentTask 48
doProgressTask 49
Dust and Scratches filter 58

E

Enable Info
constants 193
grammar 192
operator precendence 193
variables 194
EPSSaveOptions 106
equalize 62
event IDs
using ScriptListener to find 218
Events Manager 46
executing scripts 33
exif 101
exporting
documents 94
paths 107
to lllustrator 107
to Web 108

ExportOptionslllustrator 107
ExportOptionsSaveForWeb 108

F

file extensions
format 163
including 160

script files 32
file metadata 101
files
merging 50
filetypes
macOS 46
Windows 47
filling
paths 140
selections 169
filter, see individual filter names
flip 98
Folder object 32
fonts
detecting 45
determining family of 179
determining style of 179
formats, see individual document formats

G

galleries 115
background color 112
banners 111
captions 113
color options 112
credits 113
dimensions 113
filenames 113
link colors 112
making 47, 50
metadata 115
photographer 111
security text 116
thumbnail images 117
GalleryBannerOptions 111
GalleryCustomColorOptions 112
GallerylmagesOptions 113,114
GalleryOptions 115
GallerySecurityOptions 116
GalleryThumbnailOptions 117
Gaussian Blur filter 58
GIF documents
See Compuserve GIF documents
GIFSaveOptions 118
Glass Effect filter 58
glyph scaling 181-184
GrayColor 119
grids 161
grouped layers 55
guides 161
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H

halftone screen 70
hanging punctuation 182
hardProof 98
High Pass filter 58
highlights
adjusting 64
color balance 57
histograms
channels 74
history log 163
history states
activating 90
allowing nonlinear 161
default number of 162
snapshot 122
suspending 95
HSBColor 124
hypenation 183

IDs
getting 37
PICT Resource 156
property 43
runtime 47
runtime to string 52
string to runtime 51
string to type 51
type to char 51
lllustrator
See Adobe lllustrator
image
resizing 95
image pyramids 188
images
bitmap 70
black and white 64
caches 161
captions 113
definition of 90
desaturating 62
equalizing 62
filetypes 46
from split channels 95
inverting colors 62
previewing 161
pyramids 188
resizing 94
resizing in galleries 114
thumbnails 117
indexed color model 125
IndexedConversionOptions 125
individual document formats, examples 95
installing scripts 33
Intent 98
interpolate 98
interpolation 161

J

JavaScript

supported features 32
JavaScript Resource

Enable Info grammar 192

javascriptresource syntax 191
javascriptresource tag 191
JPEG

quality 126
JPEG documents

quality 126

saving 126
JPEG options

scans 126
JPEGSaveOptions 126
justification 183

K

kerning 181
text
auto kerning 199
keyboard behavior 161

L

LabColor 127

labels 98

languages 183

layer comps 128
adding 129
applying 128
in documents 91

layer sets
adding 133
art layersin 131
duplicating 132
in documents 91
linked layersin 131
linking 132
locking contents 131
moving 132
nesting 131
opacity 131
unlinking 132

layer styles, applying 61

LayerComps 129

layered TIFFdocuments, saving 160

Layers 130

layers
adding 67
applying styles 61
background 55
blending mode 55
bounds 55
clipboard commands 61
comps 128
copying 61
duplicating 62
flattening 94
grouping 55
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in documents 91
inverting 62
kind 55
linking 62
locking contents 55-56
making visible 56
merging 62
merging visible 94
moving 63
rasterizing 94
rasterizing contents 63
removing 67
resizing 64
rotating 64
saving in PDF documents 150
unlinking 64
LayerSet 131
LayerSets 133
layersets
merging 132
leading 183, 186
Lens Blur filter
applying 59
Lens Flare filter 59
letter spacing 182-185
levels
adjusting 57
adjusting automatically 57
ligatures 181-183
linked layers 62
unlinking 64
links
colors 112

M
MacOS

filetypes 46
managed documents 91
mapBlack 98
maximizing compatibility 161
Maximum filter 59
Median Noise filter 59
memory 46
merging

layers 62

visible layers 94
metadata

document 91

document object 101

galleries 115

xmp 92,190
methods

batch 47
midtones

color balance 57
Minimum filter 60
Motion Blur filter 60

N

negative 98
noise filters
Add Noise
Despeckle 58
Dust and Scratches 58
Median Noise 59
nonlinear history 161
notifications
events within scripts 138
notifiers
adding 139
event IDs 218
removing 138
NTSC filter 60

(0)
Ocean Ripple filter 60
Offset filter 60
old style type 185
opacity
channels 74
gallery security text 116
layer fill 55
layer sets 131
layers 56
picture packages 157
open options
DICOM format 89
EPS format 105
PDF format 149
Photo CD format 153
RAW format 72, 165
optimizing 108
other filters

Custom 57
High Pass 58
Maximum 59
Minimum 60
Offset 60

P

palettes 162

pasting 94

path 46

path items
adding 144
deselecting 140
filling 140

from text 187

making selection 141

path points 176

selecting 141

specifying path kind 140
stroking 141

sub items 140

sub path info 175

sub path items 176

work path from selection 169
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path point info
anchor points 146
left direction 146
right direction 146
path points
anchor points 145
left direction 145
right direction 145
Pathltems 144
paths
See path items
PDF documents
opening 149
saving 150
PDF presentations
auto advance 164
making 50
output format 164
transition type 164
Photo CD discs, opening 153
photo filtering 63
photo galleries
See galleries
photomerge 50
Photoshop documents
opening 209
saving 154
Photoshop files, maximizing compatibility 161
PICT documents
opening 209
saving 155
PICT resources
opening 209
saving 156
picture packages
contents 157
flattening 157
making 50
opacity 157
options 157
text properties 157
Pinch filter 60
Pixar documents
opening 209
saving 158
PixarSaveOptions 158
pixels
aspect ratio 91
doubling 162
equalizing 62
interpolation 161
locking 56
unit measures 216
playback options 46
playbackDisplayDialogs 46
plug-in folder
additional plug-in folder 163
PNG 8 documents, saving 108
PNG documents
saving 159

PNGSaveOptions 159
Polar Coordinates filter 60
posterrize 63
postscript encoding 94
PostScript names 179
posX 98
posY 98
Preferences 160
PresentationOptions 164
presentations
making 50
PDF presentations
printBorder 98
printing, documents 94
printOneCopy 94
printSelected 98
printSettings 92
printSpace 98
property
measurementlLog 46
PSD documents
opening 209
saving 154
purging 51

Q
quickMaskMode 92
quote style 162

R
Radial Blur filter 60
rasterize 63
rasterizing
document layers 94
RAW documents
opening 165
RawSaveOptions 166
recentFiles 46
registrationMarks 98
render filters
Clouds 57
Difference Clouds 58
Lens Flare 59
renderintent 98
resolution
bitmap conversions 70
documents 92
RGBColor 167
Ripple filter 60
rotation 64
ruler units 162
runMenultem 51

S

save as 95

saved 92

saving 94

saving, see individual document formats.
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scale 99
scripting interface
build date 46
version 46
scriptingVersion 46
scripts
automation 191, 195
enabling/disabling in menu 191
executing 33
grouping in menu 191
installing 33
startup 33
terminology dictionary 195
valid file extensions 32
Scripts Events Manager 46
selected areas 92
selections 168
boundaries 168
clearing 168
copying 168
cutting 168
deselecting 168
feathering 168
filling 169
from paths 141
making work path from 169
resizing 168, 169
rotating 169
smoothing 170
stroking 170
selective color 64
SGIRGB documents
saving 173,213
SGIRGBSaveOptions 173, 199
shadows
adjusting 64
color balance 57
Sharpen Edges filter 60
Sharpen filter 60
sharpen filters
Sharpen 60
Sharpen Edges 60
Sharpen More 60
Unsharp Mask 61
Sharpen More filter 60
Shear filter 61
Smart Blur filter 61
smart quotes 162
Spherize filter 61
spot channels
defined 74
merging into component channels 75
opacity 74
saving
in DCS 2 documents 88
in PDF documents 151
in PSD documents 154
in RAW documents 166
in SGIRGB documents 173
in TIFF documents 188

spotColors 173

startup scripts 33

strike thru 186

stroking
default stroke color 45
path items 141
selections 170

styles, applying 61

sub path items 140

systemInformation 46

T

temperature 63
terminology dictionary
defined 195
syntax 195
text
Asian 162
auto kerning 181
auto leading 186
captions 113
color
composer 186
content 181
creating paths from 187
formatting 186
gallery security 116, 206
hyphenation 183
in picture packages 157
justification 183
languages 183
offset 181
orientation 182
spacing 182-185
tracking 186
wrapping 183
text composer 186
text fonts
See fonts
text items
See text
text layers
adding contents 181
creating 55
Texture Fill filter 61
texture filters, Texture Fill 61
threshold 64
thumbnails 117
Mac OS 161
Windows 163
TIFF documents
layered 160
saving 188
togglePalettes 51
tool tips 162
toolSupportsBrushes 51
tracking, text 186
transmission info 101
trapping 95
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Twirl filter 61
type units 163

U

underlining 186
units

ruler 162

type 163
UnitValue object 32,189
Unsharp Mask filter 61
URLs, document 101
UTF8 Encoding 115

\'

vectorData 99
version
application 47
scripting interface 46
video alpha 163
video filters
De-Interlace 58
NTSC 60
visibility
channels 74
layer comps 128

layers 56

w

warp 186

Wave filter 61

Web photo galleries
See galleries.

webSnap 109

width 92

Windows
filetypes 47

word spacing 182-185

work paths
designating 210
from selected area 169

wrapping, text 183

X
XML 190
xmp metadata 92, 190

y4
Zigzadg filter 61
zoom 161
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